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Software License Agreement

This Software License Agreement (“License Agreement”) isalegal agreement between you (either an
individual or asingle entity) and Serif (Europe) Ltd. (“ Serif”) for the accompanying software product,
which includes computer software and may include associated media, printed materials, and “online”
or electronic documentation (the “ Software Product”). By installing, copying, or otherwise using the
Software Product, you agree to be bound by the terms of this License Agreement. If you do not agree
to the terms and conditions of this License Agreement, do not install or use the Software Product; you
may, however, return it to your place of purchase for afull refund.

THANK YOU FOR LICENSING THE USE OF THE SOFTWARE PRODUCT. IT ISIMPORTANT
THAT YOU (THE "LICENSEE") READ THISNOTICE CAREFULLY. THESE ARE THE ONLY
TERMS AND CONDITIONS APPLICABLE TO YOUR RIGHTS WITH RESPECT TO THE
SOFTWARE PRODUCT. THE SOFTWARE PRODUCT ISPROTECTED BY COPYRIGHT LAWS
AND INTERNATIONAL COPYRIGHT TREATIES, ASWELL ASOTHER INTELLECTUAL
PROPERTY LAWS AND TREATIES. THE SOFTWARE PRODUCT IS LICENSED, NOT SOLD.

1. GRANT OF LICENSE

Serif hereby grants to Licensee a personal, non-exclusive,
non-transferable license (a"License") to use one (1) copy of
the Software Product, including any updates thereto, and
accompanying documentation, if any, provided by Serif,
according to the terms set forth below. If the Software
Product is being provided to Licensee as an update or
upgrade to software which Licensee has previously licensed
(such software referred to as the "Prior Software"), then
Licensee agrees to destroy all copies of the Prior Software
within thirty (30) days after opening this package except for
one backup copy of the Prior Software.

2. SCOPE OF USE

You may install and use one copy of the Software Product,
on asingle computer. The primary user of the computer on
which the Software Product is installed may make a second
copy for hisor her exclusive use on a portable computer.
Licensee may also store or install acopy of the Software
Product on a storage device, such as anetwork server, used
only toinstall or run the Software Product on other
computers over an internal network; however, you must
acquire and dedicate a license for each separate computer on
which the Software Product is installed or run from the
storage device. A license for the Software Product may not
be shared or used concurrently on different computers.

3. LICENSE PAK

If you have acquired this LICENSE AGREEMENT in a Serif
License Pak, you may make the number of additional copies
of the computer software portion of the Software Product as
authorized in the Serif License Pak, and you may use each
copy in the manner specified above. Y ou are aso entitled to
make a corresponding number of secondary copies for
portable computer use as specified above.

4. PROHIBITIONS

Y ou may not: modify, prepare derivative works from,
translate, reverse engineer, decompile, disassemble or
otherwise derive source code from the Software Product
(except to the extent that such acts are expressly permitted by
applicable law notwithstanding this limitation); copy the
Software Product (except as provided above) or the
accompanying documentation; rent, transfer, disclose, make
available or grant any rights in the Software Product
(including any accompanying documentation) in any form to
any person without the prior written consent of Serif; remove
any proprietary notices, labels, or marks on the Software
Product (including any accompanying documentation); use
the Software Product in any manner that infringes the

intellectual property or other rights of another party; or use
the Software Product to provide on-line or other database
services to any other person.

5.RETENTION OF RIGHTS; TERMINATION

This License Agreement does not constitute asale. All title,
trade secrets, copyrights, patents and other intellectual rights
to the Software Product, its accompanying documentation
and any copy made by Licensee remain with Serif, and
Licensee hereby agrees to preserve and acknowledges the
foregoing. Licensee further agrees and acknowledges that the
Software Product and all copies thereof are Serif's exclusive
property and constitute a valuable trade secret of Serif.
Licensee further agrees and acknowledges that unauthorized
copying of the Software Product or the accompanying
documentation, or failure to comply with any of the
provisions hereof (each, a"Terminable Event"), will result in
automatic termination of this License. In the event of a
violation of this License by Licensee, Serif reserves and shall
have available all legal remedies.

6. TERM OF LICENSE FOR TRIAL VERSION
SOFTWARE

The License pertaining to atrial version of the Software
Product (a"Trial Version") shall expire in accordance with
the terms as set forth in the installation process for the Trial
Version along with the designated trial period as set forth in
thetrial program.

7.LIMITED WARRANTY AND DISCLAIMER

Serif warrants that, for a period of ninety (90) days after
delivery, the diskettes or CD-ROMs on which the software
included in the Software Product is furnished will, under
normal use, be free from defects that prevent Licensee from
loading the Software Product on a computer. Serif's entire
liability and Licensee's exclusive remedy under this warranty
will be, at Serif's option, to (a) use reasonable commercial
efforts to attempt to correct or work around errors, or (b) to
replace the Software Product with functionally equivalent
Software Product, on diskettes or CD-ROM, as applicable or
(c) return the price paid for the Software Product, in each
case upon return of the Software Product to Serif together
with a copy of your receipt for the purchase thereof. This
Limited Warranty is void if failure of the Software Product
or hardware has resulted from accident, abuse, or
misapplication. Any replacement Software Product will be
warranted for the remainder of the original warranty period
or thirty (30) days, whichever islonger. Outside the United
States, neither these remedies nor any product support
services offered by Serif are available without proof of
purchase from an authorized non-U.S. source. The Software



Product is licensed to you on an "asis" basis without any
warranty of any nature.

8.NO OTHER WARRANTIES

EXCEPT FOR THE ABOVE EXPRESS LIMITED
WARRANTIES, SERIF AND ITS SUPPLIERS MAKE
AND LICENSEE RECEIVES NO WARRANTIESOR
CONDITIONS, OR TERMS, EXPRESS, IMPLIED,
STATUTORY, OR IN ANY COMMUNICATION WITH
LICENSEE. TO THE MAXIMUM EXTENT PERMITTED
BY APPLICABLE LAW, SERIF AND ITS SUPPLIERS
DISCLAIM ALL OTHER WARRANTIES AND
CONDITIONS, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, IMPLIED
WARRANTIES OF MERCHANTABILITY, FITNESS FOR
A PARTICULAR PURPOSE, TITLE AND NON-
INFRINGEMENT, WITH REGARD TO THE SOFTWARE
PRODUCT AND THE PROVISION OF OR FAILURE TO
PROVIDE SUPPORT SERVICES. LICENSEE SHALL BE
SOLELY RESPONSIBLE FOR THE SELECTION, USE,
EFFICIENCY AND SUITABILITY OF THE SOFTWARE
PRODUCT AND SERIF SHALL HAVE NO LIABILITY
THEREFOR. SERIF SHALL HAVE NO LIABILITY FOR,
NOR OBLIGATION TO INDEMNIFY LICENSEE
REGARDING ACTIONS ALLEGING THE
INFRINGEMENT OF PROPRIETARY RIGHTSBY THE
SOFTWARE PRODUCT. SERIF DOES NOT WARRANT
THAT THE OPERATION OF THE SOFTWARE
PRODUCT WILL BE UNINTERRUPTED OR ERROR
FREE OR THAT THE SOFTWARE PRODUCT WILL
MEET LICENSEE'S SPECIFIC REQUIREMENTS. The
Limited Warranty gives you specific legal rights. Y ou may
have others, which vary from state/jurisdiction to
state/jurisdiction.

9.LIMITATION OF LIABILITY

IN NO EVENT WILL SERIF OR ITS SUPPLIERS BE
LIABLE FOR LOSS OF DATA, CORRUPTION, LOST
PROFITS, COST OF COVER, OR OTHER SPECIAL,
INCIDENTAL, PUNITIVE, CONSEQUENTIAL, OR
INDIRECT DAMAGES ARISING FROM THE USE OF
THE SOFTWARE PRODUCT (INCLUDING ANY
ACCOMPANYING DOCUMENTATION), HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY. THIS
LIMITATION WILL APPLY EVEN IF SERIF OR AN
AUTHORIZED DISTRIBUTOR HAS BEEN ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE. IN NO EVENT
WILL SERIFSLIABILITY EXCEED THE AMOUNT
PAID FOR THE SOFTWARE PRODUCT. LICENSEE
ACKNOWLEDGES THAT THE AMOUNTS PAID BY
LICENSEE FOR THE SOFTWARE PRODUCT REFLECT
THISALLOCATION OF RISK. Some states or other
jurisdictions do not alow the exclusion or limitation of
liability for incidental or consequential damages, so the
above limitations and exclusions may not be applicablein
certain instances. None of the above affects the statutory
rights of licensees residing in the United Kingdom.

10. NOT FOR RESALE SOFTWARE

If the Software Product is labeled “Not for Resale” or
“NFR,” then, notwithstanding section 1 of this License, your
use of the Software Product is limited to use for
demonstration, test, or evaluation purposes.

11. NO RENTAL; OTHER TRANSFERS

Y ou may transfer this License to another computer or
workstation only on a permanent basis (that is, with no intent
to transfer again) provided the computer, workstation, or
other digital electronic device from which you have
transferred this License no longer accesses or otherwise
utilizes the Software Product, and the Software Product is
used in accordance with the terms of this License Agreement.

12. TERMINATION

Y ou may terminate this License Agreement at any time. Serif
may terminate this License Agreement if you fail to comply
with the terms and conditions of this License Agreement. In
either event, you must destroy all copies of the Software
Product.

13. UPGRADE

If this Licenseisan “Upgrade,” you must have avalid
license for the Prior Software for this License Agreement to
bevalid, and this License Agreement must be used to replace
such license for the Prior Software. The total number of
license “Upgrades’ you may acquire may not exceed the total
number of computers, workstations, or other digital
electronic devices that were licensed to access or otherwise
utilize the Software Product at the time you upgraded the
Software Product.

14. USE OF CLIP ART IMAGES; DISTRIBUTION

Y ou may modify, publish, and distribute the clip art,
photographs, and other content in print; create presentations
which incorporate the images; and use theimagesin
developing pages for the World Wide Web and Intranet
systems; al provided you are not marketing any of these
works as clip art, photographs, or other content. In no case
may you distribute any of the filesin the Software by any
other electronic means, including without limitation
distributing the images on disk or CD-ROM. In no case may
thefiles or printed images be rented, lent or sublicensed.

15. MISCELLANEOUS

This Agreement shall not be governed by the 1980 U. N.
Convention on Contracts for the International Sale of Goods;
rather, this Agreement shall be governed by English law. This
Agreement constitutes the entire agreement between Serif and
Licensee and supersedes all prior agreements, understandings,
communications, advertising, proposals or representations,
oral or written, by either party. If any provision of this
Agreement is held invalid or unenforceable, such provision
shall be revised to the extent necessary to cure the invalidity
or non-enforceability, and the remainder of this Agreement
shall continuein full force and effect. This Agreement shall be
amended only by an executed writing by authorized
representatives of both parties.



How to contact Serif
Our main office (USA, Canada):

The Software Center

13 Hampshire Drive, Unit 12, Hudson NH 03051

Main (603) 889-8650
Registration (800) 794-6876

Single Unit Sales (800) 55-SERIF or 557-3743
Technical Support (603) 886-6642

Customer Service (800) 489-6720

General Fax (603) 889-1127

Technical Support E-mail support@serif.com

European office (UK, Europe):

The Software Centre

PO Box 2000, Nottingham, NG11 7GW, UK
Main (0115) 914 2000
Registration (0800) 376 1989
Sales (0800) 376 7070
Technical Support (0115) 914 9090
Customer Service (0115) 914 9090
General Fax (0115) 914 2020

Technical Support E-mail support@serif.co.uk

Online
Visit us on the Web at http://www.serif.com
PagePlus newsgroup news://news.serif.com/SerifPagePlus

International

Please contact your local distributor/dealer. For further details please
contact us at one of our phone numbers above.
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Introduction

Welcome to PagePlus 8.0—still the best value in a complete desktop
publishing package for your home, school, church, or growing business.
PagePlus 8.0 “doesit all” more easily than ever! If you're just starting out
as a desktop publisher, we' ve got automated Wizards for just about every
job. If you require professional-level features and total control, we can
offer those as well!

From glossy corporate marketing materials and elegant Web sitesto fun
stuff like party invitations, PagePlus 8.0 can handleiit... Ads, brochures,
business stationery, cards, |etterheads, compliment dlips, invoices, flyers,
forms, newsletters, notices, handouts, event programs, posters, banners,
price lists, reports, announcements, invitations, greeting cards—not to
mention Web sites and so much more. With just your PC, printer, and
PagePlus, you can save time and money. No experience necessary!

About the Companion

This Companion is your guide to getting started and getting results with
PagePlus 8.0—from the basics to advanced professional printing.

1 Welcome. Introduces you to key PagePlus features and gets you up
and running in no time.

2 Getting Started. Steps through a Page Wizard and introduces the
Studio, using amini-tutorial approach.

3 Creating a Publication. An overview of the planning, design, and
creation of apublication, and alook at PagePlus options.

4 Designing for the World Wide Web. Beyond the basics—tips and
techniques for optimizing your Web site's design and impact.

5 Production I'ssues. How to get the best results using desktop
printing, professional output, PostScript, color options, and more.

6 QuickRef Project. Follow the instructions to build your own
illustrated Desktop Publishing reference, and grow your own skills at
the sametime.
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The PagePlus 8.0 online help system is packed full of relevant
background information and detailed step-by-step instructions.
Throughout this Companion we'll be referring you to this software-based
help.

To access the How To help in PagePlus, select

Complete a Task Help/PagePlus Help, then select the indicated
in PagePlus topic from the Contents list.

To search the PagePlus Help Index,

What to search for select Help/PagePlus Help, then click Index and
in the Index
enter the suggested search text.

What’'s new in PagePlus 8.0...

If you're areturning user, welcome back! You'll find linksto details on
all these new featuresin the Welcome topic of online help.

¢

Artistic Text Tool

An entirely new text tool to complement traditional text in frames.
Just click and type anywhere on the page, format with the customary
tools, then apply colorful lines and fills directly at the character level.
Scaleit, rotateit, flip it... discover a host of new possibilities!

Table Tool with Editable Calendars

Now you can create and edit tablesright in your publication, with
no need for a separate utility. Choose from arange of preset formats
or design your own by customizing lines, cells, rows, and columns.
Powerful text manipulation features include AutoClear, AutoFill, and
cell merge. And calendars are now table-based for enhanced
functionality!

Multipage View

A brand-new working mode option that lets you see an array of
pages, not just one at atime. Easily manipulate the view dimensions,
drag objects from one page to another, and get the “big picture” of
your publication’s layout.

Multiple Master Pages

For complex documents requiring distinct treatments for body pages,
chapter pages, picture spreads, and the like—you can now design as

many separ ate background templates as you need. Break through

the single-background barrier!
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Enhanced Studio Bar with Page M anager

More convenient and powerful than ever, the Studio’ s tabs can now
be floated, redocked, shown or hidden individually. It's easier to
select gallery categories, assign text, line, and fill colors, and vary
shading. Plus the all-new Pages tab provides a graphical overview
that lets you drag and drop to add or subtract pages and assign master
pages, with instant access to the Page Manager for total control over
page content.

Bitmap Fillsand Transparencies

Choose from a multi-faceted Studio gallery of picture-based effects,
ready to work their magic on shapes or artistic text. Y ou can even
import your own images as bitmap fills!

Curved Line Tool and Freehand Shapes

QuickShapes are till superb, but now you can “haveit al”... Just
choose aline tool (including a new one specifically for curves), draw
aline... connect other segmentsif you wish... then just connect the
end pointsto create any shape you like! Customize the line and fill,
apply transparency, even freely edit the outline.

Precise Editing of Lines, Shapes, Wrap and Crop Outlines

Try the new Curve Toolbar to fine-tune the contours of any line,
closed shape, text wrap boundary or cropping edge. Simply drag the
curve' s segments or edit its Bézier nodes to achieve exactly the result
you want.

Striking Shadow, Glow, and Bevel Effects

One dialog serves as your “ creation station,” where you can select
and preview a spectacular range of special effects for text or any
object. Choose from soft-edged transparent Drop Shadow, Inner
Shadow, Inner Glow, or Outer Glow, plus four Bevel and Emboss
effects!

Replicate Tool

Instantly multiply any object into aline or grid arrangement, with
pinpoint control over offset and spacing.. Ideal for perfectly aligned
montages! Add rotation, skew, or resizing for eye-catching
transformations.

Borders

Here' s an elegant new way to add pictur e frames to your imported
pictures and shape art... even frame atext frame! Simply pick from
the preset choices, then customize corner style.
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¢ Enhanced Web Page Creation
PagePlus 8.0 adds new power to its unparalleled ease-of-usein
designing Web sites! Add your own responsive buttons with the
multi-layered Rollover graphics option. Select from expanded format
and compression choices for picture export. Insert header as well as
body HTML code, optimize overlapping objects, and optionally
maintain original image filenames.

¢ Improved Text Handling
Behind the scenes, our text engine works faster and better than
ever —with secondary font caching, better handling of default text
styles, and automatic removal of blank fields in MailMerge output.
We' ve added vertical alignment options for frame, table, and
artistic text, and now you can add or remove words from your
personal spell-check dictionary.

¢ MoreAmazing | mage Manipulation
Import imagesinline as part of frame text flow, and create your
own 32-bit anti-aliased TIFFs and PNGs. Convert to Picture allows
instant, in-place format changes! There's more control over imported
metafiles and OLE options, and TIFFs retain CMYK color datafor
full color separation. Linked images are easier to maintain... and each
export filter now remembers its own settings.

¢ MorePowerful Printing
If you're serious about printing, you'll appreciate solid featureslike
more efficient transparency output, with bitmap stripping if your
printer driver needs an assist. Improved image spooling, more
imposition controls, and new color bars and registration marks for
professional job requirements.

¢ Our Interface... An Old Friend, Now Even Friendlier
Now you can drag and drop objectsinto PagePlus from other
applications. AutoScroll automatically adjusts your view asyou
move or resize. Therevised ChangeBar features context sensitivity
and popup dlidersto save screen space. MDI (Multiple Document
Interface) provides better window control. It’ s details like these that
have made the difference in PagePlus’ engineering, version after
version!

If thisisyour first time using PagePlus, what's new isonly part of the
story. We've built our reputation on...
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...alegacy of powerful features

DTP revolutionized the graphic arts industry, and PagePlus
revolutionized the DTP market, making high-impact design available to
everyone—with features like these:

¢

Integrated Page Wizard Technology for “Smart Documents”
With the Design CD, just pick the type of publication you want to
produce and answer afew simple questions. PagePlus does the rest!
Revisit your color scheme and text selections at any time as you
continue to work with a publication. Basic user details are stored for
automatic reuse.

Versatile Setup with Auto-Imposition

Just click to specify layouts for greeting cards, business cards, folded
brochures, and more. Y ou see your publications the right way up on-
screen—and let PagePlus take care of orienting and ordering the
printed output for correctly assembled masters!

Intelligent Color Schemes

Choose from dozens of preset color schemes to change the overall
appearance of your Page Wizard publications with asingle click.
Y ou can customize the scheme colors, create brand new schemes,
and apply any scheme to a“from-scratch” publication.

Web Publishing M ode

Create your own Web site with professionally-designed Web Page
Wizards (using the Design CD). Or convert an existing PagePlus
publication to a Web site! The Layout Checker helps you fine-tune
your design. Add animated GIFs, marquee effects, sound, video—
even Javaand HTML code—to spice up your pages! Preview your
sitein aWeb browser and publish it to alocal folder or aremote
server using HTML 4.0.

On-screen Studio Combines Convenience with Functionality
The Studio’ s tabs provide rapid drag-and-drop access to commonly-
used controls such as fonts, line settings, and the color table. Use the
Portfolio to store your favorite designs for use in any publication...
and tap the Gallery, with built-in mastheads, logos, and lots of other
page elements you can customize to suit your needs!
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¢ Professional Layout Tools
Intelligent text fitting. Movable rulers and guides. Precision
placement, rotation, and text wrap. Flip, crop, watermark, and
recolor graphics. Text formatting with bullets, lists, kerning,
hyphenation, drop caps, smart quotes, and named styles. Master
pages, facing pages display, and much more!

¢ Text Composition Tools
PagePlus includes word count, search and replace, spell-checking,
thesaurus, and proof reader. Break out of the boring box with shaped
text frames—variable molds to add impact to your text. And you get
over 400 TrueType fonts that let you express yourself with flair!

¢ QuickShapes
Long an exclusive feature of other Serif solutions, QuickShapes
work like intelligent clipart... or the most powerful set of drawing
tools you can imagine. Just choose a template shape, drag on the
page... then adjust handles to customize each angle and dimension.

¢ Powerful Drawing Options
An arsenal of new drawing tools are at your command... Sketch
freehand linesand curves. Extend existing lines with ease. Apply
line styles to all kinds of shapes—even add line endings like
arrowheads and diamonds. Automatic anti-aliasing of lines, text,
and polygons results in superb visuals, both on-screen and on the
printed page.

¢ Gradient Fills
For sophisticated illustrations and impressive typographic effects,
select from awide variety of Linear, Radial, and Conical fills. Use
the interactivefill tool for drag-and-drop updating of fill nodes and
colors.

¢ Transparency Effects
Both solid and variable transparency let you add new depth to
your print and Web creations. Apply transparency directly from the
Studio, then edit nodes and opacity with the interactive tool.

¢ Versatile Text Shape and Flow
You canrotate or reshapetext frames and still edit their text.
Enhanced text wrap options and separ ate crop and wrap outlines
mean you have greater control over where text flows and how it

appears.
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¢ Photo Optimizer
If your publication includes color or grayscale photographs, use the
Photo Optimizer to get the best results for each photo on your
particular printer. Pick the best result from the thumbnail sheet—and
PagePlus remembers the optimum settings for that image!

¢ Index, Table of Contents, and Calendar Wizards
Compile aprofessional index complete with headings, subheadings
and page references... especially useful for longer publications.
Automatically collect newdletter headlines (or any styled text you
specify) into atable of contents list. Choose from awide variety of
sizes and design options, then just click and drag to fit your calendar
to acolumn or awhole page.

¢ VersatilePrinting and Mail Merge
Impressive results on your dot-matrix, ink-jet, or laser printer in
black and white or full color. Print your current publication multiple
times, merging data from any character-delimited address list file.

¢ Professional Output
Use the high-end features of PagePlus to achieve the highest possible
quality. Features the PANTONE® color library, color mapping of
vector images, and full spot and process color separation with
savable printer schemes.

¢ Total Ease-of-use
Hideabl e toolbars for extra workspace area. Right-click menus.
Employ AutoCorrect and AutoSpell proofing options. Select multiple
Undo and Redo actions from a handy list. Tool Hints, HintLine,
Wizards, and context-sensitive cursors make PagePlus as friendly as

apuppy!

Registration, upgrades, and support

If you see the Registration Wizard when you launch PagePlus, please
take a moment to complete the registration process. Just call Serif toll-
free and provide the installation number and code shown. We'll give you
a personalized registration number in return. Remember, if you need
technical support please contact us. We aim to provide fast, friendly
service and knowledgeable help.
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Installation

What you need to run PagePlus 8.0

If you need help installing Windows, or setting up peripherals, see
Windows documentation and help.

Minimum:

¢ IBM-compatible Pentium PC with CD-ROM drive and mouse (or
other Microsoft-compatible pointing device)

¢ Microsoft Windows® 95, 98, 98 SE, Me, 2000, NT® 4.0, or XP
operating system

¢ 32MB RAM (Windows 95/98), see manufacturer’s requirements for
other operating systems

¢ 160MB (recommended install) free hard disk space

¢ SVGA (800x600 resolution, 16-bit color) display or higher.

Additional disk resources and memory are required when editing large or

complex documents.

Optional:

¢ Windows-compatible printer

¢  TWAIN-compatible scanner and/or digital camera

¢  Stylusor other input device

¢ Internet account and connection required for Web Publishing
features and accessing online resources

What you need to know

PagePlusis the easiest desktop publisher around. Y ou don’t need any
printing or design experience, as the PagePlus Page Wizards can do
virtually al the work for you!

However, if you're new to Windows computing, you will find it much
easier if, before installing and using PagePlus, you spend alittle time
becoming familiar with the Windows operating environment.

O From the Windows desktop, click the Start button at the lower |eft
and choose Help.
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First-time install

To install PagePlus 8.0, simply insert the Program CD-ROM into your
CD-ROM drive. The AutoRun feature automatically starts the Setup
process and al you need to do is select the PagePlus Install option and
answer the on-screen questions. If the AutoRun does not start the install,
use the manual install instructions below.

If you' ve also obtained the PagePlus 8.0 Design CD-ROM (see below),
install it now following the same procedure you used for the Program
CD.

Manual install/re-install

To re-install the software or to change any part of the installation at a
later date, select Settings/Control Panel from the Windows Start menu
and then double-click the Add/Remove Programs icon. Make sure the
correct CD-ROM isinserted into your CD-ROM drive, choose Serif
PagePlus 8.0, and click the Install... button. You'll have the choice of
removing or adding components, re-installing components, or removing
al components.

PagePlus 8.0 Design CD-ROM

The Design CD includes over 1800 professionally designed Wizard
documents for instantly creating brochures, business forms, calendars,
stationery, notices, newdetters, Web sites, and much more. In addition,
you'll find aset of illustrated tutorials for a hands-on introduction to the
full range of PagePlus features. To find out more, see “How to Contact
Serif” at the front of this book.
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Once PagePlus has been installed, you'll be ready to start. Setup adds a
Serif PagePlus 8.0 item to the Programs submenu of the Windows
Start menu.

O Usethe Windows Start button to start PagePlus (or if PagePlusis
already running, choose New from the File menu) to display the
Startup Wizard (menu screen).

PagePlus launches, and you'll see the Startup Wizard.

PagePlus Startup Wizard

Now you can see the normal starting screen. The Startup Wizard presents
four choices:

¢ Use a Page Wizard, to create an instant document
¢  Start from Scratch, to get ablank page to work on
¢ Open a Publication, to edit your own PagePlus files

¢ View a QuickTour, to see theintroductory overview

Startup Wizard

J Use a Page Wizard
’) Start from Scratch

: ~ _ 9 Open a Publication
Pag? Wluts ;3 View a Quicktour

9 Use the Srartup Wizard next fime [ Cance il
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If you're just getting started with PagePlus, here's arecommended
sequence:

O From the Startup Wizard, choose View a QuickTour to see an
illustrated overview of PagePlus features. From the first screen, click
the Next button to step forward. Use the Previous button to step
back or the Begin button to return to the first screen. Click Cancel
to close the QuickTour.

Cancel | I<<| € | Neut » |

Q Whenyou're ready to continue, click Page Wizard or Start from
Scratch. (For details on using a Page Wizard, see the next section.)

U At any time from the main PagePlus screen, you can pressF1 or
choose PagePlus Help from the Help menu to access online help.
The help window initially displays its Contents pane on the left, and
the Visual Reference menu on theright. Click the book iconsin the
Contents list to expand topics, and click adocument icon to display a
particular topic. Click directly on Visual Reference graphicsto
browse interface features like menus and toolbars.

O Beginners should click the Help on Help topic in the Contents list
for some tips on how to proceed, tailored to individual levels of
expertise and experience.

O Click the Index tab to peruse the list of key terms, or the Search tab
to look up specific terms using full-text search.

When you’ re done, you may want to branch out on your own—or you
can tag along as the rest of us continue thistour...

Using a Page Wizard...

Instant publications... It's easy!

Creating afinished publication that you can be proud of is simple with
PagePlus. Most of the work is done by the automated Page Wizards, and
this brief tutorial shows you how they work so that you can start
publishing right now!

The steps that follow will assist you the very first time you run a Page
Wizard. After that, you'll have no difficulty putting other Page Wizards
to work for you. And when you're ready for a hands-on introduction to
PagePlus tools and special effects, turn to the “ QuickRef Project”
chapter.
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Here' sapopular starting point: a ready-made newsl etter design.

Instant certificate

Here’' s how to use a Page Wizard to create a basic certificate you can
customize and experiment with.

a

a

Run the Startup Wizard (File/New), and choose Use a Page
Wizard.

Event

W Brochures

B> Ewvent

© Information = = _—

© Price List Z =
W Business Forms ﬁ a 1
" Business Stationery = 5 .
V Calendars i — =
WV Certificates S
V Famiy Fun Arrow Atomic Blends

W Greeting Cards
WV Labels

V Menus = a— o=
O Newsletters (=]
¥ MNolices x

WV Postoards - m =
W Promotional Flyers . -

W Special Docasions : ==
WV Weh Sites

Bricks Bubbles Bugs E

TeeBak | Firish Carcel |

On the Wizard choice screen, you' |l see publication categories on the
left and thumbnail samples on the right. Y ou may wish to take a
moment now to preview some of the many available choices.

Click Certificates in the category list, then (in the Formal

subcategory) select the Great Effort sample on the right. Then click
Finish.

PagePlus retrieves the Wizard and displaysit in Wizard Preview mode.
Here' swhere you can add your own information to the design.

a

Q

The upper group of the Wizard lists the categories of information
that you can customize, with Certificate Details selected.

Further down are boxes where you can review and/or re-enter the
sample “answer text” in the category. Type into the fields (Recipient,
Description, etc.) to replace the sample text with your own.

Asyou enter information, you'll see the publication update to reflect
your choices. Y ou can change as much or aslittle asyou like at this
point—it’s always possible to revisit the choices | ater!
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O When you're done, click the Color Scheme category. This panel
presents you with a gallery of named schemes.

color: using color
schemes

Color schemeswork like a paint-by-numbers system, using five
numbers. Instead of assigning a specific color to an element, you mark it
with a scheme color number. For example, if an object is marked with
“Scheme Color 1,” that means it will take on whichever color has been
defined as Scheme Color 1 in the current scheme. This Wizard happens to
employ the “Desert” scheme, but you can change that in an instant.

O Click the“Baby” gallery sample and notice that the certificate’s
colors shift to greens and blues. Specific elements take on specific
scheme colors. The “Recipient’s Name” text, for example, is dark
blue—thefirst of the five scheme colors shown in the gallery sample.
Now click the “Carrot” sample and you' Il see the text change to
orange; again, it's Scheme Color 1 that’s being applied to the text..

O Keep clicking different color schemes. Which element(s) have been
marked with Scheme Color 2? Scheme Color 3?

Getting your bearings

Let’stake aquick look around the PagePlus environment. Theillustration
identifies the various tool bars arranged around the pasteboard and page

regions.
Standard, Arrange, View toolbars —J:;E;"u& "‘ma SEuslealnsmE al—_ll aslzom o
il Ji ru 2|
Ll LS DU B TP LI R | =
Text, Wrap toolbars —?—‘ CIT—
Gk - H
Studio & o B
(Fill panel shown) i C— 5
: T
Tools toolbar ——— =
l & | 200 -
& Robin Steele : %=g% i
PageArea = for Creative Bookheeping EEES. | | ?
i g arZJuEE
= ) wEs |
P
Pastehoard Area —~ m_
o fi — o e
HintLine toolbar ———————" » " Bk EREIETY,
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To begin learning about PagePlus tools and menus, just move the
mouse pointer around the screen. Watch the HintLine window at the
lower right for capsule descriptions of each feature.

To access online help and resources, choose PagePlus Help from
the Help menu. The Visual Reference lets you browse interface
elements—simply click an item for details.

a

Visual Reference

Right-clicking any toolbar, object, or page region brings up a context
menu of functions.

On theright side of the PagePlus window, you'll see the Studio—
actually acluster of specia-purpose tabs. Let’s preview them in sequence
(click each panel’ s name to display it).

a

I [

The Attributes tab (seeillustration) includes five separate panels
that let you customize properties of on-screen elements. These panels
include:

— The Color panel, for applying solid color and/or shading to an
object’ sfill, outline, or text

— ThefFill panel, for applying a gradient or Bitmap fill

— The Transparency panel, for applying atransparency effect

— The Font panel, for changing the font of existing text objects

— The Line panel, for setting the weight and type of lines and shapes
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O The Schemes tab displays alist of available color schemes that let
you instantly revise colorsin a Page Wizard publication. Y ou can
extend a color scheme to new elements, customize scheme colors, or
create entirely new schemes!

U The Pages tab helps you navigate within the publication and
mani pulate pages and master (background) pages.

O The Gallery includes awide variety of predesigned elements—
graphics that you can drag and drop, then customize or use as a
starting point for your own designs.

O The Portfolio isacontainer for storing design objects (pictures, text
blocks, and even unlinked text frames) you'd like to reuse in different
publications.

O The Wizard panel lets you revisit choices you made when creating a
publication using a Page Wizard, as described in the previous
section.

Toolbars and Studio tabs are initially arranged in a convenient layout
around the perimeter of the work area. However, you have full control
over this arrangement, and can customize the display any way you
want—>by showing or hiding toolbars and tabs, or repositioning them
onscreen in away that suits your style. Y ou can even undock individual
Studio tabs as floating “tab windows’ and/or group them into different
cluster arrangements which can either float or dock astoolbars at the left
or right side of the workspace.

toolbars:
customizing

PagePlus makes it easy to see exactly what you're working on—from a
wide view of multiple pages to a closeup view of asmall region. For
example, you can use the scrollbars at the right and bottom of the main
window to move the page and pasteboard with respect to the main
window. The AutoScroll feature means that the view recentersitself as
you drag objects to the edge of the screen. The View toolbar at the top
of the screen provides buttons that let you pan or zoom in and out so you
can inspect and/or edit the page at different levels of detail. In addition,
you can switch between two viewing modes: Normal view, which
displays one page at atime, and Multipage view, which displays a
number of pages at atime in the workspace.

view options
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Moving Right Along...

Page Wizard
publications

We' ve seen how a Page Wizard creates a nearly instant publication.
Wizards can provide design inspiration or essentially complete
frameworks for your own creative vehicles. For the more complex
publication formats, however, what will still be missing is content that
only you can provide.

Supplying content means substituting your own text and graphics for the
sample stories and pictures that the Page Wizard has used. PagePlus
makes these other tasks as painless as possible, too. For example, to
substitute your own text into aframe, simply right-click the frame and
choose Text File....

If you're new to PagePlus, the tutorials on the Design CD-ROM are the
best placeto start. They’ll provide a carefully sequenced introduction to
the Desktop Publishing environment. First, you'll produce a basic
publication using a variety of PagePlus objects, and then you'll develop
the publication cumulatively, while exploring each object’ s possibilities.

Whether you continue using Wizards exclusively, or decide to start from
scratch creating your own publications—or a bit of both—the
information in the following chapters will be useful to you.

¢ Creating a Publication provides some general pointers on
publication design and project management.

¢ Designing for the World Wide Web focuses on Web Publishing
mode and its particular challenges.

¢ Production I'ssueslooks at the finer points of producing a paper
publication, whether you' re using your own desktop printer or
working with acommercia printer or service bureau.

¢ QuickRef Project presents a hands-on learning sequence you can
follow at your own pace, to create a useful reference document—and
learn Desktop Publishing terms and techniques at the same time!
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Introduction

How to Start, Save, and
Close Publications

Using the Page Wizards in PagePlus, you can quickly and easily produce
awide range of documents with the minimum of effort and experience.
It's so easy that, especially if you only use PagePlus occasionally, you
may not want to do anything else!

However, you may decide that you want to start designing your own
documents. In that case, this chapter will help you. It outlines the
planning, design, and creation of a publication and also provides an
overview of key Desktop Publishing concepts, asimplemented in
PagePlus 8.0.

Follow the links to online help for step-by-step procedural details.

One Step at a Time...

The principal stepsin the process of creating a publication are detailed
below. These are offered asa guideline, and in practice you'll find that
the steps are not clear-cut and tend to overlap. The real messageisto
adopt a consistent approach to producing your publications. Asyou gain
experience, you'll develop your own style.

¢ Planning/Design
¢ Preparing Content
¢ Page Make-Up

¢ FineTuning

¢ Printing

Planning/Design

Developing design skillsis an ongoing process rather than an event, and
you'll find that experience is the best teacher. Starting with simpler
projects, and progressing to more complex work asyou gain in
confidence, isthe way to go.
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PagePlusis a simple and flexible desktop publishing (DTP) program.
You'll find it easy to create a design on-screen, and quickly adjust it by
dragging elements around the page. Because PagePlus uses a
“pasteboard” (a scratch area around the page) you can leave objects there
until you' re ready to put them in position.

The most important aspect of design, of course, isits suitability to the job
at hand. Whether you' re working in Paper Publishing mode or Web
Publishing mode, answering the following questions will help you.

¢ For whom is the publication intended? Customers, potential clients,
students, friends, yourself... Y ou need to tailor your design and
content to appeal to your audience.

¢ What isyour main message? It' s always better if you focus on the
“big picture” rather than the detail, as most successful designs utilize
a single dominant element (a photo, illustration or headline) that’s
consistent with the main message.

¢  Wherewill it be seen? Again, this affects the style you should adopt.
While you certainly don’t want to be indistinguishable from other
designs, you don’t want your design to look completely out of place.

Cheat!

Design is one of those areas where it’s actually OK to cut corners a bit!
There’ sno harm in deriving inspiration from other people’ s successful
efforts, and picking up on new ideas and stylesis part of looking
contemporary. Obviously, copyrights exist to protect creators, and you
cannot copy another’s creative work literally, outright, or in its entirety.
Still, the world of print and electronic publicationsis full of stylistic
devices that can be adapted and repurposed.

One great thing about existing artwork (especialy if you're looking to
savetime, like most of us) isthat it acts as areminder of what to include,
without figuring it out for yourself. This means that when you want to
produce afancy business card, you can take alook at other cards to see
exactly what should get included. For example, it's now customary to list
lots of contact points, including e-mail, Web site, etc.

If you'retruly dedicated, you'll start afolder or scrapbook (a“swipe
file,” asitscalled) of different publications—ads, flyers, cards, Web
pages, and so on—to use as aresource for content and design ideas.
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Design constraints

Consider the physical and design issues, cost and time scale. Will your
publication use color? Will you be producing desktop originals?
Photocopying? Special papers? Maybe even color separations? What
pictures, fonts, or text fileswill you be using? At a minimum, decide
roughly what text and graphics are going to go into your publication, the
preferred size and number of pages, and how many copies you expect to
produce.

For Web publications, be sure to review the advice in the following
chapter, “ Designing for the World Wide Web.”

Designing with text

Typicaly, text in PagePlus goes into text frames, which work equally
well as containers for single, standal one paragraphs or multi-page articles
or chapter text. You can also present text astables or as artistic text.

A text frameis effectively a mini-page, with:

¢ Marginsand column guides to control text flow
¢ Optional preceding and following frames

¢ Text and optiona inline graphics that flow through the frame (from
the previous frame and on to the next).

By convention, text frames are said to contain stories that continue from
one frame to another. But text frames can just as easily stand alone. Thus
in any publication, you can create text in asingle frame, spread a story
over several frames, and/or include many independent frame sequences.
By placing text frames anywhere, in any order, you can build up
newspaper or newsletter style publications with many stories flowing
from one page to another.

If you' re accustomed to aword processing environment, you'll find that
text frames open up awhole new range of page design options. Be sure to
read up on how they work
before designing your first
publication.

text frames:
creating, linking, and using
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Artistic text is standalone text you type directly onto a page. Especially
useful for headlines, pull quotes, and other special-purpose text, it's
easily formatted with the standard text tools but has some artistic
advantages over frame text. For example, you can initially “draw” artistic
text at adesired point size, and drag it to adjust the size later. And unlike
the charactersin atext frame, an artistic text object can take different line
styles, fills (including gradient and Bitmap fills), and transparency for
stunning pictorial effects.

artistic text

Tablesareideal for presenting text and
datain avariety of easily customizable
row-and-column formats. Each cell in atable behaves like a mini-frame.
Tables have a number of

unique features like - Wi SRt B
AutoFormat, QuickClear, and S 1.25 0.5 111
QuickFill for rapid editing and
revision.
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tables
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Designing with text styles

How to Format Characters and
Paragraphs: Using Text Styles

Early in the creative process, you should establish the main text
formatting to be used in your publication. PagePlus lets you save
paragraph and character formats as named “ styles’ for later use.
Character styles only include font attributes like name, point size, bold, or
italic. Paragraph styles define font attributes plus such block properties as
line spacing (leading) and alignment. Typically you'll use paragraph
styles for headlines, body text, and other major elements, and reserve
character stylesfor local emphasis. The sooner you establish styles, the
better, as they help give consistency to your publication, and save both
time and effort when you need to apply and change formatting.

Once you’ ve decided upon your basic styles, choose Text Style Palette...
from the Format menu to create your named styles.
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If you're working in color, you'll need to select alimited set of
complementary colorsto apply to the main elements in the publication.
Y ou can use the built-in PagePlus color schemes (see the previous
chapter) as a starting point, or pick your own colorsfirst. Of course, you
don’'t have to use color schemes at all—but if you're planning to reuse a
particular set of colorsin several publications, you'll save time by
creating a custom color scheme from those colors. The colors will be
right there on the Schemes tab when you need them.

color schemes

Take alook at any document created by a Page Wizard, and feel free to
borrow its text and graphic treatments for your own work.

Preparing Content

PagePlus lets you integrate text and images imported from awide variety
of sources. To work with content, you can choose to use either separate
applications (such as your word processor for text, and your paint
program for bitmap images) or work within PagePlus using its wide range
of editing, proofing, and creative tools. More likely still, you'll combine
all these tools.

It's hard to beat Serif’sline of graphic design software for cost-
effectiveness and ease of use in preparing publication content. Before you
look elsewhere, consider these products (all fully compatible with

PagePlus):

¢  Serif DrawPlus, the companion drawing module for PagePlus,
provides a powerful combination of paint-like effectsin a vector-
based illustration and animation package.

¢ Serif 3DPlus outputs cool, eye-catching designs ranging from
automated, Wizard-based text effects to fully rendered 3D scenes.

¢  Serif PhotoPlus handles bitmap creation and editing, with powerful
built-in filters, layering, and animation capabilities.
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Text

How to Work with Text

There are a number of ways to prepare the text content of your
publication:

¢

Create text using your existing word processor (such as Microsoft
Word or Corel WordPerfect), save it as a separate file, then import it
into a PagePlus text frame using Insert/Text File...

¢ Typetext directly into aframe, table, or artistic text object on the
page. Simply drag with the appropriate tool to create a container (or
just click for artistic text), then start typing to create headlines,
captions, pull-quotes, and other text elements.

¢ UseWritePlusto edit continuous stories that may span many linked
text frames. To launch WritePlus, right-click the text frame you want
to edit and choose Edit Story.

Graphics

How to Work with
Lines and Shapes

Without leaving the PagePlus environment, you can incorporate a variety
of graphic elementsin your publications for emphasis and decorative
effect:

¢

Gallery objects such as mastheads, logos, and other page elements
that you simply drag from the Studio’s Gallery tab.

Linesor rulesusing the Linetools (Straight, Curved, and Freehand)
with different line types and colors. Typical uses include vertical
lines between columns and horizontal lines above or below
headlines. Y ou can also set ruled lines above or below any paragraph
using the Line tab of Format/Paragraph....

Closed shapes created by connecting the end points of one or more
connected lines. It's easy to modify closed shapes using the Color,
Line, Fill, and Transparency panels of the Studio’s Attributes tab.
The Curve toolbar gives you a high degree of control over lines and
closed shapes.
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¢ QuickShapessuch ascircles,
ellipses, rectangles, and a host of
other basic formsthat you create
and customize just by dragging
adjustment handles. Typical uses
include shaded or black panels
behind headlines or pull-quotes.

¢ Don't overlook the artistic potential of artistic text—for example, a
single text character typed straight onto the page as a design element,
usualy from a“picture’ font like Wingdings, often in alarge size
(72pt or more).

Pictures

How to Import Images
and Objects

While you can achieve a great deal with the built-in graphic tools, you'll
find the old adage about pictures being worth a thousand wordsis also a
“given” in publication design. PagePlus lets you import a variety of

image files, then apply manipulations such as resizing, rotating, cropping,
and tinting (for example, using alow intensity color for backgrounds).

Toimport a picture file into PagePlus, click the Import Picture button or
use Insert/Picture... (which gives you a choice of importing from a
PhotoCD, a TWAIN scanner or camera, or afile).

¢ Bitmapped images (“raster” images or “bitmaps’) are pictures built
from amatrix of dots, or pixels, rather like a sheet of graph paper.
Familiar formatsinclude .BMP, .GIF, and .JPG. They are created by
with a“paint” program or photo editor such as Serif PhotoPlus,
Microsoft Paint, or Adobe Photoshop, often from scanned
photographs, and then saved as separate files.

¢ Draw graphics, or “vector” images, are resol ution-independent and
contain drawing commands (“draw aline from A to B") instead of
pixels. Compact draw images, produced with software like Serif
DrawPlus, are often easier to edit and print out better than bitmaps.
Encapsulated PostScript (EPS) isaspecial case of adraw-type
picture which contains the PostScript coding needed to produce
output on a PostScript printer.
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¢

M etafiles (e.g. .WMFs) are the native graphics format for Windows
and combine raster and vector information. Metafiles include
multiple “records’ for maximum portability between applications. If
you're not using PostScript, thisis the recommended vector format.

Items from other Windows
applications (such as an Excel
Spreadsheet, or a CorelDRAW!
illustration) can be transferred
directly (without saving to afile
first) to PagePlus viathe
Windows Clipboard/OLE using
cut and paste.

Page Make-up

Once you' ve decided on your overall layout, and what text and graphics
you'll be using, you're ready to start the actual page make-up stage. (The
“QuickRef Project” chapter provides hands-on practice with many of
these procedures, and the Design CD provides basic tutorials.)

Basic setup

Start with anew, blank page using File/New... and choose the Start
from Scratch option. Select a publication type on the left and examine
the samples on the right. Click the one that's closest to what you want.

Choose a Wizard

Other

W Regular/Marmal
W Small Publications
W Large Publications
" Folded Publications
O Greeting Cards
O Books/Booklets

B

O WebPage L

Side Fold Meru Side Tri-Fold Side Z-Faold
\
.Y
s
Top Fold Menu Top Tri-Fold Top Z-Fold
Custom Page Setup... | << Back Einigh | Cancel I
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If the predefined page sizes don’t fit your needs, choose the closest one,
then Y ou can change the size later using File/Page Setup.... Click the
dialog’'s Create Custom... button and use the dial ogs that follow to select
a publication and specify exact dimensions.

Small Publication Setup

Mgy
Widlhy  [3.70em _lj Left  [D00cm _IQ

A I:I Heght [318em = o [ 3

M Auto

~Gap -~ Lapau

—1— A GapX [1.28em = Acioss: B _IQ
Gapy |[0E9cm _l: Down: |2 _IZ
Cancel

All subsequent page layout work will build on this page setup.

How to Set Up Pages
and Backgrounds

Asyou begin working on a new publication, it's also agood ideato set
the visible guide lines that indicate where page margins, rows, and
columns (if any) are to be placed. To create or change these guides,
choose Layout Guides... from the File menu. The dialog includes a From
Printer button that can match the margin guide lines to your current
printer settings.

Page view and master pages

O Index |

facing pages,

master raaes
Y ou can set up your publication using File/Page Setup... so that the
PagePlus window displays either one page at atime (which provides
more pasteboard area), or two facing pages side by side. You'll need
Facing Page mode if you' re creating a publication with double-page
spreads, where a headline or other element needs to extend from the left-
hand page to the right-hand page. Facing Page mode can also be useful
when working on any document where you need to see both the left- and
right-hand pages, even if no elements need to span both pages.
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The master pagelevel isthe
background of your publication, where
you can place objectsyou'd like to
appear on every page—such as
headers and footers, page numbers, or
aborder design. Y our publication

page “floats’ above the master page,
like a sheet of tracing paper. Objects
on the two levels are separate from
each other.

You're not limited to just one master
page. For example, you might create
different master pages for “title” and “chapter divider” pages. In Facing
Page mode, dual master pages let you spread background elements
across a double page. Y ou can define mirrored margins, i.e. one setting
for “inside” and one for “outside” margins (instead of “right” and “left”).

How to View and
Turn Pages

It's best to choose between Facing and Single Page view early in the
design process. Later on, when there are more pages and objectsin your
publication, it will take longer to convert from one mode to the other.

Background

headers and footers

Y ou can choose to add repeating text at the top or bottom of the page
using Insert/Headers & Footers...... TO create more complex
background elements, work directly on the master page: choose
View/Go to Master Page (or click on the Current Page box at the
lower left).
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Headers and Footers Wizard [ x|

The Headers and Footers dialog helps pyou to create,
delete or edit headers and footers.

Ta begin the Headers and Foaoters Wizard select a
tazter Page and click Mext.

Select a master page: ILeft -

< Back I Hest » I Cancel |

In Web Publishing mode, the page background is just one of several
attributes called Web color s that you can set behind the scenes, and
which make areal differencein the appearance of your site. (The others
are for body text and hyperlinks.) For a background, you can choose
either asolid color or abitmap, which is then tiled (repeated) over the
page area. The built-in PagePlus 8.0 color schemes all incorporate
selections for these Web colors. Perhaps the easiest way to seethemin
action (if you have the PagePlus Design CD) isto run through one of the
Web Page Wizards, which will quickly generate a*“ practice” Web
publication for you. Then use the Studio to experiment with different
color scheme choices.

Web sites: choosing
Web site colors
To modify any of the colors (including Web colors) in a particular
scheme, or create a new scheme, right-click asample in the Studio’s
Schemes tab gallery and choose Scheme Manager....

The layout grid

Once you' ve defined the publication’s basic setup, you can go ahead and
create alayout grid consisting of columns, guides, and text frames. The
grid isvery important as it defines how your page will ook and ensures
page-to-page consistency.

¢ Columns. The main aspects of the grid are the number of columns
and the column gap (“gutter”). As noted earlier, page margin and
row/column guides are useful as visual background aids. For
example, layouts may be referred to as a “three-column grid” or
“five-column grid.” Set these values using File/Layout Guides....
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¢ Text frames. Decide where you want to place the main blocks of
text (or stories) on the page and create text frames to mark these
areas. Create the frames using one of the the Frame tools. For each
frame, set the margins, number of columns, and column gutter (right-
click aframe and choose Frame Setup...). Y ou can start importing
or entering text now (see the discussion of options above), or leave
the frames empty until later. For text that will run longer than a
single frame, you will want to link additional framesinto a story
seguence—but again, this decision can be postponed until later.

¢ Ruler guides. These are straight, red lines on the page (not the
master page) that aid in placing elements such as a headline, picture,
or coupon. To add aguide, just click any point on aruler. To remove
aguide, drag it off the page. Guides aren’t necessarily part of the
initial setup; you can add them whenever they’ re needed.

Snapping and the Dot Grid

snapping objects to dot
grid or quides

Thislayout grid of page margin and row/column guides, frame margins
and columns, and horizontal and vertical ruler guides helps to ensure that
objects will be correctly aligned. When the Snapping feature is turned on,
objects you create, move, or resize will jump to align with the nearest
visible guide line. There are times when you’ll want Snapping on, and
other times when (for precise positioning) it may be a hindrance. To turn
Snapping on and off, click the Snapping button on the HintLine toolbar.

PagePlus also features a Dot Grid—a matrix of dots or lines spaced a
certain distance apart, covering the page and pasteboard areas. To set the
grid spacing, choose Options... from the Tools menu and use the Layout

page.
To determine which guide elements are snapped-to, use the View menu

or the right-click Display> flyout to show or hide (check or uncheck)
specific elements.
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Adding, copying, or deleting pages
If you know how many pages there will be in your publication, you may
want to create them now—or you can add new pages as you go aong.

Y ou can aso insert one or more copies of any page, a any point in the
publication. Thisis useful if more than one page needs certain elements
in the same position. Set up the initial page layout, then (making sureit’s
final) duplicate as needed.

The easiest way to add, copy, or delete pages (or master pages) isto use
the Studio’s Pages tab. Simply click the Insert Page or Delete Page
button above the appropriate panel. For additional options, click thetab’'s
Page Manager button.

O Index |

pages: adding
and removing

Placing content

Now that you have your grid, here's a suggested approach to page make-
up with PagePlus:

Place major text elements

How to Work with Text
Create, import, or edit the text for al the framesin your publication.

Right-click aframe and choose Text File... to bring in text you’ ve created
in your word processor. When importing text, you' [l have the option of
automatically creating text frames and pages until all the text has been
imported, or storing extratext in the overflow area.

To link one frame to afollowing frame, so that the story text flows
between the two, click the first frame's Link button, then click on the
other frame. Buttons on the Frame toolbar include options for unlinking
frames, navigating between linked frames, and adjusting text size so that
astory fits precisely into the available frame area.

Y ou can type or edit text directly into aframe, or right-click and choose
Edit Story to open a WritePlus window on the whole story. The text in
both windows updates simultaneously as you type, so you can actually
work on two sections of the story at once.
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If you plan to incorporate table text, first create the table objects and set
row/column properties. Then either type your text or paste from the
Clipboard (tab-delimited datais automatically distributed across cells).
For atable that’ s already set up as a calendar, click the Insert Calendar
button to choose from avariety of colorful styles.

At this point, you may want to adjust the graphic properties of the frames
and/or tables. Y ou can manipulate these text objects just like shapes and
apply line styles, fills, colors, and transparency. To simplify matters,
tables come with arange of built-in AutoFormat choices—take alook at
those first!

Add headlines

Now add secondary text elements like headlines, captions, and banners.
For decorative text elements, consider using artistic text, which lets you
format individual characters with line properties, gradient or Bitmap fills,
and transparency.

With either kind of text object, you can apply text formatting commands
(using the Text panel of the Studio’s Attributes tab, the Format menu
(and right-click) commands, or the ChangeBar) to get the text looking the
way you want it. Adjust the font, size, width, and color. Rotate the text
for greater impact.

Import and place pictures and objects

How to Import Images
and Objects

Once the principal text elements arein place, add your image files using
the Import Picture button. To replace an existing image—for example, a
placeholder picture included by a Page Wizard—just double-click it to
bring up the file selection dialog. Y ou can also drag and drop an image
fileicon into PagePlus, and of course paste objects from other
applications via the Windows Clipboard.

One advantage of importing over pasting (or drag and drop) isthat it lets
you choose whether to link or embed the image. Each method has pros
and cons. A linked image is basically areference to the original file, so
the actual picture stays separate from the publication file and its
representation updates automatically in PagePlus if you revise the
original image. An embedded picture is wedged into the PagePlus
publication when you import it; if you subsequently revise the image
you'll need to re-embed it. Lots of embedded files can swell the size of
the publication file, but at |east al the images are in one place. (If you use
linked images you' |l need to keep track of them.) If filesizeisn’t an
issue, consider using linking just for images that are still “in flux,” and
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embedding them all once they’re final.

The Convert to Picture command lets you combine several separate
elements (as a multiple selection) into one picture for easier
manipulation. It's aso great for changing an embedded picture from one
format to another, saving you the trouble of making changesin an
externa editor.

Place and size each picture or object. Y ou can aso crop, rotate, and flip.
Apply line style, fill, or background color as for frames and graphics.

wrapping text around
objects

Page objects can be set so that text wraps around them—click the Wrap
Settings button on the Arrange toolbar, or choose Arrange/Wrap
Settings..). If you set a Tight wrap, you can click the Edit Wrap button
to adjust each object’ swrap outline individually by dragging its nodes
and connecting segments. Y ou can even use the Curve toolbar to add or
delete nodes for a high degree of control over text wrap.

Check that al the text on your page wraps around your picture elements
asdesired. Y ou can adjust an object’s crop outline independent of its
wrap setting so that portions are masked and don’t appear on the printout.

Wrap off Wrap outside Wrap inside
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Addding flair

In design work, inspiration and perspiration go hand in hand. Ideally,
having followed through on your original concept, you'll now like what
you see—and still have some time left to experiment with finishing
touches. Sometimes, thislast burst of creativity means removing clutter
or adding white space. Sometimes it means adding elements or special
effects to enhance the original concept.
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By all means, explore what PagePlus has to offer. For example, you can
employ decorative touches like clipart backgrounds, ruled lines, cropped
shapes, Bitmap fills, and special text characters. Borders et you add an
instant frame to any object. The Studio’s Gallery is a great source of
inspiration: check out the various categories and try customizing the
prebuilt designs. Inline graphics can spice up mundane text, while filter
effects like drop shadow or bevel can add depth to otherwise flat graphics
and lettering. It's all there waiting for you!

Fine-tuning

Make any final adjustmentsto size, position, or formatting of your page
objects. Click the Print Preview button on the HintLine toolbar to seea
preview of your publication. For longer publications, click the Multi-
Page button to set up an array view—a great way to check for overall
consistency.

How to Check Your Work

Of course, you'll want to review an actual printout (see below), asit’s
often easier to spot mistakes on paper than on screen. Now isthe time to
check, and double-check, your work. If you can, get someone else to
proof it for you, too. If you're printing alot of copies, mistakes can be
embarrassing and costly!

In Web Publishing mode, use Tools/Layout Checker... to help you find
and correct common layout problems.

Web Site Layout Checker Wizard [ x|

The eh Site Lapout Checker Wizard checks your
‘web site ta find any problems that will occur when pou
publish it ta the 'Web.

To begin the 'Web Site Layout Checker “Wizard, click
Hext.

< Back Cancel
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Printing

How to Print Your
Publication

Thisfinal stage in Paper Publishing mode is a breeze. Use the Windows
Control Panel or the Properties button in the Print dialog to make sure
your printer is correctly configured., and check that you have blank paper
loaded.

printing: basics
and options

When you're ready, choose File/Print... to print your page(s).

PagePlus has options for printing and collating multiple copies or printing
just specific pages. The various tabs of the Print dialog let you access
advanced choices including scaling (to size pages to a specific paper
size), tiling (for printing multiple page posters & banners), and
thumbnails (printing mini-previews of multiple pages on a single sheet).

Y ou can use the Separations tab to create spot and process color
separations, and options on the Prepress tab will be useful if you need to
submit your output to a professional printer or service bureau. Seethe
“Production Issues’ chapter for background and details.

In Web Publishing mode, you may want to print your pages for reference,
but the final stage hereis of course “publishing” or converting the
PagePlus publication to a Web site. Y ou can choose to publish to alocal
disk folder or directly to the World Wide Web. See online help for
complete coverage of the basic stepsinvolved. The next chapter,
“Designing for the World Wide Web,” picks up the discussion on a
dlightly higher level, with tips and insights especially for those
transitioning from traditional DTP to Web publishing.



N=E 48

Designing for the
World Wide Web
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Designing for a New Medium

Congratulations! Y ou’ ve chosen PagePlus to do your Web site authoring.
Let others lose sleep trying to turn HTML dross into WWW gold... You,
on the other hand, will rapidly gain ground as you translate your existing
design and content skills into Web pages. Use familiar layout tools to
compose your publication, then click to turn it into aWeb site. To revise
aWeb page, ssmply go back to the .PPP file, make your changes, and
publish the page again.

Doenary

B e @M i
AN
.

Designing a Web siteis no more difficult than designing a newsl etter—
but be prepared to learn some new tricks. When you build your first Web
site, you're entering the realm of hypermedia and interface design. This
chapter won’t focus on the mechanics of turning out a basic Web site;
these steps are covered in PagePlus online help. It will, however, share
some important lessons from people who’ ve “ been there, done that.”
Starting out, you have one key advantage over those hypertext pioneers:
plenty of examplesto learn from!

You’'d Better Shop Around

The Web is the place to go looking for examples—the high, the low, and
the in-between. The more you surf, the more keenly you'll be able to
judge the variety and value of what's out there. Inspect what your
colleagues (or competitors) have created. What works, and what doesn’t?
What'simpressive, and what' s frustratingly bad? Explore our Suggested
Links. Create a bookmark/favorites list of the best examples you find.
And resolveto rise above the ordinary.

s
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Designing the Site

How to Prepare a Publication
for the World Wide Web

The advice in this chapter comes from some of the gurus who have set up
Web sites to disseminate their particular design credos, as well as from
first-hand experience devel oping user-friendly online environments.
Almost all agree that good design begins not with the designer but with
the user. Know the user; put yourself in his or her place. Learn from your
own experience as a consumer of onlineinformation.

Notice immediately that we're not speaking of “readers’ here. In the
online realm, the people who point their Web browsers to your site are
“visitors’ or even “users,” not merely readers. Even if the material you're
presenting there comes from a print publication, when displayed online it
won't be perceived in quite the same way.

Still, it’ sworthwhile trying to conceptualize your site asif it were amore
traditional form. Isit a“billboard in the sky”? Isit basically agreeting
card, aphoto album? An Open Letter or editorial? Peopl€e’ s past
experience with print and pictures shapes their expectations for new
forms, and afamiliar concept or metaphor can help to draw usersinto
your web, asit were.

To begin with, don’t set out to overwhelm or overdesign. The simplest
site may work best. What will succeed is the result of understanding
who'’sin your audience, and what they bring to what you have to offer.

Who's it for?

Family, friends, neighbors, colleagues, co-workers, kids, adults, clients,
prospective clients, prospective employers, fellow worm-farming
enthusiasts—or “the world at large” ? Chances are you aready know at
least afew of the folks you'd like to reach. Perhaps you' re already
publishing print pieces that connect you to that audience. Part of the
excitement in creating a Web site is knowing you' Il likely be reaching a
great many folks you couldn’t reach before.
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Use yourself, and your own experience on the Web, as a starting point.
But be prepared to be surprised that many users don’t share your
assumptions. ldeally, a Web site should constitute a dialog between
creator and audience, more like a (very slow) theater event thana TV
broadcast. If the dialog begins while the siteisin its formative stage, so
much the better. Do a bit of research among people (even just one person)
representative of those you'll be trying to reach. Poll your clients or
newsletter subscribers.

Ask them what they like and dislike about Web sites.

What'stheir level of expertise?

What kind of hardware, software, and Internet connection are they
using?

Use the Web itself to tap into surveys on Internet usage.

What characteristics make your audience unique—different from the
so-called average user?

Each point you can clarify will serve as areality check on your initial
concepts. And as time goes on (see “Maintaining Y our Site”), user
feedback will help you develop your site in away that keeps the visitors
coming back for more.

What have you got?

That is, not just what do you want to say, but why should anyone listen?
What have you got that users actually want? What are you starting out
with as content, and what kinds of transformations will it need to go
through to succeed on the Web? These are complex questions, but
essential to address at the start of this kind of project. The answers will
help you tailor your content to your intended audience in this new
medium.

Don't assume that your existing content is going to satisfy Web visitors
before it’s been enhanced in various ways. Quite often, traditional content
needs to be “massaged” in order to translate successfully to the computer
screen. It'salot like adding motivational bells and whistlesto an
instructional program for reluctant learners. In the early days of the
Internet, text and hypertext links were sufficient to keep scientist-users
entertained and enlightened. While one can certainly still design elegant
screens to display text-only material, one can’t turn back the clock.
Today, users expect to see pictures (or at least graphic elements), colors,
buttons, and other interface attributes. They certainly don’t want to
become bored or get lost. Y our goal should be to minimize any negative
first reactions to your site, while maximizing the rewards for each user.
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Site structure

OB Index |

Web sites: page
lavout basics

Most of the preceding advice on adapting content to a targeted audience
could apply just aswell to, say, developing a suitable newsletter format
for a subscriber or client base. But as soon as you begin to think about the
structure of your site—as you might envision a print publication’s overall
layout—you realize that this mediumis different. The typical computer
monitor simply can’t display afull newsletter page; you realize this each
time you adjust the zoom view in PagePlus. The screenisalike a cutout
rectangle in apiece of cardboard, through which users must peer.
Information disappears off the bottom of the screen. Will users be
inclined to scroll down and retrieve it? Reading skills like scanning
headlines or skimming stories become irrelevant when content is
segmented into separate screenfuls. And even the most computer-literate
first-time visitor to your Home page will have no idea how many pages
there are or how the pages are organized.

@=

Browser Window
("safe area”)

Page

To complicate matters, setting up your site's structureis like building a
house. Once you' ve set up the rooms, doors, and hallways, it becomes
problematic to go revising the layout. With a computer, of course, it's
easy enough to rearrange things; but if you’ ve aready invited peoplein,
you're likely to get some complaints from second-time visitors who
bump their heads trying to get through a kitchen door that no longer
exists.

So it seems you' ve got your work cut out for you!

Asyou draw up the blueprints for your site-to-be, here’ s one useful
approach to mapping the content you plan to put on the site to the
physical pages that will contain and display it. It's called the section/level
model.
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¢ A section isacategory, like “Company News,” “Products,”
“People,” or “Links.” The various sections are typically listed on the
site’'s Home page. Each page on the site belongs to a particular
section. And unless there' s only one page in a given section, the
section has its own menu page.

¢ Thelevel isthe number of steps (i.e. jumps) a given page is removed
from the Home page. Considering the Home page as Level 1, then,
section menu pages are Level 2. Pages one step “below” the section
menu are Level 3.

1 HOME
L
ARCHIVE: ,

2 | siony || _PAST || WHOS | lpgopucts| | LINKS
STORIES

30 OO

Thisisbasically a“hierarchical” or “tree” model, based on the concept of
one Home page as aroot or point of entry, with other pages branching
away fromit. (Of course, nothing prevents you from also installing
sideways links, as opposed to just up-down links between levels.)

Not only is the section/level model well-suited to most kinds of content
likely to end up on the Web, but it particularly lends itself to graphical
reinforcement (see “Navigation”). So there’ s an excellent chance that
you, as the site designer, will be able to organize your content and
provide appropriate visual cuesto prevent users from getting lost.
Remember, each screen should provide cues as to which section the user
is“in.”

The menu and submenu pages—the Home page and the various section
menu pages—are the key nodes in this structure. As arule of thumb, keep
the number of menu items per page between four and eight. When in
doubt, increase the number of menu choices before you create a new
submenu page (i.e. anew level). Studies have shown that users prefer a
few dense screens of choices over many layers of simplified menus.
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No matter how simple your initial site concept, it needs to be clear to you
before you can make it clear to your users. Sketch out a diagram of how
you envision the various sections and levels. If you use one of the Page
Wizards, you'll begin with one Home Page linking to half a dozen Level
2 (section) pages; make sure these sections are named according to the
content you'll be offering.

PRODUCTS PRODUCTS

c - 2]
TN,
3 0

Over time, you'll be adding content. The section pages will probably
evolve into menu pages, with content migrating to newly-added Level 3

pages. You'll be prepared for this growth if you' ve started out with a
clear model of your site's structure.

Designing Pages

If good site design means structuring your content in away that makes
sense—both to you and to someone trying to explore the cavern one
screen at atime—good page design means providing, each step of the
way, al the necessary signage and illumination to ensure your visitors
don’t get lost or bump their heads.

Consider this. Chances are you can tell the difference between one and
two sheets of paper held between your fingers. Y ou apply that tactile
sense to the act of reading a magazine. At each moment, your eyes and
hands tell you exactly where you are in the publication you're holding. If
you happen to drop the issue, you can find your place again in no time.

Now consider a Web site. Where' s the tactile or kinesthetic feedback?
Despite the hype and the easy analogies to “surfing,” the Web experience
isnot really spatial or physical; it's strictly linear and intellectual. One
word, one picture, one screen at atime—and without the positional cues
afforded by holding a book or magazine. Hypertext jumps may be cool
and convenient, but they’re basically disorienting.
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Unless you're intentionally trying to attract people who like to lose
themselves inside Web sites (and yes, there are probably afew of those),
we suggest you discard any fanciful notion of turning your site into a
“museum” or a“landscape,” or even a“zone.” Focusinstead on what you
can do to avoid losing or alienating your first-time visitors.

Old principles...

While many Web sites aspire to become multimedia experiences, the
reality isthat most home users’ Internet connections and hardware can
barely deliver even the throughput of afloppy disk drive. A vast mgjority
of Web pages will continue to be primarily text-based for sometimeto
come. Recognizing this, cutting-edge Web designers are keenly interested
in electronic text and typography, and in bringing to the Web the kind of
design principles that have prevailed in traditional print publishing.

In effect, what'sold is new. Aslong as people are reading Web pages, as
opposed to watching them or listening to them, everything you’ ve been
taught about editorial style and text organization has relevance. (Don’'t
throw away that Style Manual!) Readers respond to writing that’s
presented clearly and concisely. They’ Il respect the fact that you
understand the proper way to present a story: the relation of headlinesto
body text, the use of subheads, and so on. And, within reason, they’ll
admire any compositional tricks you can introduce that don’t detract from

legibility.

...New practices

At the same time, respecting the unique challenges of navigating through
aWeb site, as opposed to reading a book or a magazine, needs to become
part of your design approach. For example, suppose avisitor is
particularly interested in one page within your site (perhapsit’s your
Links page, afeature story, or acool picture). They may bookmark that
one page and return to it later—or tell afriend. In effect, since every page
on your site hasits own unique URL (address), the site has as many “side
doors” asit has pages. Each page needs to provide cues that a visitor can
use to become oriented to the new “space” they’ ve entered.

One basic aspect of looking at a Web page is that the viewer initially sees
only what’ s displayed in the browser window (the safe ar ea, after the
television concept of a“safetitle” area), leaving unseen an indeterminate
portion of the page below that. At VGA resolution of 640x480, the safe
areamay be around 300 vertical pixels high; at 800x600, around 400.
Content in this region may be all the visitor seesfor several seconds as
various graphics load onto the page. Studies show that many Web users
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are not in the habit of scrolling pages before deciding to move on, so that
leaves afairly narrow strip and a short interval in which to grab their
attention!

¢ Content. The safe area should convey essential information about
the site and entice the visitor to scroll for more.

¢ Composition. Think of the safe area as a mini-page, and make sure
that the elements within it work as a group.

OB Index |

Web sites: choosing
a site title

In general, Web page headers and footers need to contain more
information than those in a conventional publication. The Web site title,
which appearsimmediately in the browser’ stitle bar as the first page
loads, should convey your site’ sidentity accurately, and even with a
touch of wit. The top matter should include alogo or other identifying
motif, aswell as a page title (so users know they’ ve come to the right
place). Visual cues as to section and level can also be part of the top
matter.

O Index |

Web sites: working
with hvoerlinks

The bottom of the page is a good place to include elements that help the
page stand on its own as a self-contained unit. For example, it's good
practice to include a date stamp so users know how current the contents
are (use Insert/Information/Date or Time... and uncheck Update
Automatically). If you don’t have a separate “Reply” or “Feedback”
page, consider placing areturn hyperlink with your own e-mail address
at the bottom of each page. It’s not a bad ideato spell out the page’s URL
aswell. That way, if avisitor saves apage as atext file, or printsit out,
they’ll have arecord of where the page originated. A copyright notice
isn't out of the question, either.

Page layout

The above advice on top and bottom matter applies equally to your Home
page, section menu pages, or any other pages. It will help you build in a
page-to-page consistency that respects the way people view Web sites.
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In general, consistency is good: if you choose a graphic theme, by al
means use it throughout your site. But too much of this good thing can
lead to blandness, and you should also work on differentiating the various
levels of your site from each other. In other words, the Home page should
appear unique, and section menu pages should resembl e each other, while
looking distinct from pages at other levels. Besides adding interest, these
variations also serve as havigational cues.

master pages: setting

In using PagePlus to design the publication, take advantage of the master
page/page distinction. Think of the background as a sheet of preprinted
stationery with its own elements. For example, you can design a colorful
background header—perhaps incorporating a main logo—on the master
page, which will then repeat on each Web page. Individua pages can add
“local” information such as a section name or page title, which will be
visually merged with the background when the page is published. (See
thetipsin the “ Graphics’ section on combining foreground and
background elements.)

The HTML 4.0 output available in PagePlus 8.0 largely frees you from
the page layout constraints that plagued HTML 3.2. With HTML 3.2,
WY SIWY G output was only achieved by turning the arrangement of
elementsinto one large, complex HTML table per page, with each
element occupying its own cell. Overlapping objects had to be exported
asasingle graphic. With HTML 4.0, based on absolute positioning rather
than tables, it's now OK for objects to overlap, and your compositions
can be amost totally free-form!

PagePlus includes two default Web page sizes: Standard for VGA
monitors, Wide for SVGA. To accommodate most users, choose the
Standard size. It’ s better to have the layout appear a bit tight at 800x600
than to have text and graphics spill beyond the edges of a 640x480

display.

The bottom of the PagePlus page is fixed, too, but a Web browser will
only display as far as the bottom object on each page. If there’s a chance
you'll be including pages with alot of text, requiring usersto scroll
down, you can increase the height value for the page to give yourself
some extraroom. You don’t haveto fill al the space, and it's much easier
to change the value at the outset than after you' ve devel oped the site.
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One of the simplest things you can do to improve your site's appearance
isto set rather wide left and right mar gins. Extra space on both left and
right helpsto set off your content from the edge of the browser window,
and gives an uncluttered appearance just asit would on a printed page.
It's also easier to view: studies show that at normal reading distances, the
eye' s span of movement isonly about 8 cm (3 inches) wide; longer lines
of text require extra effort. So spend some time experimenting with
different placements of the main frame on your very first page,
previewing in your browser until you find your own preferences. Then
duplicate the first page to create the other pages, so the layout will be
consistent on the other pagesin the site.

Your Home page

On the Home page, you can break afew rules. For example, although
you're generally trying to reduce the time it takes each pageto load, it's
OK to include larger or more numerous graphics on the Home page. Most
visitors' attention span will stretch a bit in anticipation of seeing what
your site has to offer, and they’ |l make allowances. In addition, they'l|
only have to wait the first time they visit the page, as the graphics will be
cached and instantly available next time.

On the other hand, all the guidelines mentioned above work to your
advantage. The Home page, and particularly its safe area, are your only
chance to make afirst impression (unless someone enters through one of
the “side doors” we aluded to). Decide what kind of impression you want

to make—"“cool,” “hot,” “intriguing,” “professional,” or al of the
above—and go for it.

Make the safe areainteresting enough to hold the visitor’s attention while
therest of the page loads. Text loads first, then graphics. A composition
of freetext blocks will load quickly and, with the right choice of text and
background colors, can be stunningly effective. A pithy quotation or
unusual symbol will serve to engage the mind's eye and arrest the web-
surfer’simpulseto “click and get on with it.”

The Home page can be a cross between a greeting card, a magazine
cover, an advertisement, and amain menu for the rest of your site.

There' s no question that well-rendered graphics add interest, but don’t
feel obligated to illustrate every single section link with its own GIF.
Remember that some users still turn off graphic loading when browsing
Web sites, in order to speed up access to textual info and skip advertising.
These users will never see your pictures; make sure your text hooks them.
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For these as well as other visitors, make sure you provide alter nate text
captions for each graphic, using the Web Picture Manager on the Tools
menu dialog). Y ou can select individual graphics and then run the Wizard
to set individual captions. The captions will hold attention as the graphics
load, and convey the essence of the image for the text-only user. Blind
users with special software can hear the alternate text (via synthesized
speech), and so will not completely miss the pictorial content.

Web Picture
Properties Wizard

Large graphics have their place, particularly if they double as
hypergraphics (see below), but you certainly don’t want more than a
couple of 50K graphics per page. And anything that’s going to take a
minute or two to load had better be worth it!

Navigation

Earlier (see “ Site Structure”) we introduced some of the differences
between Web sites and paper publications that make navigation tricky.
(When was the last time you even thought of “navigating” through a
book?) The section/level model we' ve been using provides a suitable
framework—assuming it works with your content—because the basic
form of a“tree” isabout asintuitive as any path system islikely to get.
But with users coming in through side doors, or traversing hyperlinks that
leapfrog from one part of the site to another, it's up to you to ensure the
tree doesn’t turn into a maze.

Unlessyour siteis extremely simple, don’t expect sequential page
numbering to serve avisitor’ s needs. In fact, the only person who should
have to contend with page numbers is you—because PagePlus requires
you to supply a page number each time you define a page-to-page
hyperlink. That means you’ll need to maintain a separate listing of your
site’ s page numbers (corresponding to pages in the original publication).

Rather than page numbers, what's needed are visual cues on each page
that convey: Which section am | in now? and Wheream | inrelation to
the section menu?

Text can help. It's common sense to use page titles or headlines that
identify what’s on the page. By using somewhat larger headline text for
Level 2 (section menu) page titles, smaller subheads for Level 3, and so
on, you can reinforce the user’ s sense of how far removed they are from
the Home page.
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For communi cating section identity, you can use avariety of techniques,
preferably in combination. Sections can use color-coding, applied to
headlines and/or graphic elements. Y ou can incorporate the section name
into the composition by placing it as free text on the page, aligned with
background elements.

But the most effective approach, and one that deserves as much attention
as the design of your Home page, involves designing a havigation bar or
button bar that will serve as:

¢ Anelement of the site’ s page composition;
¢ A visua reminder of where the user is;

¢ A functional tool to enable jumps between sections of the site.

Wherever it's placed—across the top, down the left or right side, or
elsewhere—the “nav bar” needsto be considered afixture of the page
layout. It must never disappear or wander off to another corner. A typical
nav bar provides buttons linked to the Home page and the various section
menu pages.

| HOME  |[wHATSNEW || ARCHMWE | wHO'SWHO || PRODUCTS || LINKS |

The nav bar’s appearance can vary in ameaningful way. For example, on
pages within a particular section, that section’s button could appear
highlighted (using a different color, font style, etc.). Asthe user enters
each new section, the otherwise fixed nav bar will appear to change state,
signaling the transition.

| Home ||wHaTsnEw | ARCHVE | map | HoME | |wHaTsmEW || archve |

It's not difficult to create navigation bars using only text, and in fact
pages created with the PagePlus Wizards use these to good effect. But a
well-designed graphical nav bar will reward your efforts and set your site
anotch above the others. For further tips, consult the “Links” section
below.

If you're not using a navigation bar, at least make sure that each page has
aminimum of one or two hyperlinks, leading to the Home page and/or
related pages. Dead ends force users to rely on their browser’s “Back”
button to retrace steps, and that can all too quickly lead them away from
your site.
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The advantage of using anavigation bar isthat links to key nodes in your
site structure are built in, and you don’t have to worry so much about users
getting lost. Y ou can devote more of your time to adding hypertext links
(see below) that enhance both your content and the user’ s experience.

Designing Elements

In this section, we'll look more closely at tools and techniques you can
use to construct a site that works, both aesthetically and functionally. The
differenceisin the details.

Links

Web sites: working
with hvoerlinks

PagePlus gives you four basic ways of linking, all discussed in online
help:
(1) For standard hypertext links, you can attach a hyperlink to text;
such links appear underlined and use the link color.
(2) For asimple hypergraphic, you can attach a hyperlink to a graphic
or other object, which makes the entire object “hot” (clickable) but
doesn’t otherwise change its appearance.
(3) For more complex hyper graphics, you can draw hotspots over any
part of the page and customize their outlines.
(4) You can designrollover graphics that respond to the user’s mouse
actions by changing appearance to reflect “up” and “down” states—and
triggering a hyperlink in response to amouse click.

The World Wide Web has finally popularized the concept of hypertext,
which has been around for at least a decade. Formerly limited pretty
much to clicking our way through CD-ROMs, we' re now accustomed to
clicking 'round the world in amatter of seconds! Y et the skill of
authoring effective hypertext documentsis still initsinfancy. Here are
severa styletipsfor linking:

¢ Uselinksintext sparingly: quality, not quantity, matters. If you want
readers to finish reading your paragraph, don’t fill it full of
invitations to jump elsewhere.

¢ Don'tletlinksin text disrupt the flow of your writing. Avoid
sentences like: “Click here to learn more about placing linksin
text.” An improvement would be: “Web links are powerful, but may
cause problemsif overused.”
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¢ If you have more than a couple of links to related material, consider
listing them separately (like a See Also list), perhaps with a bit of
graphic embellishment.

¢ If your site has agroup of interrelated topics, it may be more
efficient to cluster them into a section or sub-section, with its own
menu page, rather than creating lots of sideways links between the
topics themselves.

¢ For sequential material, you can create a browse sequence (see
below).

Navigation buttons

WEe' ve already noted the value of a“button bar” as a basic layout
element. Generally, buttons are hypergraphics: graphics with hyperlinks
or hotspots applied. What should the graphics consist of, and how best to
construct them?

If your site adheres to the basic section/level model, then you’ll want to
provide links to the Home page as well as to the various section menu
pages. If you're just starting to develop your site, make sure the overall
structure is clear before you design a navigation bar. Decide what your
sections will be, then choose a concise button label for each section.
Sketch some designs on paper. If there's a chance you may add more
sectionsin the future, allow room for the nav bar to accommodate a new
button or two.

Resist the temptation to design individual icons for the various buttons.
Y ou might purloin some decent clip art, but developing a set of original,
decipherableiconsisafine art in itself, and a supreme time-waster.

Asfor the buttons themselves, they needn’t ook rectangular and beveled,
like lozenges. Artistic text works fine. Remember that whenever the
browser’s mouse pointer rolls over a hyperlink, it will change to a hand.
If the assemblage looks anything like a navigation bar, users will find it
and know what to do with it. Y ou can accentuate button labels by
separating them from each other (e.g. with lines or borders); adding
bullets or triangles; or using afilter effect on the text, such asadrop
shadow or emboss. Of course, if you like, you can create more traditional
box or oval buttons using QuickShapes.
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Another option for buttonsisto userollover graphics—objects whose
appearance changes through image-swapping in response to mouse
events. Adding rolloversin PagePlus is simply amatter of deciding
which rollover state(s) you'll want to define for a particular object, then
specifying an image for each state, and a hyperlink target for the button.
The necessary event-trapping code is generated for you automatically.

rollover graphics

Aswe ve mentioned, users should perceive the navigation bar as afixed
component of the page background throughout the site. The simplest
solution isto position the bar on the master page so it appears on every

page.

To aid navigation, you can vary the bar’s appearance from section to
section, with the button for the current section appearing emphasized or
highlighted in some way. Perhaps the most economical solution combines
abasic set of buttons on the master page with abullet or pointer graphic
on the page level to denote the current section. This approach works
especialy well with avertical list, e.g. section names:

HOME HOME

P WHAT'S NEW WHAT'S NEW
ARCHIVE P ARCHIVE
WHO'S WHO - WHO'S WHO
PRODUCTS PRODUCTS
LINKS LINKS

Placing a pointer-type graphic on each page entails alot of pasting, but
it'sworth the effort. Make sure pointer alignment is consistent from page
to page.

To achieve a highlighting effect, you can use a paint program to
customize the navigation bar graphic for the various sections of the site.

O Begin with agraphic that includes afull set of neutral
(unhighlighted) buttons.

O Makeas many copies of the graphic as there are buttons.

0 Maodify one button in each copy, applying a highlighting effect such
as adifferent color or font style. Keep therest of the graphic the
same.

This gives you a unique button graphic for each section.
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U Paste each graphic onto all pages of the appropriate section, in the
same position. (Work at high magnification and use the ChangeBar
to view the selected object’ s pixel position. Better yet, place a couple
of ruler guides and turn Snapping on.)

The effect will be that of a single navigation bar with highlighting that
changes from section to section. By the way, an advantage of using the
page level (rather than the master page) for your button bar is that you
can include a duplicate bar at the foot of each page as an added
convenience to the user. Since your pages are likely to vary in length
(that is, distance to the bottom object), you can vary the placement of the
bottom bar as needed. If it were on the master page, its position would
have to remain static.

The navigation bar is tremendously useful, but the structure of your site
may call for other kinds of navigational links. For example, suppose
several pages comprise a natural sequence. Perhaps along story or report
has been broken into several sections, or directory listings are arranged
alphabetically. In such situations, create a br owse sequence using amini-
navigation bar that lets the user step forward or backward through the
series. One way isto provide Previous and Next buttons, using fairly
standard arrow graphics:

4 PREV | | NEXT @ @

PREY  HEXT

The problem with Previous/Next buttonsis that you' [l have to custom-
link each button to a specific target page, with a different pair of links on
every page in the series. A more economical (and functional) browse
sequence bar looks like this...

00000

...where the five dots represent a five-page sequence. The square center
shows the current page. To get to any one of the five pages, the user
simply clicks the corresponding dot. If you use a set of five hotspots
“hard-wired” to the correct pages, you can duplicate the hotspot set on all
five pages, and simply place a different graphic on each page.
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Finally, while we don’t encourage long pages that force the user to scroll
on and on, it’s handy to know that a hyperlink to the current page will
force the browser to redisplay the top of the page. So in situations that
seem to call for it, you can include a TOP button (typically with a small
up-arrow) at the bottom of your page, linked to the current page. After
all, the user worked hard to get to the bottom—why make them climb all
the way back up?

Hypergraphics

Web sites: working
with hvoerlinks

Hypergraphics in PagePlus come in two flavors: graphic objects to which
ahyperlink has been attached (using Insert/Hyperlink...) and those with
one or more hotspots superimposed using the Hotspot tool. The choiceis
usually obvious. If you' re creating a button bar using separate shapes for
buttons, use individual links for each graphic (or rollovers, discussed
above). If your bar consists of a single graphic, use hotspots.

Hotspots, which are themselves graphic elements, are not recommended
for use over text blocks. They force the text to be converted to a graphic
when the page is published, which aliases and often distorts the
characters. On the other hand, hotspots over a picture don’t trigger
conversion. So if you want clean lettering as part of your hypergraphic,
create it in your paint program. (In general, use the .GIF format for all
non-photographic images you create for PagePlus Web publications, and
work in 256-color mode. See the tips further on under “ Graphics.”)

The five-dot browse sequence bar depicted above is a good example of a
simple, useful hypergraphic. The hotspots themselves comprise a group
that can be copied and pasted to various pages, while the underlying
graphic changes.

Hypergraphics give you an aternative to using hyperlinked text, which is
best reserved for use within body text. For example, if you had a set of
pages arranged al phabetically, you might like to create an alphabet users
could click on to jump to a particular page. This could be done with a
string of 26 hyperlinked text characters, but a creative a phabet graphic
with hotspots over each letter would undoubtedly end up looking better.

Y ou can use hypergraphics to create fanciful pictorial menus, visual
indexes, maps, diagrams, and other clickable previews of the content on
your site. In short, they’re fun. Use them!
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Text

Tips about text usage abound in this chapter: writing style, varying text
size as anavigational cue, when to use or not use linksin text, etc. Rather
than recap what’ s been said, we'll just make afew new points.

¢ Hardly anyone actually prefers reading computer text over traditional
print. Try to make your text inviting, at least. Asarule, users should
be able to view each text block in the browser window without
scrolling. Use short, newspaper-style paragraphs, not flowing, book-
length ones. The “inverted pyramid” style of writing found in
journalism works well on Web pages, too: use a strong lead-in and
place essential information up front.

¢ Headlines and subheadlines are useful devicesto facilitate scanning
(scrolling) and to break up the monotony of longer stories. Use left
aligned rather than centered heads. Avoid headline text larger than
24pt, which looks amateurish, and all-uppercase headlines, which
can be hard to read. For variety, you can color the heads and
subheads differently from body text—just don’t overdo it!

¢ Ingenerdl, it'snot a good ideato use more than one column for story
text, as you might in a newsletter. No one wants to scroll to the
bottom of one column and then back to the top of the next. Y ou may
see sophisticated Web pages that use tables and frames to demarcate
different kinds of content, and you may be able to emulate these
effects, but they work best with short text blocks and menu pages,
rarely for the presentation of longer material.

Graphics

Web sites: efficient

text and agraphics
Y ou can obtain pictorial content in lots of ways: scanning, grabbing
screen images, using clip art, creating from scratch. No matter where you
get an image, you'll need to modify it in some way: cropping or
enhancing it, adding text, applying a special effect, combining it with
another image. For these tasks, you don't have to be a great artist, but you
do need to know your way around a paint program like Serif PhotoPlus,
PaintShop Pro, or Adobe Photoshop. Make sure you’ ve got a package
that can save to the .GIF format. Whichever program you' re using, the
information and advice in this section will help you useit effectively with

PagePlus.
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Appearance

Web sites: choosing
a color scheme
Before moving on to some more technical aspects of enhancing Web
graphics, let’sreview afew visual design precepts with special relevance
for Web pagesin general. Asin other sections of this chapter, we're
interested in respecting the way people actually experience Web pages.

+ If you're using graphics as page elements, not just as background,
then use small, significant elements throughout the page, not just at
the top and bottom. As users scroll, the page should preserve a
balance of text, graphics, and white (background) space.

¢+ At the sametime, avoid insignificant adornments like rules, bullets,
and icons unless they're part of an overall scheme.

¢+ Don't use too many colors on the page or background. Half a dozen
per page, including background, body text, links, and graphics, is
about right to lend your site a professional appearance. (Plain white
or light backgrounds are favored.) Pick no more than two dominant
colors per page; the further any other color isfrom these
“dominants,” the less space it should occupy.

¢ Elementswith similar form or function (for example, al section
heads or horizontal rules) should share the same color.

¢ Try varying the artistic forms you use. Throw in a photograph or
two—even if they have no special relevance to your site, they’ll
enhance its visual appeal on adecorative level aslong asthey blend
into a compositional scheme. Think about using aclip art photo as a
background for alogo, text head, or navigation map. Don’t get stuck
on using just one type of graphic.

¢ Avoid blocky, rectangular shapes, which tend to make the page ook
closed, static, and amateurish. Rounder and softer-edged images tend
to open up the page.

¢ Include graphic effects that combine hard-edge and soft-edge; drop
shadows are a good example.
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The soft-edge effect known as anti-aliasing is one of the basic tricks of
the computer graphics artist. The effect getsrid of “jaggies’” along edges
by subtly applying intermediate colors. To the human eye, anti-aliased
text on-screen (especially at larger point sizes) appears of higher quality
than text without the effect. In general, always use anti-aliasing for your
graphics and headline text, unless the image contains only straight lines,
edges, and outlines.

Asshown in the illustration below, your design can include page
elements that blend with master page elements. These might include
portions of alogo, header, navigation bar, and so on. Fortunately, with
HTML 4.0 you can overlay one object on top of another and not have to
worry about overlap. You'll still need to zoom in closely and adjust the
objects on one or both layers to achieve precise registration.

:\ Page * | 99 JAN

o
Master Page

Choosing the proper format and settings for Web picturesisvital.
PagePlus relies on global settings to determine how each type of picture
should be exported when you publish the site. By default, any image you
inserted as a GIF or JPEG is exported as the original file, using its
original file name. All other graphics are converted to JPEGs.

OB Index |

Web Picture

Proverties Wizard
If you wish, you can alter these global settings (on the Graphics tab of
File/Web Site Properties...), and you can always use the Web Picture
PropertiesWizard (Web Picture Manager from the Tools menu) to
change the export settings for individual images. The Wizard lets you
check just one selected image, arange of pages, or the whole publication.
For each image, you can specify the output format: .GIF, .JPG, .PNG, or
Global Settings.
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Web Picture Properties Wizard E

The ‘web Ficture Properties ‘\wizard sets the export
options of objects in pour Web gite that will be converted
to pictures.

Wwhich pages would you ke to check?
Al

o es: Elom:l‘l_ To |4_
 Selected Object Only

To begin the \web Picture Properties \Wizard, click Finish.

< Bach I Finigh I Cancel | Help |

Here' s some very general advice on which Web image formats to use
when importing. There' s a great deal more detail on formats and
conversion optionsin online help—the topic referenced above is a“must
read”!

¢

Use the Import Picture button (or Insert/Picture... command) to
bring imagesinto PagePlus, rather than pasting them viathe
Clipboard. The fewer filter transformations an image has to undergo,
the better.

Use the .GIF format for low-color, non-photographic images with
sharp edges—for example charts or screen-capture text. The format
islimited to 256 colors, soit’s fine for grayscale photos as well.

For photogr aphic images and high-color, soft-edged graphics, .JPG
rather than .GIF isthe preferred format.

With JPEGs, image quality goes down (along with file size) asthe
compression setting increases. With high compression, some images
may still ook fine, but photographsin particular will visibly
degrade. Preview your site, and et your own eye be the judge. You
can adjust the global or local settings for .JPG compression as
required.
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Bear in mind that not all your visitors' computers will match your own
for speed or graphic display. Like the .GIF format, some monitors are still
limited to 256 colors. It's generally agood ideato switch your display to
256 colors and test the page in a browser before finally publishing it. This
will ensure you're using colorsin away that won't present problems
when displayed on average systems. The more you know about about
color palettes and image for mats, the fewer display problems are likely
to creepin.

Note: If you're quite sure al your intended visitors can display more than
256 colors, the following section isn’t required reading. On the other
hand, the knowledge is likely to prove useful when working with any on-
screen graphics, just as knowing basic color theory servesyou in the
realm of printed publications.

A major constraint imposed by 256-color systemsisthat not all systems
use the same 256 colors. The operating system reserves a certain number
of palette slots for “system colors,” and system palettes differ, for
example, between Windows and Macintosh computers. Applications,
including Web browsers, declare their own palettes and use dithering to
approximate colors outside that palette. This means, for example,
alternating pixels of red and blue (from within the palette) to approximate
apurple color outside the pal ette.

If you're not careful, dithering can ruin your best efforts. Let’s say
you'’ ve created a graphic with some solid color areas, but the user’s
browser can’t display one of those colors. So the browser dithers the
color, resulting in amottled and degraded image. If the solid color
happened to include text, the text becomes less legible.

To prevent display of thiskind, Web designers often use a Web-safe
palette of 216 colors that don’t dither in Web browsers operating in 256-
color environments. The safe palette is actually a 6x6x6 RGB “color
cube” using evenly-spaced red, green, and blue values from 0 to 255
along its axes. 51 happens to be the interval in the series of values (0, 51,
102, 153, 204, 255). So, for example, the RGB definition “0,102,51"
would be a safe color, while “0,102,52" would not. To create Web-safe
colorsin apaint program, define new colors using RGB values that are
either O or divisible by 51.
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For your convenience, PagePlus includes two swatch panels
incorporating the Web-safe colors. (Look for wWeEBSAFEL.GIF and
WEBSAFE2.GIF inthe /PP80/SampPLES folder.) Y ou can paste either one
into your paint program’s “canvas’ areaand pick colors from it using the
program’s eye dropper tool. Or you can load the supplied WEBSAFE.PAL
palette so it's used in the color selection table. It's especially important
when anti-aliasing graphics to ensure that the edge colors the program
applies come from the safe pal ette.

Asarule, if you're concerned with 256-color display, save low-color
bitmap images created in your paint program in the .GIF format using the
safe palette. Avoid using a unique palette per image; if you have multiple
GIFs per Web page, different palettes may clash and all images will
suffer.

Performance

“Performance’ may seem like an odd aspect of graphic design, but it's
actually one of the key factorsin how users will judge your Web site.
Technically, performance means load time: how long it takes for your
whole page, including text and graphics, to display completely in aWeb
browser. In practice, it's hard to measure, and subjective factors intrude.
Connection bandwidth, server speed, and modem rating al play a part.
Asdiscussed earlier, it's always wise to design the safe area of each page
to give visitors something to look at, read, and/or think about, and thus
offset the perception of delay while the rest of the page loads.

Load timeisafunction of the total size of all the page objects that need to
load; and graphics usually take up thelion’s share. That's why we can
talk about the “performance” of your page as afunction of the total file
size of its graphics.

Asarule of thumb, use 60K bytes per page as a maximum. Assuming
that the average home user’ s dial-up modem can download 3-5K bytes
per second, that’s aload time of 12 to 20 seconds. Any longer than that is
asking for trouble.

O You can determine the actual size of your files by publishing one
page at atimeto alocal folder (using File/Publish Site/to Disk
Folder...), then using Windows Explorer to examine the contents of
thefolder. View the files by date and Shift-select the most recent
batch, then right-click and choose Properties to see the aggregate
byte count. Obvioudly, the lower the better.
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Is there anything you can do to reduce the total size of your graphics,
aside from using fewer graphics? An obvious suggestion is to make them
no larger than they need to be to get your point across. Since file size
increases as the square of each dimension, shrinking both height and
width by 50% reduces the file size by 75%.

If you save graphics as Gl Fs (see above), you can take advantage of the
fact that GIFs, unlike most other 256-color (8-bits-per-pixel “bit depth”)
formats, don’t insist on using 8-bit pixels. If the number of colorsin the
imageis 128, GlFswill encode using 7 bits; with 64 colors, 6 bits, and so
on. As an experiment, we tried starting with a small image (some anti-
aliased text) that only used 14 colors. With the paint program set for 256
colors, we saved as a.GIF, yielding afile size of 1204 bytes. After
reducing the number of colors displayed in the paint program to 16—still
sufficient to display al those in the image—we saved again, and the file
size went down to 420. If you' ve got adozen or more small GIFs per
page, those little savings can really add up!

Paint programs handle color reduction in various ways. Some let you set
the image to either 16 or 256 colors, but not to 64 or 128; that’s till a
help if your images require 16 or fewer. Ideally, you can save with an
arbitrary number of colors, and the program will attempt to optimize the
image using that value. So you can pick any intermediate bit depth, and
find the one that works best for the specific image. To sum up:

U To reducefile size, reduce the number of colorsin each image, and
save as a .GIF file using the lowest acceptabl e bit depth your paint
program will allow.

If al thistalk about image formats and bit depth has landed somewhere
dightly over your head, we have two suggestions:

(1) Spend some time with agood paint program and experiment with the
techniques introduced here.

(2) Point your Web browser to the Suggested Links listed below. You'll
find awealth of advice and examples to draw upon.

Multimedia

Considering all the cautionary advice here about reducing file sizesto
achieve acceptable load time on home-based Web browsers, aforay into
multimediais clearly not for the faint of heart! Although PagePlus 8.0
allows you to insert both audio and video files—and will even embed the
filesin the original publication to facilitate your efforts—from adesign
standpoint this feature should be regarded as rather experimental .
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Although PagePlus will insert awide variety of audio and video files
(such as QuickTime, MPEG, RealAudio, and Real Video), unless you
know your target visitors can play one of the special formats you should
stick with the “generic” Windows media types. These include WAV for
audio and .AVI for video. The main barrier, of as with graphics, isfile
size. Typicaly, a.WAYV filefor speech content consumes about 10K per
second, and a compressed .AVI| file for a postage-stamp-sized, 10 frame-
per-second movie video without sound uses at |east 35K per second. If
you want an audio track along with your movie, add the two numbers
together. While these rates are paltry when the sourceisalocal hard disk,
over astandard modem (using our earlier estimate of 3-5K per second,
and we'll let you do the math) your Web visitors will have a painfully
long wait before that five-second video clip knocks their socks off. And
unless you opt for streaming media, which entails technical issues well
beyond this chapter, there’ s just no other choice.

Another obvious barrier to using audio or video is obtaining or producing
the content. PagePlus, of course, doesn’t handle either format natively—it
cannot edit or play them back—so unless you rely on borrowed or clip
media, you' Il have to master a media editing application or know
someone who can. (Any teenagers in the family?)

The good news is that just because multimedia capabilities are
“experimental” in PagePlus doesn’t mean you can't have alot of fun
experimenting! If you (and/or your Web visitors) are on aloca network
or have extremely fast Internet access, the fact that audio and video are
basically file downloads should not be a barrier. The limited support that
PagePlus offers may be exactly what you need to include that special bit
of digitized home movie footage, or some background theme music that
loops while visitors peruse your home page.

And while video on the Web may be “not quite ready for prime time,”
don't overlook the possihilities of creative audio. Y ou can add
entertainment value and interest with well-selected, short audio clipslike
single words or phrases, themes, sound effects, and the like. For longer
clips, we suggest you use the inline option, which provides a small on-
screen player. Visitors who don't care for the audio will appreciate being
ableto click the stop button!

In sum, while we wouldn’t recommend making non-streaming audio a
centerpiece of your Web site, it’s certainly another way of introducing
welcome variety to your pages. The constraints are real at this stage—but
let your creativity rise to the challenge.
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Maintaining Your Site

Using PagePlus, it'sfairly easy to keep track of the pages on your Web
site. All the originals are right there in your publication! As areference,
keep alist showing the page numbers and the contents of each page. Y ou
can store the list on the pasteboard, or (for printing out) on the last page
of your publication, which is easy to access by double-clicking the Next
(right-arrow) button. (Y ou can still publish the whole site; userswon'’t be
ableto access the last page aslong asthere are no linksto it.)

Web sites: previewing

in Web Browser

U Asyou're developing Web pages, you' |l probably need to carry out
some housekeeping tasks on your local hard drive. Note that each
time you publish one or more pages to afolder, a new set of image
filesis generated (although duplicate HTML file names are
overwritten). If you publish often, these .GIF and .JPG files can
proliferate; it's agood ideato weed out the old ones periodically.
Y ou can sort your Explorer or My Computer window contents by
date, then use the “Modified” attribute to determine which filesto
keep (i.e., the set most recently published). For thorough cleanup,
periodically publish the whole site to a new folder and delete the old
one. You aso have the option of restarting graphic file numbering
with each “publish,” thus overwriting old file names rather than
proliferating new ones—see the Graphics tab of the File/Web Site
Properties... dialog.

Web sites: publishing t

World Wide Web
A similar issue arises when publishing to a Web server. Because the
publishing process only lets you write files to a remote server, you'll
need to use another utility (either atool offered by your service provider
or ashareware FTP utility such as WS_FTP) to delete old image files
from your Web site. Just how soon this becomes an issue depends on how
much server space you' ve been allocated, the size of your pages, and how
frequently you update them.
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The question of how frequently to update gets to the heart of “site
maintenance.” Having spent days or weeks designing and then publishing
an attractive site with intuitive navigation and palatable content, you've
only just begun. The cycle is completed when visitors start arriving, and
their feedback is critical. Be direct about asking for comments, and make
sure you've included an e-mail return link. Challenge your users to
respond! Give them some specific choices to make (“Would you rather
see A, B, or C onthis page?’). Let them feel they’ re contributing. For
you, there will be an enormous difference between operating in avoid
and receiving even one or two responses.

Think of your site as more than an electronic business card—think of it as
anewsletter with publication deadlines. As arule of thumb, don’t let
more than two weeks go by without making visible changes. The changes
don’'t have to be dramatic; the main thing is to reinforce the perception
that your siteis dynamic, not static. The Home page should change most
often: add new links, or replace old graphics with new ones. Add anew
page or two, expanding the original sections. (Be sure to post notice of
the NEW! features on the Home page.) Revise the design of any pages
that aren’t working the way you expected.

Asarule, keep the background and section organization intact so as not
to confuse repesat visitors. Sections that began as a single page will
reguire a section menu as soon as a few new pages have been added. If
you've got a havigation bar with a button already linked to the original
page, turn that target page into the menu page to keep the link intact. It's
usually easier to migrate content to a new page than to rewire existing
links. (Y ou can see the content, but you can't easily seethelinks.)

Finally, feel freeto break the above rules and overhaul your siteif it
becomes clear your users are getting lost or frustrated, or if you've
discovered a better way to organize your content. In thisfledgling
medium, it's not at all uncommon for sites to undergo metamorphosis. On
the World Wide Web, change is a constant—and now, you’re part of it.
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A Few Suggested Resources

Print

a

Nielsen, J., 1999. Designing Web usability: The practice of
simplicity. Indianapolis, IN: New Riders Publishing. Trove of well-
researched pointers on interface design and content devel opment.

Siegel, D. 1997. Creating killer web sites, 2nd ed. Graphically over
the top, but technically rich resource.

Strunk, W., and E. B. White. 1999. The elements of style, 4th ed.
Boston: Allyn & Bacon. Classic writer’s handbook.

Rosenfeld, Louis, and Morville, Peter. Information architecture for
the World Wide Web. 1998. Cambridge, MA: O'Reilly &
Associates. Highly regarded overview of information design
concepts.

Tufte, E.R. 1990. Envisioning information. Cheshire, CT: Graphics
Press. Superb textbook on visual literacy.

University of Chicago Press. 1993. The Chicago manual of style.
14th ed. Chicago: University of Chicago Press. Definitive reference
source.

Weinman, L. 1996. Designing Web Graphics.3, 3rd ed. Indianapolis,
IN: New Riders Publishing. Excellent introduction to Web graphic
issues.

Zinsser, W. K. 1998. On writing well., 6th ed. New Y ork: Harper
Callins. Tips for nonfiction writers.

Links

a

info.med.yale.edu/caim/manual/index.html Yale CAIM Style Guide,
by Patrick Lynch and Sarah Horton of Yale's Center for Advanced
Instructional Media. Illustrated, annotated dissertation on all facets
of Web interface design. Also available in book form.

www.desktopPublishing.com Thousands of pages, including sections
on Design, Graphic Sites, Web Designer’s Paradise. Extensive links
to DTP resources.

www.efuse.com/start/ Attractively presented sequence of
informational pages on planning, design, building, publishing.
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www.ippa.org Internet Professional Publisher’s Association site,
“saluting the finest examples of design for commercial applications
through the Internet.” Elegant example of site design, with
interesting Essays section.

www.serif.com Forums, updates, and tips for users of all Serif
products. Online Glossary lets you browse the full version of our
Desktop Publishing QuickReference (see Chapter 6).

www.sun.com/980713/webwriting/ Writing for the Web. Authored
by Jakob Nielsen et al. (see Print resources), research-based
guidelines to improve usability.

www.wdvl.com Web Developer’s Virtual Library (WDVL).
Supersite contains dozens of sections for both novices and experts,
including /graphics/, /multimedia/, and /authoring/design/.

webdesign.about.com Collection of links and features, including
Getting Started, Animation, Site of the Week.

www.webpagesthatsuck.com Vincent Flanders’ guided tour through
examples of, ah, poor design. The site became a book and
(unfortunately) never seemsto run out of fresh material.

www.webreference.com Comprehensive developer’s site, includes
Developer’s Corner with how-to articles, sections on Graphics and
Design. Part of internet.com’s WebDev network.

www.webreference.com/dlab Archive of Dmitry Kirsanov’s “Design
Lab” columns—advice you can use. See Dmitry’s current site at
www.Kirsanov.com.

www.webreference.com/graphics Another WebReference feature,
with aslew of tutorials and contributions from Wendy Peck and Dan
Giordan.
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Introduction

How to Work with Color

In this chapter we'll take a closer look at printing using your desktop
printer, and provide an overview of commercial printing where you use
outside services for longer runs, higher quality, and/or color.

For high-volume, full-color printed pieces—such as ads, mailings,
sophisticated marketing materials, and product packaging—you'’ Il need to
use commercial print services. But outside printing can also include
asking your local quick printer to give you 100 photocopies of your laser-
printed document, or doing a short-run color job at a service bureau.

If you're thinking of getting involved in outside printing for the first time,
browse this chapter to get an idea of the principles and jargon. Try a
simple job first; don't make your first project a complex, full-color
catalog!

Desktop printing vs. commercial reproduction

Do you want desktop printing, or do you need commercial reproduction?
That is the question. The answer depends on the following principal
iSsues:

¢ Quantity. For small quantities (100 copies or so), you usually will
use your desktop printer to produce every copy. For somewhat larger
runs, it's advisable to produce just one origina (known as camera
ready artwork) and then use that for reproduction by photocopying.
For medium to long runs (500 or so and up), it's best to use
commercial printing.

¢ Quality. For many purposes, the quality produced by your desktop
printer may be entirely acceptable (especialy the latest 600+ dpi
laser printers). For higher quality, you'll need to consider using a
service bureau to output a high-resolution version of your PagePlus
publication. And you'll need commercial printing rather than
photocopying.



78 Production Issues

Color. Color ink-jets, and other desktop color printers, produce
vibrant color pieces direct from your PC. Again, for very short runs
for your presentations and so on, the output is fine. And you can use
color photocopying for slightly longer runs, although thisis still
relatively expensive per copy. In general, whether you have a black-
and-white or color printer, for color work you' Il end up using the
PagePlus options for producing spot- and process-color output. Now,
for most pieces, you' re moving into the realm of commercial printing
and high-resolution bureau output.

If you decide that you need to use commercia printing, then you'll need
to find:

¢

Commercial printer. A company that you can work with to print
your catalog, brochure, or mailing. Consult with them sooner, rather
than later.

Service bureau. If you' ve decided to produce high-resolution
output, you'll need a service bureau. The bureau will be able to
advise you about producing the output, and will be able to highlight
any areas which need special attention. Again, consult with them
early.

PagePlus print options

Special printing optionsinclude tiling, thumbnails, scaling and multiple
pages. To set special print options, choose File/Print... or click the Print
button to display the Print dial og, then select the Layout tab.

Print

General Layout | Separations | Prepress |

~Special Printing

@ A in documert 100 _,::‘ % Seale factor [ Fit Many
 Print a3 thumbnails; 1 _,::[ Per sheet
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Selecting “Print as thumbnails’ lets you print several pages at a reduced
size on each printed sheet. Specify the number of thumbnails per sheet in
the value box. PagePlus will print each page of the publication at a
reduced size, with the specified number of small pages or “thumbnails’
negtly positioned on each printed sheet.

Selecting “ Print tiled pages” letsyou print oversize artwork on severa
sheets of paper. Each section or tile is printed on asingle sheet of paper;
the sheets can then be joined to form the complete page. Thisoptionis
used for printing at larger sizes than the maximum paper size of your
printer (e.g. for posters). To simplify arrangement of the tiles and to alow
for printer margins, an overlap value can be specified.

To scale your work to be printed at alarger size, specify alarger scale
factor value and to scale down, specify a smaller value. To enter a custom
scaling percentage, just enter it in the percent field. The default hereis
100% or normal size. If the “ Scale to fit paper size” option is selected,
artwork is automatically adjutsted in size, if necessary, to fit neatly on the
printer page. “Fit Many” places as many pages as possible on each
sheet—for example, two A5 pages on alandscape A4 sheet.

Asan dternative to “Fit Many,” when you'’ re working with a page from
the Small Publications category in Page Setup, you can set “Multiple
pages per sheet” options. These let you repeat each page a certain number
of times, repeat pages to fill asheet, or print afull sheet of each page.
You can aso enter (inthe “N times’ box) a value that instructs PagePlus
to skip a certain number of regions on the first sheet of paper. Skipping
regionsis useful if, for example, you've already peeled off several labels
from alabel sheet, and don't want to print on the peeled-off sections. The
dialog’s Preview window shows how each output will look.

The Print dialog's Prepress tab includes optional settings for
professional printing. Choicesin the “Page Marks’ section include crop
mar ks that show the artwork (PagePlus page) dimensions; registration
targets that help the printer align subsequent press runs with the first one;
densitometer and solid color barsfor gauging output accuracy; and file
information to print the time, date, and publication name. For page
marks to appear, the actual paper size must be at least 1 inch (25.4 mm)
larger all around than the artwork. For PostScript® printing, the
Windows printer driver normally has some “Extra’ type page sizes that
can be used when using standard artwork paper sizes. If the paper is not
actually big enough, a warning message appears.
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Checking “ Suppress pictures’ means that pictures won't be printed, but
their position will be shown by place holder boxes. This speeds up
printing when doing quick proofs, and the key lines are useful when
pictures are added by hand (“stripped in") later in production.

The “Include OPI comments” option only applies to the production of
Postscript® print files for use with an OPI (Open Prepress Interface)
server. It is greyed out unless printing to an OPI output device.

If your design incorporates bleeds—elements that run to the page
edges—set a“Bleed limit” to extend the printable area slightly beyond
the page edges where printing would otherwise stop. Y ou can then print
to an oversized sheet which islater trimmed to the correct publication
dimensions.

Desktop Printing

Do-it-yourself output comes down to two basic choices. photocopying or
printing multiple copies on a printer linked to the PC. For small numbers
of finished items, say up to 500 items, photocopying may well be the
most cost-effective method of production. Photocopying masters
designed with PagePlus can be printed on alaser or inkjet printer.

Printer types

Small business or home PagePlus users probably have one or more of
these types of printer available:

¢ Dot Matrix printer
¢ Inkjet printer

¢ Laser printer

Dot matrix printers should not be used for anything but drafting if at all
possible. They are much slower, not to mention noisier, than the other
types of printer, and do not really produce good enough output to make
photocopy masters. Their “impact printing” method inevitably damages
the paper dlightly, and as more copies are made they get grayer because
theink isliterally squeezed out of the ribbon. If you have absolutely no
alternative, make sure that you use a new ribbon and set the Windows
printer driver to make the printer print at its highest resolution.
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Inkjet printersrepresent an intermediate stage. They give good
resolution output (and at the very highest resolution settings on the
manufacturer’ s own high-gloss paper, photographic images are virtually
indistinguishable from original photographs) for alow to mid-level
purchase price. Color inkjets are the cheapest way of getting standard-
page-sized, full-color output. They can also print overhead projector
transparencies. Inkjet printers can give good results, and can be used to
make photocopying masters.

Models from different manufacturers work in slightly different ways, but
basically they all spray liquid ink at the paper from a special print head.
Because of this, large areas of solid black or color may emerge wet from
the printer and be prone to smudging. The ink can also bleed into the
fibers of cheaper papers (such as copier paper) resulting in the edges of
letters and shapes |ooking ragged.

On the down side, because the print head and ink reservoir are usually a
single throwaway unit, the running cost per page can be higher than that
for alaser printer. At the top end of the market, however, the color
reproduction may be good enough to earn Pantone® certification.
Because inkjet printers build up the image on the paper one row of dots at
atime, it can take along timeto print afull page—up to 20 minutes for a
page with complex color bitmaps!

Laser printersare the highest specification output devices available to
most small business or home users. In a process related to photocopying,
laser printers use alaser beam reflected off a spinning mirror to
electrostatically charge alight-sensitive photoconductor drum or belt with
an image of the page. The charge is transferred from the drum to the
surface of the paper, and as the paper passes above the toner cartridge,
particles of toner (powdered ink) are attracted to the charged areas of the
paper. The powder is then sealed to the paper by a heating process just
before it leaves the printer.

Most laser printers print at a resolution of 300 or 600 dpi (dots per inch).
Some laser printers reach 1200 dpi, but these are very expensive. Laser
printer output is perfectly adequate for photocopying masters, but it may
in fact be cheaper to laser print 100 originals than to make 100
photocopies.
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There are two main standards for laser printer control: PCL and
PostScript. PCL (Printer Control Language) was devel oped by Hewlett
Packard. Printers which use PCL are often referred to as LaserJet
compatible. PostScript® was developed by Adobe Systems. It is a page
description language—if you wanted to, you could write a PostScript
program to draw acircle. PostScript printers are more expensive, but as
PostScript is also used to control imagesetters, a PostScript laser can be a
good proofing device.

The speed at which the finished pages are delivered depends on the exact
model of printer—the page per minute (ppm) rating is anominal figure
and is not wholly reliable. GDI (Graphical Display Interface) printers use
Windows system resources to build up the virtual page on the PC, not the
printer, and so their speed is much more dependent on the power of your
PC.

Optimizing photographs
Help
Photo Optimizer Wizard

Until now, it’s been difficult (if not impossible) to obtain predictable,
satisfactory results when using a desktop printer to reproduce
photographs. Because each photo is different, each requires individual
adjustments to contrast, gamma, color values, and so on. Not only that;
each desktop printer has different characteristics!

The Photo Optimizer in PagePlus gets round these difficulties by printing
out asingle image 24 ways on asingle test sheet. Each “thumbnail” uses
adifferent internal setting; al you need to do is tell PagePlus which one
you think looks best. PagePlus remembers the settings. Repeat the
process to fine-tune the settings, if you like. If you're using photosin a
desktop-printed publication, you'll definitely want to take the time to
print afew test pages using the Photo Optimizer.

Adding atouch of color

Y ou can jazz up the output from your desktop printer ssmply by using
colored paper or card. You can use plain paper in awide variety of colors
for minimal extra cost, or you can use specialty preprinted papers (for
example, from PaperDirect) in awide variety of colors and designs. You
can even get preprinted cards, certificates, brochures, and | etterheads!
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Special formats

special formats, printing

Using the PagePlus scaling and tiling options, you can use your desktop
printer to produce poster-sized output for event notices, calendars, and so
on. These print options allow you to increase the size of your on-screen
page, and print it out using several sheets of paper. Y ou can then

assembl e the sheets to make one large poster.

PagePlus 8.0 features auto-imposition of publication formats like
newsletters, brochures, greeting cards, and booklets. This means that you
don’'t have to reorder your pages, as PagePlus will put the correct pairs
together (for an eight-page booklet, page 1 is automatically printed next
to page 8, page 2 next to page 7, and so on).

Hints for desktop printing

¢ Carefully proof your publication on screen (using the Spell Checker
option) until you’ re confident everything is OK.

¢ Usethe correct driver for your printer. Some printers will work with
more than one driver, but will only have the best capabilities with the
driver optimized for them. If there is adriver specifically for your
printer, useit. New and updated printer drivers may be available on-
line from the manufacturer’s Web site.

¢ Setthe printer driver which you will use for final output as your
Windows default printer. Set the printer driver to use the highest
possible resolution. Higher resolution = more dots per inch = sharper
image.

¢ |f using acolor thermal wax or color inkjet printer, use the
manufacturer’ s recommended special paper. It will be more
expensive, but you will get better results.

¢ Useagood quality white paper to get maximum contrast when
preparing photocopying masters. If preparing photocopying masters
using an inkjet printer, consider using one of the special coated
papers which minimize ink bleed.

¢ If you can, print outsize master copies and then use areducing
photocopier to reduce the size slightly, thus increasing apparent print
density and sharpness. For example, with business cards, you can use
the scaling options to print at 200% and then photo-reduce back to
origina size.
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¢ Photocopiers do not cope well with gray scales. Set the picture color
of scanned photographs or shaded clipart to be a medium gray, rather
than Black or Original. If you are using a PostScript laser printer,
then set the Line Screen to a coarse value like 55 rather than leaving
it set to the printer’ s default.

¢  Carefully check your output, and handle the artwork with care. Don’t
fold it or get fingerprints on it, and make sure that anyone else
handling the artwork is equally careful.

¢ After you've printed your pages, you may want to consider various
DTP accessories for laminating or binding your publication for
presentation purposes.

Outside Print Services

Depending on what you print, there are several types of outside services
you may need to use. Some companies provide all these services. Often,
smaller companies have working relationships with others, and can
recommend the appropriate people for you to talk to. Y ou should talk to
several firms about what you want to do before deciding whether you
should be using one company or several.

The different service types are:

¢ Service Bureau

¢ Quick Printing and Copying

¢ Commercial Printing

If you are getting involved in commercial printing for the first time, shop

around. Try to find reputable and friendly companies. Naturally, you
should also compare their prices!

Service bureau

You'll need a service bureau (the modern-day equivalent of the
typesetter) if you want to have someone output your PagePlus or
separated PostScript files to high-resolution paper or film.



Production Issues 85

If the bureau specializesin color work, you'll also be able to get the
following services:

¢ Production of acolor proof (such asaCromalin or Matchprint)
Thisisan essential step allowing you to check your film separations
for errors, and color matching, before you go ahead with a print run.

¢ Extracopies of your films
Y ou can get multiple copies of film made from the one set of
separations (if you need to send ad film to different magazines, for
example).

+ Traditional stripping-in of photographs
The bureau produces high-resolution commercia scans of your
photographs from film, print, or disk, separates them, and strips them
into your separated films.

Quick printing and copying

Y ou can produce photocopiesin-house, or your local quick printer will
do them for you. Photocopying is quick and inexpensive for shorter runs.
Color photocopies of your color output are significantly more expensive,
but may still be more cost-effective than commercial printing for short
runs.

Photocopying may not reproduce all of your page exactly as you expect.
For example, tint areas (a shade of black, rather than a solid color) may
become muddy. Very fine lines (in text or graphics) may disappear. For
color work, the photocopy may differ slightly from your printout, which
may in turn differ from your on-screen colors. If thisisimportant to you,
make atest photocopy and/or discuss your pages with the printer.

Quick printing is done using heavy-duty desktop printers, black-and-
white and color photocopiers, and small printing presses that can print
medium-quality, short runs, direct from a desktop-printed original. Quick
printing is typically low-cost, convenient, and provides fast turnaround of
short, medium-quality print runs of, say, 300 to 3,000 copies.

Asdiscussed in the “Desktop Printing” section, you can use your desktop
printer to produce artwork originals for reproduction. Quick print shops
normally accept such copies as artwork and take it from there. Some offer
direct PC-to-color laser service. Choosing between photocopying and
printing is simply a matter of cost.
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Commercial printing

Traditional printing presses are used for longer print runs of severa
thousand or more (which iswhen using alarge pressis almost certainly
cheaper than any of the forms of quick-printing), and for short-run, high-
quality color work (e.g. abrochure). We'll have much more to say about
this option in the following section, “Professional Printing.”

With the advent of direct-to-plate printing, for example using an Indigo
system, short-run color (in runs of 500 or so) has become an affordable
option offered by both printers and service bureaus. The results are
superior to color photocopying.

Y our commercia printer will take your artwork (created either on your
desktop printer, or using a service bureau) or disk, and print your work.
Make sure you' ve first established aworking relationship and discussed
your job’s requirements.

Costs

The costs of your print run will be based on avariety of factors. These
include:

¢ How the artwork is delivered
Desktop-printed output is camera-ready and film needs to be made
from it. Service bureau output is aready fina film.

¢ Color use
Single color (black, or another color).
Spot color (how many colors, which colors).
Full (process) color.

¢ Quantity

¢ Stock
Type (paper, card, art paper, etc.), coated/uncoated, gloss/matte,
weight, color.

¢ Finish

None, varnish, lamination.
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Artwork specification

If you're producing artwork for commercial printing, you really should
discuss your requirements early with your printer, who will specify how
the artwork needs to be produced, and will advise about your desktop
printer output. If you' re using a service bureau, the printer will advise
whether to deliver film or paper, positive or negative and so on. Y ou'll
also learn about the screen angles and frequencies required if you're
producing full-color separations. We'll provide details on these options
later in the chapter.

Just as with photocopying, printing from your desktop originals may have
unexpected results if you' re anovice, and you should be aware that small
objects, fine lines, and tints may cause problems. Experimentation and
the advice of your printer will be very helpful. The “Hints for desktop
printing” above apply to artwork aswell as full publication output.

Photographs

Y our printer can also discuss your requirements for including high-
quality photographic imagesin your publication. For many people, it's
quicker and easier to strip-in photographs in the traditional way than to
include them in the publication file (for single-color work, or
Separations).

Inexpensive color options

Y our commercial printer will also be able to show you samples of
colored and textured stock which you may want to use instead of plain
white. Ask about appropriate weight and any subsequent finishing
(laminating, varnish, binding, and so on).

It's easy and relatively inexpensive to print in colored ink (instead of
black) and/or use an additional spot color for various page elements.
Spot color isaquick and easy way to add alittle color to your page.
Using the PagePlus spot-color separations option, all the “blue” items can
print out on one sheet, and all the “black” items on another. PagePlus will
produce one black-and-white sheet (separation) for each of the named
colors used on every pagein your publication. Usually you'll keep the
number of different colorsto less than four. For more information on spot
color, seethe “Color Printing” section of this chapter.
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Professional Printing

Once you need more than about 500 copies, the economic advantages of
photocopying or quick printing begin to dwindle. The fixed cost for
stepping up to professional (offset) printing is the same whether the
printer needs to be set up for 200 or 20,000 copies, to the cost per sheet
drops fairly rapidly with increased volume.

Besides economics, there may be other reasons why you need
professional printing. For example:

¢ If you need full color (also known as process color)

¢ If you need aprecise color, such asa PANTONE® reference color
¢ If you need to use a specia paper or heavy card

¢ If you need a special finish on the paper (e.g. a spray coating)

¢ Forlarge print runs

The offset printing process

An offset printing press transfers ink to the paper by indirect (“ offset”)
contact. A plastic or metal plate containing the image to be printed
transfersink to a coated cylinder called ablanket, which in turn transfers
the image to the paper sheet. Printing plates are made from film
negatives, which can be either:

¢ Shot using alarge camera (from camera ready copy which might
have been output from a high quality laser printer); or

¢ Output from an imagesetter connected to a computer, which usually
processes a PostScript file supplied by the client. The PagePlus
Professional Print Wizard will help you generate a PostScript file
that meets your printer’s needs.

One plate must be made for each color. For full color, this usually means
four plates (Cyan, Y ellow, Magenta and Black).

Usually, camera-ready copy is produced on heavy, glossy paper (called
“repro paper,” “RC paper,” or “bromide”’) by a special printer called an
imagesetter—although you may be able to get away with using a good
laser printout, especialy if the artwork is being reduced in size at the
camera stage. Some companies produce specia polyester compound
plates which can be fed through alaser printer and then used directly on
the press. These don't always produce acceptable results.
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Imagesetters usually produce output at between 1200 dpi and 2400 dpi
(compared to atypical laser printer resolution of 300 or 600 dpi). They
are very expensive and the usual way to gain accessto oneisviaaservice
bureau. Imagesetters can also produce films directly, but thisis more
expensive and removes some flexibility—you can’t add in a photograph
or illustration at the camera stage, as you can with camera-ready copy
approach. Some imagesetters can also make paper or plastic plates
straight from disk, which is cheaper, but does not allow any correctionsto
be made.

Imagesetters are essential for quality printing work, but are too expensive
for most people. A service bureau simply charges you to output your
publication to their printer. The output is high-quality paper or film which
(just like the artwork produced by your desktop printer) you give to your
commercia printer as master artwork for the printing process.
(Sometimes your printer has both bureau and printing facilities in-house,
so you only need to deal with one organization.)

Pre-planning

Make the decision to use a service bureau (or not) before you start
designing or making up any pages. For example, you may need bleed
elements (objects which print right up to the edge of the paper). For color
work and high-quality projects you should use a service bureau.

When choosing a service bureau, you really need one that uses PCs, and
preferably is familiar with producing output from Corel DRAW!-type
programs (Discussion of Adobe PageMaker and Quark X Press can be
confusing as these products are available on both PC and Mac.) If in
doubt, ask directly: “Can you handle a PostScript file on a PC disk, as
created by a Windows application?’. Be on your guard if the answer is
anything other than a simple yes or no!

Y ou may feel more comfortable with alocal company, but many
excellent organizations accept files by mail (on disk) and via modem.

Color considerations

If you want to do color work, you can use the PagePlus print separation
options to generate color-separated PostScript files. Y ou can produce
either spot-color separations or process-color separations (for details, see
the “ Color Printing” section).
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If you're printing spot- or process-color separations, check that you have
the appropriate options selected in the Print Options dialog. Y ou'll need
crop marks (which also produce registration marks), and it'sagood idea
to print file information as well. For spot-color separations just choose
the colors to output. For process color you must choose your paper type,
and check your options for trapping and overprinting.

If you're doing full-color (process-color seps) work, you should always
get afull-color proof (such asaCromalin or Matchprint) produced. It
won'’t match your final printed page exactly, but it's as close as you can
get before going on the press. It is your responsibility to ensure that
you' re happy with the colorsin the color proof before you authorize the
print run. The colors produced by the printing process will rarely match
those displayed on your screen.

If you want to include any photographsin your page, we recommend that
you have your printer “strip” them in. This means that you provide
artwork for your page without photos (but with keylines to show where
the photos go) together with your actual prints or transparencies. The
printer can do a high-resolution scan of the photos and strip them into the
film for top quality results.

If you have arranged for picturesto be stripped in, you should delete your
pictures at print time. Or use the Suppress Pictures option on the Print
dialog’ s Prepress tab, which substitutes a keyline box to show your
commercia printer where the picture isto go.

Talk to your printer or service bureau for advice. Some prefer to receive
an electronic file, including pictures, directly from you in lieu of the
traditional film.

An dternative (for really advanced users), isto use OPI (if your service
bureau supports it). The Adobe OPI options |et you include the low-
resolution FPO (For Position Only) version of your photographs which
will automatically be substituted at imagesetter time.

Proof and proof again

Carefully proof your publication on screen and have a colleague check it,
too. Make sure that the paper size is large enough for the artwork and
crop marks (they add an inch to both dimensions). Y ou need to ensure
that the printer driver page size (set via File/Print.../Properties), is larger
than the artwork size (set via File/Page Setup...). Check the values
displayed in the Print dialog.
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Before you deliver a PostScript file (as described below), always make
sure that you extensively proof your publication using your desktop
printer. Check the paper and toner/ink in your printer, select any
appropriate print options (scaling, booklet, crop marks, and so on) before
printing. This saves time and money at the service bureau stage. Give a
hardcopy printout to the service bureau, so they can check the imagesetter
output. If your printer isn’t quite up to the task, ask the service bureau to
proof thefileto their laser printer for review, before sending the output to
their imagesetter.

Always check the final paper or film produced by a service bureau before
you giveit to your commercial printer. Compare it with your desktop printer
output for consistency. It is your responsibility to ensure that it is OK!

Creating a PostScript file

A service bureau can output a PostScript file directly to an imagesetter.
Asthe PostScript file will include all the required information, there will
be no need for any bureau intervention.

Producing a PostScript file is a straightforward process. When printing
your PagePlus publication, you specify a PostScript printer (or printer
driver) asthe target, and instead of printing out sheets of paper, you
check the “Print to File” option. The driver takes care of generating the
PostScript file(s).

Make sure you have an acceptable PostScript printer driver installed. Use
the Windows Add Printer command and choose an appropriate printer
option such as Linotronic 530. Right-click the printer’sicon in the
Printers folder to access the driver properties, and set up the driver
exactly as directed by your service bureau or printer.

Before printing to disk, you'll need to know:

¢+ What type of output you require: asingle composite containing all
colors, process (CMYK) color separations, or spot color. (See the
next section for more on color printing.)

¢ What type of paper your document will be printed on.
¢ Which installed PostScript printer driver you'll be using.
¢ Thepublication’s page size.

¢+ Whether you want to print each page to a separate file and/or print
each separation to a separate file. (Smaller output files are more
easily transferable to a service bureau.)
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Choose Print from the File menu to display the Print dialog. Click the
Properties... button to select the PostScript printer, page size and
orientation, and other printer settings. Double-check the option settings
before actually printing to the PostScript file. These settings are
“remembered” throughout the session, but each time PagePlus restarts,
the print options are reset to standard defaults. If you need to make
further |ast-minute changes (for example, a custom setting required by
your print bureau, or alimited set of spot color separations), you can do
so at this point.

When you're ready to print, check the Print to File option on the General
tab to create output files on disk.

PostScript output tips

¢ Ingenera, use only the TrueType fontsinstalled on your system.
TrueType fonts (marked TT) are fully scalable and can be
extensively manipulated by PagePlus (and other Windows
applications). Most importantly, all TrueType font information is
included in your PostScript output file so you won't need to worry
about which fonts are available on the target printer.

¢ When naming output files, you can use any name you like; the
extensions .PRN and .PS are common. Y ou should create the file on
your hard disk and then save a backup el sewhere. Copy the
PostScript file(s) to a disk which can be sent to your bureau, or
modem the files directly.

¢ PostScript print files can become very large, especialy for complex
pages for color separations. Consider using removable media or
recordable CD to transfer the files. Compress large files, using an
appropriate compression utility (such as WinZip) that can zplit them
across multiple disks if needed. Y our service bureau will need the
same hardware and software to decompress your files.

¢ When sending files viae-mail, bear in mind that e-mail programs re-
encode attachments, which means that the file size of an attachment
may exceed that of the original file by 75% or so. To minimize
download problems, don’t e-mail files larger than IMB or so. But if
you must, make sure the recipient doesn’t mind receiving large
attachments!

¢ Don't forget to deliver a hard-copy proof from your desktop printer
for the bureau to “eyeball.”
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What to tell the bureau

Y ou should make it as clear as possible what you want, because mistakes
at this stage are expensive. Use the following checklist as a guide.

¢

¢

Name and subject of file: Isit clear and obvious?

Output medium: Repro paper (bromide), negative or positive film,
right or wrong reading?

Number of separations (for color work)
Number of copies required

Page size: Letter, A4, custom...

Page orientation: Portrait or landscape
Number of pages

Crop marks, register marks (for color work): Printers often use
oversize stock and may want to have these marks as a guide

Paper proofs. Supplying a paper copy of the design will help make it
clear what you want

Make sure that everything you send to the bureau is clearly
identifiable. Label disks with the filename, your name/company,
phone and fax numbers, and job number if you have it. Also label
paper copies and other instructions so they don’t become separated
from the job to which they relate.

When you receive the camera-ready copy or film, it should be
handled aslittle as possible. When it must be handled, do so with
great care, picking it up by the edges with clean hands. Films and
repro paper are easily scratched and marked, for example by
fingerprints or sharp objects. Never write a note or instruction for the
printer on camera-ready copy—always do a separate note.
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Color Printing

For each page, PagePlus can produce a set of black-and-white output
(seps), each of which represents one color component of the page. To set
separation options, use the Separations tab of the Print dialog.

Print [ =]

General | Layout  Separstions | Prapress |

[¥ Enabie Separalions

Options—————————————— 7 Trapping ——————————

* Process Graphic TrapValue: |10 =
" Spot Graphic Max Trap:  |0.3pt _,::'

= Eerven Panicre Spot
colars ta Pracess

TostTisplalue:  [03p1 =
Text Thiesheld: BES]

Paper Type |NEWSPRINT PAPER (85 LPI) =

1 Color [ Frequency | Angle [ Overprint [
=] Cyan %00k 10500 Deg =]
om Magenta @0l 75.00Deq o
u] Yellow %50k 90.00Deg u]
om Black @0l 45.00Deg
Preview <¢ Hep | Bt | Cese |

There are two types of separation:

¢ Spot-color separation means separation into the individua colors
visible on apage (“red,” PANTONE Reflex Blue and so on).

<>

Process-color separation means separation of everything into
percentages of the four so-called “process’ colors (Cyan, Magenta,
Y ellow, and Black). All printable colors can be expressed,
approximately, in terms of process colors.

printing: of color
separations

Color in PagePlus publications

color

By way of summary, PagePlus includes the following key color features:

¢ Unlimited color mixing
You can create virtually any color using the HSL (Hue, Saturation,
Luminance) or RGB color models, and specify custom CMYK
colors.
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¢ Industry standard PANTONE®* Colors
Choose from the Process Color System or Spot Color System
pal ettes, with automatic conversion of PANTONE Spot colorsinto
process colorsif required.
*Pantone, Inc.’s check-standard trademark for color reproduction
and color reproduction materials.

¢ Apply colors and shades, gradient and Bitmap fills, and transparency
to pictures, text, and graphic objects

¢ “Colorize” pictures
This allows you to change full-color images to asingle color, or
shade of color. You can adjust the intensity of the original colorsto
generate alow-intensity version for use as a background image.

Color Mavper

¢ Color Mapper for vector images
The Color Mapper alows al imported vector images and vector-
based OLE objects to have their included colors replaced by existing
PagePlus palette colors (or standard PANTONE colors).

¢  Color-separate full-color images
PagePlus imports, displays, and process-col or-separates 24-bit color
imagesin virtually every industry standard format, including .TIF,
.PCX, .JPG, .GIF, and PhotoCD.

¢ Import pre-separated CMYK TIFFs
PagePlus can generate the ultimate in picture separation quality by
importing pre-separated .TIF files from Adobe and equivalent
programs.

¢ Spot-color-separate vector files and vector-based OLE objects
PagePlus can produce spot-color separations from any vector-based
imported image or OLE object. Thisincludes Serif DrawPlus and
other Windows applications like CorelDRAW! and Microsoft Excel.

¢ Print spot color separations to any kind of printer, not just a
PostScript printer

¢ Standard and customizable screen angles and frequencies
¢ Support for the Adobe OPI specification

¢ Create custom registration marks using objects and the [Register]
color
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¢ Suppress Picture output option to facilitate traditional picture

stripping

¢ Automatic color trapping on output for both text and graphic
elements

Spot color

On the press, the color of the printed piece has nothing to do with the
color of the original image or computer file. It depends on the color of the
ink that the operator putsin theinkwell. Put in red ink instead of black,
and your pieceis printed in red.

Suppose you want aflyer printed in black and red ink (for example, the
business name and alogo in red, everything elsein black.) To do this,
two plates are needed: one with the part printing in black, and another
plate with the part printing in red. Each plateis “inked” from areservoir
with either red or black ink, the image is transferred in turn to each sheet
of paper, either by running the paper through the press twice (first to print
the black part and again to print the red part) or by using atwo-color
press with two ink reservoirs and plate mountings.

Two pieces of film are needed for plate making: one for the black plate,
and one for the red plate. The colors that are printed depend only on the
colors of ink put into the reservoir. If you changed your mind, you could
use the same plates and just tell the printer to fill the reservoir with blue
ink instead of red, and your job would now be printed in black and blue.
If you were to decide that you wanted the red logo to be in black, then
you would need new plates.

Y ou can create an illusion of more colors by using tints of a color, with
the same color ink applied through a screen of tiny dots (that’s how a
newspaper photo is printed). For example, you could make one headline a
70% tint of black, and print alogo in a10% tint of blue behind the type.
You don't get more colors, just different shades of the colors you are
using. Y ou don't need extra plates to print these tints as they go on the
same blue and black plates which you aready have. The tints can be
created by a photographic process (for camera ready copy) or specified in
the software before output from the imagesetter.

Note: Darkened colors that have not been added to the PagePlus pal ette
will be spot-separated incorrectly, using the base (100%) value. To
ensure that these colors are properly handled, add them to the palette
before printing.
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Full color

What about printing a color photo or picture with hundreds or thousands
of colors? It’ s not practical to run ajob thorough a press hundreds of
timesto print a picture. Thisiswhere CMYK comesin.

CMYK isaprinting process which uses four different color inks: Cyan (a
light blue), Magenta (purple-red), Y ellow, and Black. They are not solid,
but semi-transparent, and when printed using four different color plates
on the press, the inks laid down on each pass will overlay the inks laid
down earlier and mix on the page to create a wide range of colors. Tints
of each ink are used, with each combination creating a different color.
100% Magenta on top of 100% Y ellow ink gives awarm red; use less
Magenta (say 70% or 50%) and you'll get shades of orange. Add asmall
amount of black for a darker shade.

The inks are not physically mixed together—this would just result in a
muddy dark brown color—but they are mixed optically when you look at
the paper. Printing like thisis called process color printing; the printing
method for adding just one or two colors is known as spot color printing.
Cyan, yellow, magenta, and black inks are used because they can be
mixed to produce almost every color you might want. However, they
cannot produce every color available as a spot ink, and can produce far
fewer colors than you can see on a computer monitor.

Color matching

Printing creates colors by mixing inks and absorbing light. Mix the four
processinks, and you get black. No ink gives you white (i.e., the color of

the paper).

A monitor produces an image by producing light. It also mixes from
primary colors, using a mixture of Red, Green and Blue to create colors
(hence, RGB). Mix all three colors together and you get white light. Turn
all the elements off and you get black. Different brightnesses of each
element give arange of colors much greater than can be printed with
CMYK inks.

¢ Therange of colorsyou can mix with agiven processis referred to
asacolor gamut.

¢ CMYK isasubtractive model.
¢ RGB isan additive model.
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CMYK isnot better than RGB. They are two entirely different processes
for two different applications. If you tried to use red, green, and blue inks
on your press, what appeared white on your screen would be adark mess
on your paper.

The RGB and CMYK color models are not really compatible. It is
possible to make an approximate conversion, but you should never rely
on the colors on screen being exactly the same aswhat is printed. It's
very difficult to convert accurately between the two models. The problem
exists with 24-bit graphics and true-color monitors, and becomes even
more pronounced if you work using alower graphics mode.

If you are printing process color separations, you should use Adobe
PhotoShop or asimilar program (for example Serif PhotoPlus, Corel
PhotoPaint, or JASC Paint Shop Pro 5) to convert from an RGB file
format to uncompressed CMYK TIF format and then reimport the
pictures. Frankly, having to do thisis a pain, but avoids problems and
nasty surprises later. Film or repro paper is expensive, not to mention the
time spent correcting the mistake.

One solution isto use the PANTONE® Color Picker, built into PagePlus,
which lets you add PANTONE colors to the color palette. The
PANTONE Color Matching system is an internationally recognized
system for color matching. When a PANTONE color is output, PagePlus
uses optimized color values to achieve a better color match. The on-
screen color display isonly an approximation—don’t rely on it for
accurate color matching. For precise reproduction, use official

PANTONE color reference material s (swatches).

If you' re concerned about the printed colors, you have to produce a
Cromalin, Matchprint, or other press proof. It won’'t exactly match your
final printed page, but asit’s created from your separated films, it
provides afina check that the filmsare OK. It's as close as you can get
before going to press. Don't authorize the print run until you' re happy
with your colors as seen in the proof.

Registration and trapping

When you print color separations, PagePlus generates film for each print
ink. The alignment of each film (and the actual printing plates) is
controlled by the registration marks which are printed outside your
printable page area. Y ou can create custom registration marks by creating
objects using the [Register] color in PagePlus.
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PagePlus automatically “knocks out” overlapping text and graphicsto
give“kissfit” trapping. Y ou can specify black overprinting for text and
graphic elements, to avoid any trapping problems as aresult of press mis-
registration.

Y ou can al'so specify that PagePlus uses automatic trapping for all text
and graphic elements. In each case, you can specify a spread value for the
overlapping object.

Screen angles and frequencies

In conjunction with your commercial printer, you can specify custom
screen angles and frequenciesin the Print options. Alternatively, you can
simply use the default PagePlus values, which have been preset for a
range of standard papers.

Deciding among color output options

Y ou can create full-color pagesin PagePlus, and you can output them
using its built-in separation capabilities. But should you? The choices are:

Print separations from PagePlus

Using the Print options, you can print spot- or process-color separations
directly from PagePlus for all items on your page. Thisis the most
inexpensive way to create separations, and if you do alot of color work
you may prefer to do this. Y ou also have to take responsibility for
scanning any images and dealing with the technical issues of color work.
Using photographs requires good-quality scanning, and these files can
become very large (and in turn, produce very large PostScript files).

Print seps from PagePlus combined
with traditional separation

This approach uses the separation capabilities of PagePlus for all
elements except photographs. Y ou create your layout using low-
resolution FPOs (For Position Only) of your photos and establish size,
position, rotation, and runaround. Then (after deleting your images or
using the Suppress Pictures option) you produce the color separations.

Y our commercial printer and/or service bureau will scan high-resolution
versions of your photos, and strip these in to create final film. If you want
the highest possible quality, or you want to avoid the learning curve of
desktop color, take this option.
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Print separations from PagePlus via
a high-end color system

Y ou can link PagePlus to high-end color systems (e.g. Crosfield, Hell,
and Scitex) which support the Adobe OPI (Open Prepress Interface)
specification. Using the PagePlus OPI Print option, you can create your
PostScript separations with embedded OPlI comments.

The repro house will scan your photographs and create low-resolution
FPOs, and high-resolution commercial scans for later use. As discussed
above, you use FPO photosin your layout. The OPI comments enable the
color system to replace your low resolution images. In effect, this
approach is automated stripping.

Summary

This chapter hastried to give you an overview of the production issues
involved in commercia printing. As with everything else, the best way to
find out the detailsis through experience.

With PagePlus and its sophisticated print options, commercial printing is
now definitely an option for everyone. It’s worth considering for colorful
greeting cards, handouts, brochures, and so on. You'll be surprised by
how inexpensive short-run color printing can be...

However, don't ignore the issues of color matching and inclusion of
photographs. Make sure your first few commercial printing projects are
simple, and allow plenty of time for the production process. Only when
you've successfully completed afew simpler commercia printing
projects should you attempt a project of real consequence, or one with a
tight deadline.
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A Hands-on Project

|

This chapter presents alearning sequence developed in the spirit of a
construction kit. We' ve provided the raw materials and instructions; you
provide several hours of your time, moving at your own pace. There are
no prerequisites. You'll get results quickly, and fedl a sense of
accomplishment each step of the way. When you’ ve completed the
project, you'll have not only a useful visual reference but afirst-hand
knowledge of basic Desktop Publishing techniques—both of which you
can apply to your personal design projects.

What it is

You'll be assembling an 11-page publication called a Quick Reference, or
QuickRef for short. The process transforms a text-only glossary of DTP
termsinto avisual glossary with inline illustrations of typographic terms
and techniques. Just a browse through the pages of this chapter will give
you an idea of what'sin store and the DTP terminology you'll be
introduced to.

Of course, we could have simply printed the QuickRef as a Companion
chapter—but then you would have missed a great opportunity to learn
about PagePlus and DTP at the same time!

What it isn’t

The QuickRef project is not afeature-by-feature tutorial—for a more
systematic, beginner-level introduction, you should start with the
Tutorials on the Design CD. There's a bit less hand-holding here. The
QuickRef takes you through a straightforward production sequence: just
begin at the beginning and follow the instructions. Along the way, we'll
introduce you to the tools you need to get the job done—without long
digressions on design principles or technical details.

You'll find the emphasis here is on black-and-white fundamental s rather
than color-specific techniques. But don’t let that limit your imagination!
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Before You Begin...

Here are afew tips before you undertake the project:

The QuickRef uses avariety of TrueType fonts, which are included with
the standard PagePlusinstallation. If the instructions call for afont and
it's not installed on your system, go back and run the install program
again. Thistime, choose the Modify option, and select a Custom install
with the “TrueType Wizard Fonts” option checked.

When called for, source files for the QuickRef project can be found in the
\PROGRAM FILES\SERIF\PP80\SAMPLES folder on your hard drive (if you
did a Recommended install); otherwise, look in the \SERIF\PP8O\SAMPLES
folder on your PagePlus 8.0 CD.

Follow all instructions to the letter. (And how else, for atypography
primer?) To-do steps are noted with an open check box. () So as not to
skip a step inadvertently, it might be wise to make check marks on the
page as you proceed.

How to Start, Save, and
Close Publications

Save your work often. Y ou can give the QuickRef file any name you
choose. It's sound practice to Save As frequently, to adifferent file name
so if something happens to your current file you can fall back on the
previous version. For example, you could begin with QRer1.ppPP, then
save as QREF2.PPP, and so on. Or alternate between the two names.

Select, Copy. Move, and
Resize Objects

The currently selected object displays a bounding box and eight small
“handles.” When selecting an object that overlaps another, click
repeatedly until the object you want is selected. Clicking over text objects
will place the text editing cursor and alow you to select areas of text asif
you were using aword processor. To manipulate the frame itself, select
its bounding box.

If you're not already familiar with the various Zoom buttons on the
HintLine toolbar at the bottom of the PagePlus window, take a moment to
glance at their “tool tip” messages and try them each out. It’'simportant to
feel in control of these options.

Take heart! If you make a mistake, most actions can be undone by
choosing Edit/Undo or pressing Ctrl+Z. Y ou can set the number of levels
of undo using Tools/Options/General.
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Setting Up the Publication

Starting from scratch

At the Startup screen, click the Start from Scratch option. From the
Regular/Portrait category, choose the standard Letter format (A4 for users
outside the US and Canada), click Finish, and the new publication will
open with one blank page.

Initial settings

Whether you’ ve used PagePlus many times before, or not at all, you'll
need to set various preferences and defaults a certain way so that the
instructions here will produce predictable results.

O Choose Layout Guides... from the File menu. We'll only need the
Margins tab for this project. The number of Grid rows and columns
should be 1. For a L etter-size page, set the marginsto: Left .75
inches, Right .75, Top .75, Bottom 1.00. For an A4-size page, set the
margins to: Left .63 (1.6cm), Right .64 (1.62cm), Top 1.00 (2.54cm),
Bottom 1.44 (3.66cm). All check boxes should be unchecked. Click
OK.

O Choose Options from the Tools menu, and on the Layout page turn
on (check) Display guide Lines, and Display frames. Turn off
(uncheck) Grid Dots.

U Onthetop View toolbar, click the the E Fit Page button. On the
HintLine toolbar along the bottom of the window, start with the ﬂ
Snapping button down and the @ ChangeBar button up.

This means we' Il begin with aview of the whole page with the Studio to

the right; the Snapping feature turned on (for aligning the first elements
we create); and the ChangeBar hidden (we'll get to that later).

If you're using PagePlus for other publication work and need to change
these settings before you' ve completed the QuickRef, be sure to return to
this step and restore this setup before resuming the sequence.

Footer and header

To get started, you'll install a pre-built footer into your QuickRef
publication and create a simple header.

U Beforeretrieving the footer, save your Untitled publication under any
name you choose (for example, QREF1.PPP).
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The QRerMAST.PPP file, located in the Samples folder, contains several
pre-built elements you'll be copying into your QuickRef.

a

Choose Open... from the File menu, then locate and open
QREFMAST.PPP. Click the footer group at the bottom of the page to
select it. Press Ctrl+C to copy it to the Clipboard. Close
QREFMAST.PPP by clicking the X button in the top-right of the
window (we won'’t need thisfile for awhile). Y ou're back in your
QuickRef. Note that if you need to you can switch between open
PagePlus publications using Ctrl+Tab.

PO Index |

master pages

Typically, the header and footer are elements that repeat on every page;
for this reason they’re placed on the publication’ s background, or master
page. We'll paste the footer to the master page.

g

Click once on the {191 [* Cyrrent Page box at the left of the
HintLine toolbar to switch to the master page. Make sure Snapping is

on, and click the =] Actual Size button. Now press Ctrl+V to paste
the footer. Drag the footer group down to the bottom of the page and
position it so the top of the gray box is touching the blue bottom
page margin.

Now to make several minor adjustments to the footer.

a

Click to select the footer group, then click the ] Ungroup
button attached to the group. Y ou'll see three selected elements: a
gray box (QuickShape), text frame, and alight gray circle. Click off
to one side to de-select everything. Then click theright end of the
gray box (unobstructed by other elements) to select it. Now you'll

see acontrol handle ™ to the | eft of the box. For rounded corners,
adjust this downward until the HintLine shows that the corner radius
is about 65%.

The footer needs a page number, so we'll insert a special page number
field that will update on each page. For this and for many other short
blocks of text, we'll employ artistic text instead of frames.

a

Locate the light gray circle at the right of the footer. Choose the ﬂ
Artistic Text tool, then click and drag down and to the right to obtain
a starting point size approximately as big as the circle. In the Point
Sizelist box on the Text toolbar, choose 30 pt, then click the Bold,
ltalic, and Centered buttons. From the Insert menu, choose Page
Number.
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U For precise placement, turn Snapping off for amoment. Movethe
pointer over the text object’ s bounding box, and when you see the 3*
cursor drag the object so the numeral is centered right over the circle
in the footer.

U Turn Snapping back on and scroll up in the window so you can see

the top margin. Choose the M Straight Line tool and, holding down
the Shift key, draw aline from the l€ft to the right margin along the
top page margin. Then drag the line up a bit so it’s above the margin.
Click the Studio’s Attributes tab and select the Line panel. Using the
list boxes, select aweight of “2.5”, and from the line style previews
click “Line Style 10" (watch the popup tooltips). In the Attributes
tab’s Color panel, click the black sample, and under “ Shade/Tint”
move the slider to about “+20%".

Page One — “Anatomy of a Page”

For the first page of the QuickRef, we'll import a pre-built layout that
also provides an introductory labeling challenge.

O Click on the Current Page box to leave Master Page Mode, save your
work and choose Open... from the File menu. Open ANATOMY .PPP,
located in the Samples folder. Choose Select All from the Edit menu,
then press Ctrl+C to copy the entire set of selected objectsto the
Clipboard. Close ANATOMY .PPP.

O Back in the QuickRef, choose Fit Page view, then press Ctrl+V to
paste the objects to page 1. With all the objects still selected, adjust
the positioning of the multiple selection between the margins. Adjust
the placement of the footer (on the master page) if necessary, so the
page elements don’'t overlap it. Save your work again.

O When completed, “ Anatomy of a Page” will be avisual referenceto
the parts of atypical newsletter layout. There's at least one example
of each of the 16 itemslisted. Your challenge: to finish the layout by
labeling it, using the numerals from 1 to 16 included at the bottom of
the page. Try it now!

U Eachlabel isagroup object consisting of a square and a numeral.
Select each label and drag it to a suitable position. If you' re unsure of
some of the terms, just continue to the next section of the QuickRef.
Y ou can return at any time, once you'’ ve located the definition you
need in the Glossary.
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The Glossary Story

Frame setup

text frames:

creating, linking, and using

The Glossary itself will begin on page 2. Before importing the text, which
will fill about six pages, we need to set up atemplate page with atwo-
column frame.

W]

Click the Studio’s Pages tab and in the lower (Pages) panel, click
the ﬂ Insert Page button. The new blank page appears.

To create the frame, first click the = Standard Frame Tool button
on the left-hand Tools toolbar, which will give you the standard
square-shaped frame tool. Click at the upper left page margin corner
and, holding down the mouse button, drag out a rectangle as far as
the lower right page margin corner (but don’t overlap the footer).
Rel ease the mouse button.

Since Snapping is turned on, the new frame sensibly aligns to the nearest
guide lines—those for the page margins.

O

Right-click the new frame and choose Frame Setup.... Type“2" as
the number of Columns, and enter “.1” inches (0.25cm) in each of
the Margin boxes (top and bottom margins are set in the middle of
the window). The column gap should be 0.2 inches (0.5cm). Click
OK.

With the new frame selected, choose Update Object Default from
the Format menu so these settings will bein effect for frames you
create |ater.

Importing the Glossary
WE'll begin importing from page 2.

a

Right-click the frame and choose Text File.... In the file selection
diaog, specify Files of Type: “Rich Text (.rtf).” Locate thefile
GLOSSARY.RTF in the Samples folder and double-click its name. As
importing proceeds, answer Yes to the option to Autoflow; this
means PagePlus automatically creates new pages, with linked frames
holding all the text of the “story” being imported. (If you get a
prompt to AutoFit, answer No—we want to |eave the text size the
same.)
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When importing is done, you'll be looking at page 7, with that page’s
main frame partialy filled.

The next step isto carry out a simple Find/Replace operation to insert
spaces between each glossary term and its definition. We'll be using
WritePlus, the built-in story editor.

O Right-click the frame and choose Edit Story to open WritePlus. The
full text of the Glossary story appears.

O Press Control+F to open the Find & Replace window. In the Find
box, type “#" (without the quotation marks) and in the Replace With
box, type“ ” (two spaces). Click Replace All. Shortly the “PagePlus
has finished searching the document” message will appear. Click
OK, then click Close to dismissthe Find & Replace dialog. Finaly,
click the close (X) button in the top right of WritePlus to return to
your document view.

The Glossary text asit stands is essentially complete, minus the
illustrations we' Il be adding later. Y ou may wish to print out pages 2 to 7
now for your own reference. This might also be a good point to save your
work as anew version, for example incrementing from QRerF1.PPP to
QREF2.PPP.

Room to grow

At present, the Glossary story text is contained in six linked frames on as
many pages (2 to 7). Aswe proceed to add illustrations throughout the
text, the story will overflow beyond page 7. Sooner or later, we'll need to
create some additional pagesto contain the overflow. It may aswell be
now.

O Starting on page 7, click the Next (right arrow) button to open the
Page Manager. Enter “3” for the number of pagesto add (after page
7) and click OK. Y ou should now be looking at page 8 of 10. Create
astandard text frame on each of your three new pages, as you did on

page 2.

We now have three new pages with blank frames, but the frames will
need to be linked into the Glossary story sequence.
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U Onthe Studio’s Pages tab, double-click the“7 of 10" page
thumbnail to jump to page 7, which includes the last frame presently
linked into the Glossary story. Click on this frame to select it. At the
bottom of the frame, you'll see asmall button with ablack arrow; it's
called the Link button. Click it to begin linking frames. Now click
the Next (right arrow) button to go to page 8. To complete the link
from page 7' s frame, just position the pointer over the page 8 frame
(you'll seethe “Textflow” cursor) and click once.

U Repeat the linking procedure twice more, from page 8 to 9 and from
9to 10.

Let’'s take one more step, which will help to clarify how all this content is
going to be distributed over the pages.

U Jump to page 2 and click Actual Size, then locate the entry for the
term “caption”. Click for an insertion point at the start of thisline,
and press Ctrl+Shift+Enter, the shortcut for a Page Break. This
forces the “ caption” entry to the top of page 3.

U Proceed through the document and repesat the page break procedure
in front of each of these entries: “cursive,” “font,” “kerning,”
“ornamental cap,” “reverse,” “shading,” and “white space.” You can
remove any of these breaks later if they’re superflous.

a

Page Two — “accent” to “cap line”

Now for the main business of the QuickRef project: producing a series of
inlineillustrations for key Glossary terms. We'll proceed aphabetically,
S0 as soon as you' re done with a page it will be ready to be printed out as
areference.

alignment

For the first illustration, we'll apply four different kinds of paragraph
alignment to some sample text.

U Open QReFMAST.PPP in the Samples folder. On the left, you'll seea
text frame containing four paragraphs. Click on the frame's bounding
box to select it, press Ctrl+C to copy it to the Clipboard, then close
QREFMAST.PPP.

U Navigate to page 2 of the QuickRef publication.
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For a suitable working view, you want the page edge centered in the
window, with pasteboard area on one side and a column of text on the
other. Usually, you'll want to be zoomed-in enough to read the text in the
column, but not so close that you sacrifice workspace.

O To set the view, click the 2| Zoom Tool button and drag out a
“marquee”’ selection rectangle around the top left quarter of the page
area, including some pasteboard area as well. Can you read the text
of the “alignment” Glossary entry? Y ou may need to use the Zoom
Out or Zoom In buttons for a better view. About 70% should be
right. Is the page edge in the middle of the screen? Use the lower
scrollbar or the Pan Tool to adjust the view.

Before continuing, you may wish to experiment with the various zoom
and pan controls on the HintLine toolbar. Y ou can also right-click on an
object and choose Zoom In or Zoom Out.

O Press Ctrl+V to paste the text frame, and drag it over to the
pasteboard on the | eft of the page. Starting with the top paragraph,
click each onein turn and apply the appropriate paragraph alignment
using the alignment buttons on the Text toolbar: Left aligned,
Justified, Centered, and Right aligned.

Setting the text wrap properties of our illustrations will be an important
part of preparing them for inline insertion into the layout. Wrap settings
control how the text in aframe flows around an object. Usually we'll set
the properties before inserting the object, then fine-tune the object’ s
“wrap outling” values as part of fina positioning.

wrapping text around
objects

U Right-click the newly pasted frame and choose Wrap Settings. In
thedialog, click Square and Both Sides, and change al four default
Distance From Text valuesto “.2” (0.5cm). Click OK.

O Drag the frame over the left column of page 2 text, just below the
“aignment” entry. Use the Pointer tool to adjust the frame's
placement and width so it’sinset slightly from the existing column
margins. Drag the frame’s bottom, middle handle down several
inches so the frame is about six inches high; we'll closeit up later.

Now for finishing touches: standoff rules and white space.
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W]

Click oncein the first paragraph of the smaller frame.

Thiswill give you atext edit cursor. Remember, should you need to cycle
through overlapping objects, just Alt-click several timesin the same
place.

a

Select Paragraph from the Format menu. Select the Line tab and
click in the top half of the Line Selection box.
Typethevalue“.2” (0.5cm) for the Gap. Click
the Line Style button, specify 2.0p as the Weight,
and make sure you're using the first line style
fromthelist. Click OK twiceto apply the
change.

Line Selection

Repeat the process for the bottom paragraph of the new frame, but
thistime giveit aLine Below, clicking in the lower half of the Line
Selector, using the same line settings.

Click in the centered paragraph and drag each of the Indent Handles
on the ruler about a quarter-inch (or 0.5cm) towards the middle of
the paragraph. This shortcut adjusts the block’ s left and right Indent
settings, making it easier to see the centered-text effect.

Now we'll ater the distance between the four paragraphs we' ve
reformatted.

a

Sel ect the second paragraph. Open the
Format/Paragraph dialog and select the
Spacing tab. Set the Before value to
12.0pt. Repeat this separately for
paragraphs 3 and 4.

of text 1z 1eft aligned. It's flush with
n, at the

Finally, select the example frame and
adjust its bottom edge (using the bottom,
middle handle) until the frameisjust
dightly larger than the text inside,
including the ruled line.

Great job! That wasn't trivial, especialy for starters—but the alphabet is
dictating the project sequence here... By the way, don't forget to save
your work.

Bézier

W]

Since we' re now working on the right column of page 2, adjust your
window view accordingly, with the pasteboard on the right side of
the screen thistime.
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How to Use LogoPlus

a

Click the Insert button on the Tools toolbar and choose @
LogoPlus (LogoPlus) from the flyout menu. Drag out aregion in the
right column just below the “Bézier” entry, from the left to the right
column margin and a bit more than ¥-inch (about 1.5 or 2cm) high.
When you rel ease the mouse, LogoPlus launches.

In the list of templates, choose Blank, the default (perhaps taking a
moment to preview some of the others), and click OK. In the Text
Entry window at the upper |eft, type “Text on aBezier curve...” and
from the double row of buttons on the right side, click the top right
Bezier Text button. Instantly the text you typed appearsin the
Preview pane. If you want, you can use Ctrl+Alt+e to type an
accented character “€".

Locate the Text Size list box (it initially says“Auto Ps’) and select a
value that better fills the LogoPlus preview pane (the dashed
magenta box). Click the Size and Position button to see this set of
controls, and click the left-arrow position button until the text begins
at the left side of the dashed magenta box (it shows the actual region
you dragged out).

Click theﬂ Text Attributes button to return to that set of controls.
Thistime, double-click the Bezier Text button to edit the curve.
When you click on the curve in the Edit Curve window, you'll see
three nodes, each with handles. By dragging nodes and/or handles,
you're altering the mathematical parameters of the baseline upon
which the text rests. To update the preview, click the Accept
(checkmark) button; if you mess up, click the Cancel (x-mark)
button. Experiment! (Remember, you can’t damage anything.)

Once you' ve created some semblance of an attractive curve, click the
LogoPlus Accept button to update PagePlus. Right-click the object
and choose Wrap Settings. Set the wrap to Top & Bottom, leave the
Distance From Text asis, and click OK.
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U For fine-tuning object placement, zoom in quite tightly on the
LogoPlus object and the “Bézier” entry. Now use the Pointer tool to
adjust the object’ s position so it’s just between this entry and the
following entry for “blackletter.” To fine-tune the wrap, select the

=] edit Wrap button on the toolbar to view the wrap outline and
nodes. Drag the nodes (corners, in this case) of the object’ s wrap
outline so there’ s a small amount of white space above and below the
example. Keep the left and right edges of the wrap all the way out to
the column margins, so there are no gaps for text to flow into (it's
dippery stuff!).

blurb

This exercise introduces another standard publishing technique we'll be
using. Adjust the window view so you'refairly close in on the entry for
“blurb.”

U Click at the end of the “blurb” entry and create a new line by
pressing Enter on your keyboard. Just start typing, exactly these
words: “Don't just sit down in front of the PC and divein...” Press
Shift+Enter to insert a soft return (line break). Continue typing:
“Take some time to plan your design!”

U Triple-click over any of the words you’ ve just typed and the whole
paragraph should select. Aim for the word “Don’t” if you’ re unsure
where to click—you’'ll soon get the hang of triple-clicking (three
clicks of the left mouse button in quick succession) On the Text
toolbar, set the text to “Arial” and “14.0p". Then choose Update
Text Default from the Format menu so these settings will be in effect
for new text objects you create | ater.

O Makethetext Bold and Italic using the buttons on the Standard
toolbar.

U Adjust the left and right indents for thistext by clicking once
anywhere amongst the words you typed, and then moving the ruler
indent guides. Remove the hanging indent by lining up the two left-
hand guides. Then the left-hand pair can be moved together by
dragging the small horizontal bar just below the lower guide. The left
indent needs to be approximately 1.25” or 3cm. Indent the right-hand
side of the text until the first line ends with the word “down.” Adjust
the paragraph spacing using Format/Paragraph—on the Spacing
tab, settings of 8pt Before and 10pt After should be fine.
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Choose the g Box button from the QuickShape flyout and drag out
to create a narrow, upright box just to the | eft of the text you've just
added. Open the Color panel of the Studio’s Attributes tab. Click the

@ Line button and then click

the“None” (empty) sampleto e & :
remove the line. Click the Fill D O;j £ us:rs’;t d’gévn
button, then click the black in front of the

sample. Drag the Shade/Tint and dive in..:
slider to “+40% . Take some time to

lan your design!
Adjust the size and position of plany g

the box as shown, and you’ re done!

boldface

a

Click at the end of this glossary entry and press Enter to start a new
line. Type “regular bold heavy” on the new line. (Y ou might need to
replace the capital “R” with alowercase “r” at the start of the line if
you have capitalization rules active in your AutoCorrect options.)
Double-click each word in turn to select them and apply formatting
asfollows, using the Text toolbar controls: “regular” as Basic Sans;
“bold” as Basic Sans (and click the Bold button), and “heavy” as
Basic Sans Heavy.

Triple-click anywhere in this one-line paragraph to select it. Set the
point size to 24pt using the pull-down list. Next, center this line of
text using the Justify button.

While the lineis still highlighted, open the Paragraph properties
dialog (Format/Paragraph). On the Spacing tab, set the Space
Before setting to 10pt and the Space After to 12pt. Y ou can also
apply paragraph formatting while the cursor is at any placein the
paragraph, without selecting it in advance.
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This brief exercise introduces the

bounce bounce

ChangeBar.

W]

Click to insert your cursor after this glossary entry and press Enter to
create anew line. Type “bounce” on the new line, double-click to
select the word and set the font to Blippo Light SF, 48pt (you can
type the value into the Point Size box, then press Enter). Click the

@ ChangeBar button to show the ChangeBar. Select the“0” in
“bounce” and adjust the ChangeBar’s (Baseline) Advance setting to
“-12.0". Repeat thisfor the“n” and “e.”

All that remains to be doneisto click the Centered button. The
settings for the Space Before and After this line of text might need to
be adjusted: settings of 4pt work fine.

cap height

Since thiswill be the last illustration on the page, it’stime to make sure
that your next page will begin with the correct entry. Wrap settings,
paragraph spaces, and placement may need to be adjusted to avoid
confusion as you proceed with the project.

a

Take amoment to save your work and then open the QREFMAST.PPP
file again. Locate the small illustration featuring a capital “A,” and
copy it to the Clipboard. Leaving QREFMAST.PPP open this time,
switch back to page 2 of your QuickRef-in-progress (try using the
Windows menu or Ctrl+Tab). Paste the illustration group and
position it on the pasteboard near the “cap height” entry, towards the
bottom-right corner of the text frame.

Right-click the group and set its wrap to Tight using the | button
on the Wrap Settings toolbar. Drag into position to the right of both
the “cap height” and “cap line” entries.

We want “cap ling” to be the last entry on this page, so you might
need to adjust the Space Before/After values for the previousinline
examples, or adjust the wrap settings for placed objects. For
symmetry, however, leave the main Glossary story text paragraphs
alone.
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Page Three — “caption” to “crop marks”

= | Since the first couple of examples on this page begin with designs pre-

— stored in the master file, we'll take this opportunity to introduce the
Portfolio—a repository that’s convenient both for storing objects you
want to reuse, and for transferring multiple objects between documents.

Everything =

©

caption

O Switch to the QRermAST.PPP file, and click the Studio’s Portfolio tab.
Holding the Ctrl key down, drag a copy of the lion picture and drop it
into the Portfolio’s My Designs group. (Not holding down Ctrl
would result in aMove operation.) Y ou need not provide a name for
the design at thistime; it will simply appear as“Unnamed Design.”
Likewise, Ctrl-drag a copy of the group featuring the word
“Everything” into the Portfolio.

O Switch to your QuickRef file and go to page 3. Click and drag the
lion picture from the Portfolio out onto the pasteboard.

Note that a copy of the design remainsin the Portfolio. (For future
reference, to delete an item from the Portfolio, you can right-click on it
and choose Delete Design.)

O Set thezoom view and scroll settings to alow alegible “ caption”
glossary entry on the right, and pasteboard on the |eft. Drag the lion
over to the pasteboard to the left of your text.

U Select the picture, then show the ChangeBar. Using the Object
Rotation control, set the rotation to 10.0 degrees.

U Drag the pictureinto position below the “caption” entry. Set itswrap

to Square using the Wrap Settings button. Now zoom in for a
better view.

U Choose the Artistic Text tool and click on ablank part of the page for
an insertion point. Type “It'sajungle out there!” and set the object’s
font to Arial, 11pt. Use the ChangeBar to rotate this caption block to
10.0 degrees, and drag it into position below and to the right of the
picture.

character

The “Everything” diagram in the Portfolio istheillustration to
accompany the “character” entry. (If it’s not there, retrieve it from
QREFMAST.PPP.)



118 QuickRef Project

U Drag acopy of the diagram out of the Portfolio and drop it over the
frame text so the “character” entry ends just above it in the left
column. The object’ s left and right edges should align with the page
margins. Set the wrap to Square, with the distance from text set to
.15 (0.4cm) top and .10 (0.25cm) bottom.

copyright

How to Use Special
Character Options

U Choose the Artistic Text tool and drag out a letter approximately 1"
(2.5cm) high at the edge of the page. Choose Symbol from the Insert
menu and select Copyright from the submenu. Select with a double-
click, then format the symbol as 60pt by typing “60” directly into the
Text Size box and pressing Enter. Set its wrap to Tight thistime.
Make sure that the “ Crop object to wrap outline” box is unchecked in
your wrap settings so no portion of the symbol disappearsin the next
step.

U Drag the character into position to the right of the “copyright” entry.

To edit the wrap outline, click the @ Edit Wrap button. You can
then drag the dashed outline or nodes. To create a circular wrap on
the left edge, first insert an additional node by selecting the lower | eft

node, then clicking the Q Add

decorative type Seo display type

Node button on the Curve descender The lowest portion of letters, sach as ‘g or 4," that
. tetucds badonsr the e ik
toolbar. Make sure the right- Bk oy ko s
. digarc e belowr the baseline

hand outline edge extendsto the  aighats A typetice which conaivs dee

. . antive syrbols mther than readeble
right margin, to keep text from chenes, Coc baow s " s
meak| ng in there ﬂ.hplajr;pr Large type, cfben st in bold for afterdion grbbing

et s headlinea or headings. Sares as “deeorative type."”

U Before proceeding, make sure the two-line entry for “crop marks” is
the last entry on the page. Again, you can adjust the wrap settings
and spacing for inline illustrations to change the amount of space
available for the remaining frame text.



QuickRef Project 119

Page Four — “cursive” to “folio”
deck

O Click toinsert your text cursor at the end of this entry. Press Enter to
start anew line. Type “Introducing PagePlus 8.0". Set thelineto
Chanson Heavy 18pt, centered. Make the Space Before this
paragraph 12pt and leave the Space After at 1pt.

O Press Enter once at the end of the lineto start a new paragraph. Type
“It’swhat you' ve been waiting for!” Make this Arial 14pt and center
it. Set the Space After to 12pt and |eave the Space Before the

paragraph as Opt.

dingbats

This exampleis similar to the “copyright” example on the previous page,
but uses the Windows Character Map applet.

U Using the Artistic Text tool, click for an insertion point at the page
edge. Choose Symbol from the Insert menu and select Other to
bring up the Character Map system accessory. In the list of fonts,
select Wingdings. Type “{” into the Character box, then click Copy
and Close.

U In PagePlus, press Ctrl+V to paste the “flower” after the artistic text
cursor. Set the character to 90pt (double-click the symbol then type
the value into the Fonts box and press Enter). Set itswrap to Tight,
and drag the object into position to the right of the “dingbat” entry.

O Adjust the wrap outline using the Edit Wrap tool and Curve toolbar
so theillustration fits into the white space to the left of the entries for
both “descent” and “dingbats,” which should contain two lines and
four lines, respectively.

display type

U Type, on anew line after the display type entry: “Bolts <Enter>
Pagoda <Enter> Stylistic”. Triple-click and set the first line to 20pt,
then select each of the other two new lines and make them 30pt.
Center-justify all three lines. Go back and change each line' s font to
the font name you'’ ve typed. Set the Space Before and after the Bolts
lineto 12pt, and set the Space After the Pagoda and Stylistic linesto
12pt (with Opt Space Before).
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dropped (drop) cap

Q Click onany word in the “drop cap” entry. Choose Dropped Caps
from the Format menu and select “ Dropped” from the Drop Cap
Typelist. Make sure the drop setting includes 3 lines, and click OK.

drop shadow
This effect is one of many Filter Effects available on the Format menu.

U Create anew artistic text object at the bottom of the page and type
the words “ Shadow text”. Set the text to 28pt Cairo and zoom in
fairly closely.

O Choose Filter Effects... from the Format menu. In the dialog, check
the Drop Shadow box and then play with the sliders on the right side
until you find a preview effect you like (or just use the default
settings). Click OK when you're done. If you want to try again, you
can also find filter effects on the object’ s right-click menu.

O For added effect, use the ChangeBar to rotate the object +10 degrees.
Drag it into position below the “drop shadow” entry, so the
illustration becomes the last element in the left column; it can extend
outward into the left margin. Y ou can easily drag one of the object’s
cornersto scaleit, if necessary. Set a Square wrap with standoff
values so that the entry for “ear” now begins the right column.

a

Egyptian
U Create anew line after this entry and type “Commerce”. Set the font

to Commerce, 36pt Centered. Set the Space Before this paragraph to
5pt and set the Space After to 6pt.

family

This example introduces the special effect of “ghosting” light-shaded text
behind solid black text.

O Create atext frame 3" (7.5cm) wide by 2" (5cm) high with asingle
column. Type “Times Regular <Enter> Times Italic <Enter> Times
Bold <Enter> Times Bold Italic”. Press Ctrl+A to select all the text
in this frame, then set the font to 30pt Times New Roman. Tighten
the frame to best fit the text. Click the Align Right button and click
the 70 Shade sample on the Studio’s Colors panel.
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a

layering order

Use the Painter tool to triple-click each line and set the font style
accordingly. Right-click the frame and choose Layer/Send To Back
so the block goes behind all other page elements. Now drag it into
position, behind the entry for “family,” so the font names end about
halfway into the right margin. Adjust vertically for best visibility.

Note: Some printer drivers have trouble with pages like this one that
include shaded text. For best results, before you print, click the
Properties button in the Print dialog and select the Fonts tab. Check
the option to “Download TrueType fonts as bitmap soft fonts.”

Before proceeding, check that the entry for “fold marks” ends the right
column. (Adjust the Space Before and After paragraph settings on the
font examples, or the bottom frame margin if necessary.)

Page Five — PagePlus Font Sampler

This special page provides—in addition to adefinition for the term
“font”—avisual reference showing a selection of some fontsincluded in
the PagePlus installation.

font

The Font Sampler page will use text that’s not part of the glossary story,
so we'll insert anew page at this point, along with a new frame.

a

Assuming you' re on page 4 now, then click the Page Manager
button on the HintLine toolbar (or the Pagestab). Select the dialog’ s
Insert Page tab and leave the settings as they are (1 page after page
4). Just click OK.

Zoom out to Fit Page view and make sure Snapping is on. Choose
the Standard Frame tool and drag out atext frame fit to the page
margins. Drag the top edge down leaving about two inches between
the frame and the top of the page.

In this space above the frame, we'll create two elements: a headline or
title and (in a sidebar) the definition of “font.”
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U Create an artistic text object at the top of the page, type “ PagePlus
Font Sampler” and set the text as Centered, Chanson Heavy 20pt.
From the Format menu, choose Paragraph, and select the Line tab.
Click in the Line Selection box to create lines above and below. For
each line, click the Line Style button and set a 3pt line width. Then
set the top and bottom gap to .10” (0.25cm) and click OK.

U Drag the header block into position above the frame’ s left column,
touching the top page margin.

U Create anew standard frame on the same page (or over on the
pasteboard, about one inch (2.5cm) high and three inches (7.5cm)
wide. Set it to have one column rather than two (you can use the
Columns control on the ChangeBar) and drag the marginsto O.

U Now go to page 6 and triple-click the first entry (for “font”), then
press Ctrl+X to cut it to the Clipboard. Return to page 5 and click in
the frame you just created, then press Ctrl+V to paste the text.
Format the new frame's text as 9pt and fit the frame into position in
the upper right corner above the second column. It should be
balanced with the | eft-hand header.

U To create abackground for this definition sidebar, right-click it and
choose Fill..., then select Solid. Click the black sample (not the
number 1 scheme color) and set a +10% tint.

U Right-click the big, empty frame and choose Text File.... In the
dialog, make sure “Retain Format” is checked, and locate the file
WIZFONTS.RTF in the Samples folder. Click OK to import it.

Bnt Traditionally, the set of characters, having a specific size,
weight andatinbote, in a ghven typeface | forexarple, 12 point
PagePIl.ls Font Sampler Basic Sans Bold. Hove used interc hange shby with the term type-
fice in desktop publishing circles. Derived fror the word
“fomd,” as in “type foundry.” See also famdly.

by SF S Jiamond SF 1 0pt
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Now we'll increase the spacing between all the paragraphsin the new
story.

O Click inside the font listing and press Ctrl+A to select all thetext in
this frame. Choose Paragraph from the Format menu and select the
Spacing tab. Set the After attribute to 6pt. Click OK.

Thefina step isto format each block in turn with the corresponding font
name. It's not the most exciting activity in the world, but the Studio’s
Font tab makes short work of it...
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U For each font block: Triple-click to select the paragraph, then click
the name of the specified font in the Font tab.

The Font tab is more useful for this task than the Font Name box on the
Text toolbar, because its scroll position doesn't change, so you can
proceed down through the aphabet rapidly.

This Font Sampler isjust astart. Y ou may want to replace these samples
with a“Favorite Fonts’ page to customize your QuickRef |ater on.

Page Six — “foot” to “justified”

By now, actions like adjusting the zoom and scroll settings, choosing the
Standard Frame tool to create text frames (and the Pointer tool to move
your cursor or move objects), formatting text, setting the wrap outline,
clicking OK, and so on, are no doubt becoming familiar. That's progress!
Accordingly, our instructions from here on will dispense with the more
basic reminders and focus on essentials...

frame text

So far we've only dealt with standard text frames. This simple illustration
will place some frame text in an area of white space to briefly
demonstrate PagePlus 8's shaped text frames.

U Add twelve new lines after the “frame text” entry.

U Onyour pasteboard, use the Shaped Frame flyout to create three
frames—Polygon, Oval, and Triangle—each just over an inch (3cm)
per side. Set the Polygon frame to be four-sided. Align the three
framesin arow as wide as one of your main page columns.

U Click the Link button on the bottom of your left-most frame, link it
to the middle frame, then link the middle frame to the right-most
frame. Y ou have created a mini frame sequence for flowing text.

U Click insidethefirst frame. Set the font to Times New Roman, 6pt.
Type “Sample Text ", including a space after the words Sample Text.
Press Ctrl+A to select all of thistext and press Ctrl+C to copy the
text to the Clipboard. Press Ctrl+V to paste this text until all three
small frames arefilled.

U Now select all threefilled shaped frames, group them, and drag the
group into the white space you created earlier, below the “frame
text” entry.
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gutter
Thisone' sjust for fun.

a

Start a new line below the “gutter” entry and type “In the gutter”. Set
the font for the line to Balloonist 30pt, and set the paragraph spacing
to 10pt Before and After. Create an artistic text object, set the font to
Wingdings 60pt and type the letter “F’. Drag this pointing hand over
next to the “In the gutter” line, so that it is pointing at the gutter of
the page. You can scaleit up or down to fit.

half-fill text

First, we need to draw a background square with its upper half white, its
lower half black. Then we'll add the text.

a

Choose the Rectangle QuickShape tool and hold down the Shift key
to draw a square, slightly larger than 1.5 inches (4cm) per side. It
should have a black line and white (not clear!) solid fill. Duplicate
the box using Ctrl-drag, and fill the copy with black. Shift-click or
drag a marquee to select both boxes and use Arrange/Align
Obijects... to line up the Top and L eft corners. Finaly, click once to
select the topmost box, and drag its upper edge down so you have the
half-and-half square as described above.

Create an artistic text object and type three lines: “Black <Enter> and
<Enter> White". Set thisto 30pt Basic Sans Heavy, Centered. Now
Ctrl-drag to create a copy of this block.

The effect is simulated by cropping the copy on the top layer.

a

Select the two text objects and align their top left corners as you just
did for the two rectangles. Again, click once to select the front
object. Give it awhitefill. At this point very little of the text will be
visible, but aslong as you can see the front object’ s bounding box,
you're OK.

With the front text object selected, click the Wrap Settings button
and set a Square wrap. Also, check the “Crop aobject to wrap outline”
box, then click OK. Click the Edit Wrap button and drag the two
upper nodes of the wrap outline downward exactly hafway, so the
black text is exposed to the midline of the letter “A.”
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U Select both text objects and group them, then drag the group on top
of the half-and-half box. Now you' |l see both the black and white
text, and the effect is complete.

U When you're done, drag a marquee around al the objects and group
them. From the Tools menu, choose Convert to Picture.... Select the
Bitmap Format option and the GIF format, then click OK.

(Converting to a pictureis agood trick to useif you find that certain
effects, like this one, pose problems for your printer!)

U Finally, drag the new picture object over and drop it below the
definition for “hairline rule”. Give it a square wrap with standoffs of
0 top, bottom, and left, and .2 (.5cm) right. Drag to scale the picture
down in placeif necessary, so the entry for “hard return” fallsjust
below it.

initial cap
A simpleillustration...
O Selectthe“i” at the start of this entry. Set the point size to 24pt.

O Inthe Format/Paragraph... dialog, set the Space Before this
paragraph to 6pt, and the Space After to 18pt.

italic
U Placeyour cursor at the end of this entry in the right-hand column
and create anew line. Type“Try using italics for pull-quotes and

captions.” Set the text to Grenoble 24pt, Italic (of course!); leave it
left-aligned.

U  Settheleftindent to .5” (1.5cm) and the right indent to .85” (2.1cm),
using either the ruler margin guides or the Paragraph dialog. Set the
Space Before and After the paragraph to 14pt, and remove the
hanging indent.

U Create an artistic text object and type a*“smart” open-quote character
(ANSI value 147). To do this, hold down the Alt key and press
“0147" on the numeric keypad. Set this block to 72pt Grenoble (this
time regular, not italic). Duplicate the object and replace its text with
aclose-quote (ANSI 148, or Alt+0148).
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U Now move these two quote characters around your indented
italicized text to form a big pull-quote. Adjust your indents if
necessary o it’sfour lines and the third line reads “ pull-quotes.”
Position the open quote to the top left, and the close quote to the
bottom right of the blurb.

U Before moving on, adjust the paragraph space settings, the size of the
half-fill text illustration, and/or the overall frame size so the
definition of “justified” ends the column.

Page Seven — “kerning” to “OPI”

kerning

Thisisasimple Before/After example, demonstrating the kerning of
severa letter pairs.

U Start anew line after the kerning entry. Type “Wo, Ya, Tu <Enter>
Wo, Ya, Tu” and set the two lines as 36pt Times New Roman.

U Click with the Pointer tool to place your text insertion point between
“W” and “0” in the second block. Y ou could choose
Text/Kern/Negative from the menu, but it sinfinitely simpler to
press Ctrl+Alt+’-" (minus key on numeric keypad). Do this six or
eight times, until the “0” isunder the top serif of the“W.” If you
need to back off ahit, press Ctrl+Alt+’+’ (plus key).

U Repeat the procedure with the other two pairsin the second block,
and set the Space Before line one of your formatted text to 16pt and
the Space After your second line to 18pt.

In practice, as the definition states, kerning is generally applied only to
headline text at larger sizes. If you keep the “ Auto kerning” option
(Format/Character/Character Spacing.../Auto Kerning) set to 16
points, you'll rarely need to think about it.

Wo, Ya, Tu
Wo, Ya, Tu
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leading

O Insert your cursor at the beginning of the sentence starting
“Headlines’ in the “leading” entry, start a new line and type (all
capitals): “HEADING <Enter> LEADING”. Format the two lines as
Commerce 36pt. Select both words by dragging from the start of line
one to the end of line two.

O Show the ChangeBar and locate the Leading control. Click the up-
and down-arrow nudge buttons to experiment with various leading
settings. Move the lines together until an optimum setting of about
90% is reached.

U Set the Space Before HEADING and the Space After LEADING to
14pt. You may need to adjust the indent settings for the paragraph
starting “Headlines’ by setting the special indent to None, and the
left indent to .1" (0.25cm).

letterspacing
Theillustration will go at the top of the right column.

O Placeyour cursor at the start of the right hand column. Type“Line
has letterspacing” in Arial 14pt. Select and copy the lineto the
Clipboard, then insert areturn and paste the same line below the first.
Repeat this until you have five identical lines. Set the Space After the
last lineto 12pt. Type +1.4pt at the end of line 1, +0.7pt at the end of
line 2, Opt online 3, -0.7pt on line 4, and —1.4pt on line 5.

O Show the ChangeBar and locate the L etterspacing control.

We're going to show how variations in letterspacing affect atypical line.
The middle line will remain asis, with no tracking (letterspacing)
adjustment.

O Using either the nudge buttons or typing a value into the ChangeBar,
adjust the letter spacing on each line to match the values you've
typed. Select all fivelinesand set a.2” (0.5cm) left hand indent.

logo
This short exercise will demonstrate how to take advantage of the
PagePlus Gallery.
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O Display the Studio’s Gallery tab and select the Logos category.
Scroll down to “Logo 21,” then click that thumbnail and drag it onto
the pasteboard. Zoom in closely on the object and click its Ungroup
button. Now you can get to the placeholder text.

U Click the frame and type to replace the placeholder text with some of
your own. (We used “AMALGAMATED WIDGET, LTD” and set
the text to Ultra Serif.)

U Regroup the collection of objects, then
adjust position and wrap: try choosing
atop & bottom wrap from the Wrap
Settings box, setting the distance from
text to be .2” (0.5cm) at the bottom.

AMALGATATEO WIOGET, LTO

By the way, the logo we' ve just added, like al Gallery objects, employs
scheme colors—so if you' ve never experimented with the Studio’s
Schemes tab, there's no time like the present!

U Before continuing, the last entry in the right column should be for
“OPI.” Make sureit’s complete.

Page Eight — “ornamental cap” to "resolution”

= —— | outline

O Start anew paragraph after thisentry. Type “ Jagger Outling”. Set the
text to Jagger, 20pt, centered. With all three words selected, click the
Format/Character menu item to access the Character dialog. Check
the Outline box and set the Space Before and After thisline to 10pt.

paragraph spacing

U Right-click on the “ paragraph spacing” entry, select Text
Format/Paragraph..., and access the Spacing dialog. Type 5 as
Space Before and 18 as Space After, and click OK. Now with the
Pointer tool, add the following to the entry: “This paragraph’s
spacing is set at 5pt Before, 18pt After.” Select that new sentence
and format it Bold.
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picture cap

For this effect, we'll combine a clipart border with a capital |etter from
the script font Ancestory.

a

First, create an artistic text object and type a capital “P’ into it, then
set the “P” to 18pt Ancestory. Zoom in so that you can easily seethe
object.

Next we'll get aclipart border from the Samples folder. Click the
Import Picture button and you'll see a standard open file dialog.
Locate BORD_4.WMF in the Samples folder and select it, then click
OK. (If your cursor is gtill in the text, you'll be asked if you want to
insert the picture inline; click No.)

Click back in PagePlus just above and to the | eft of the capital “P.”
You'll seethe Picture Size cursor, which lets you drag to set the size
of apasted picture. If you drag while holding down the Shift key,
you'll see asguare shape. Instead, drag without the Shift key to allow
unconstrained sizing, and create a small rectangle just large enough
to enclose the capital “P.” Position and resize the frame so it's
enclosing the “P” and correctly aligned, then group the two objects.

Drag the group over to the left of the “picture cap” entry, so its base
is aligned with the second line of text. For a*“raised capital” effect,
increase the paragraph’s Space Before setting. Set a Tight wrap
around the border image. Delete the now redundant initial “p” in the
word “picture.”
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Before proceeding, adjust wrap and spacing so the first column ends
with “slightly more or less than that,” and then click to select the
main text frame itself. Drag the bottom of the frame up just a bit so
the first column ends with “Equal to 1/72". Thiswill ensure the page
as awhole comes out right.
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point size

U Create atext frame on your pasteboard, approximately 4" (10cm)
wide by 1" (2.5cm) high and type “ 8pt10pt12pt14pt18pt36pt” (with
no spaces). Set the text to Times New Roman and, using the Pointer
tool, carefully select each point size reference (including the “pt”)
and set it to the corresponding point size. Give the frame a
Top/bottom wrap and drag it into position below the entry.

raised cap

U Right-click on the “raised cap” text block and choose Text
Format/Dropped Caps.... Select “Raised” and |leave the options set
asthey are (a3-lineraise). Click OK. Voild A raised cap.

O Before going to the next page, make sure the entry for “resolution” is
the last text block on thisone. If any part of “reverse” is showing, or
if all thelines of “resolution” aren’t shown, adjust the right column
spacing as needed (or raise the frame's bottom edge some more).

Page Nine — “reverse” to “set-width”

reverse

The reverse effect for text uses two elements. background and
foreground. In this publication, we'll specify black and white, but you
can create awide variety of effects using grayscale shading or colors.

U Create anew frame (one column) about 3 inches (7.5cm) wide, and
typein al caps. “REVERSE”. Set it to Cairo 30pt. If the text wraps,
widen the frame.

O Now open the Studio’s Attributes tab and select the Color panel.
With the new frame selected, click the white color sample. The text

will disappear temporarily, but now click the Fill button above
the gallery and then the black color sample. Thistime it’'s the frame
background that changes color, and we see the text reversed out of
black. (Thisis one effect you can’t achieve with artistic text objects,
which don’'t have a“background fill” property.)

O  Apply aSquare wrap with .1” (0.25cm) distance from text
top/bottom. The frame should fit nicely in the left column just below
the “reverse” entry.
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rule

This exercise involves reformatting a paragraph to make it stand out.
Earlier, we applied solid ruled lines to the heading for the Font Sampler
page, with the line the same length as the paragraph.

a

a

Thistime, we'll make the line wider than the text. From the Align
tab of the Paragraph dialog, set the left and right indentsto .5”
(2.25cm) with no special indent set. On the Line tab, click to set a
Line Above and specify a.1” (0.25cm) gap. Click the Line Style
button, and under Line Style choose the double-line rule with two
pixels below, one above, like this: == (the next-to-last line stylein
thelist). Since the rule isfour pixels wide, including the space, you'll
also need to specify a Weight of 4.0p. Click OK twice.

Repeat the previous settings exactly for the Line Below, only this
time choose the double-line rule with the thick line above (the last
stylein thelist). Finally, click OK. Use the Paragraph dialog once
more to set the Space Before and After to 18pt.

With the cursor anywhere in this paragraph, click the = Align
Center button.

The next several exercises are a bit repetitive, but will go quickly.
Remember the old axiom about “five percent inspiration, ninety-five
percent perspiration”—and don't forget respiration. Now might be agood
time to take a few deep breaths...

sans serif

a

Start anew line after this entry. Type “Arial <Enter> Basic Sans
<Enter> Blippo Light <Enter> Minimal” and format the new text as
36pt. Select the 4 lines and click the Align Center button. Select
each linein turn and convert it to the corresponding font. Adjust the
Space Before the Aria line and Space After the Minimal line settings
so thefirst line of the “scanner” entry is at the bottom of the left
column. The second line should flow to the top of the right column.
Aswith the preceding page, you can raise the lower edge of the main
frame dlightly if necessary.
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script

U Create anew frame and type “Handscript” and format the word as
Handscript, 40pt (type in the value). Tighten the frame size, giveit a
top & bottom wrap with standoffs of 0. Plunk it in place.

serif

U Start anew line after the serif entry and type “ Casper <Enter>
Goudita <Enter> Times New Roman” and this time use 30pt; again,
center the text. Convert each font name to its particular font, and set
the spacing Before and After to 14pt.

U Before continuing, adjust spacing as needed so the entry for “ set-
width” ends the page.

Page Ten — “shading” to “weight”

Coming down the home stretch now...

shading

WEe' ve used shading and tinting before but this exercise introduces a
couple of handy techniques that will help you in situations where precise
alignment is a necessity. In short, we'll replicate a simple box a number
of times and align the boxes in an evenly spaced row.

U Sincewe'reillustrating an entry at the top of the column, a good
place to work would be in the top margin region. Zoom in to 100%.
To create the initial box, select the Rectangle (QuickBox) and draw a
Shift-constrained square of .3” (0.75cm). Watch the HintLine to get
the sizeright.

O Using the Attributes tab’s Color panel, give the box amid-gray fill
using RGB(135, 135, 135) from the gallery.

Now to make six copies (for seven boxesin al).

O With the block selected, choose Replicate from the Edit menu. In the
dialog, select Line, type“7” asthe number of objects, select Offset,
and enter a Horizontal value of exactly .4” (1cm) and aVertical
valueof 0. Click OK.

The “ Offset” setting is calculated between the top left corners of each
pair of objects, so you should now see the seven boxes spread in arow,
with asmall amount of space between each box. If it doesn’t look quite
right, double-check your settings and try again.
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O Working from the center square, give the square to the right a
“+70%" tint, the next square to the right a“+40%" tint, and the right-
most square a +10% tint. Give the square to the left of middlea”-
70%" shade, the next square to the left a“-40%" shade, and the | eft-
most sguare, you guessed it, a“-10%" shade.

U Create an artistic text object and type “Original” in Arial 14pt. Now
duplicate the frame twice. Change the second frame' s text to “Tint”
and type “ Shade” into the third. Drag “ Shade” so it’s positioned over
the second square from the left. Position “ Tint” over the second
square from theright, and “Original” underneath the central square
(seetheillustration).

Shade Tint

N OO

Original

U Marquee-select and group al the boxes and text objects. Set the
group’swrap to Top & Bottom with standoffs of .2” (0.5cm). Drag
the group into position just below the “shading” entry.

small caps

O With the Pointer tool, select just the text of the “small caps’
definition (not the words “small caps’ themselves). From the menu
choose Format/Character..., then select “Small caps” in the
Uppercase list box, and click OK.

soft return

O With the Text tool, edit the “ soft return” entry by pressing
Shift+Enter to insert a soft return after each of the following words:
“character,” “ling,” “continuing,” and “same.” For better appearance,
drag the ruler’ sindent handles in about an inch to change the indent
and close up some of the white space just created.

O Set the Space Before and After this paragraph to 8pt.



134 QuickRef Project

Note that the spacing between the new linesisidentical and they are all
indented, per the paragraph’s defined hanging indent. Pressing Enter for a
hard return, on the other hand, would start a new paragraph, having its
own hanging indent, and with a*“1.0p Space After” setting (although
subtle) separating the old paragraph from the new one. Try experimenting
with these values in a separate document. And check online help for some
differencesin the way PagePlus handles hard and soft returns.

strikethrough

O Just aswith the previous “small caps’ example, use the Character
dialog to apply the “ Single Strikethru” style only to the definition
text, not to the term “ strikethrough” itself.

text wrap

Shaped text frames in PagePlus | et you achieve awide variety of internal
text wrap effects without having to draw freehand container shapes.

U Zoom/scroll until half your window shows the right column and the
other half shows pasteboard. Triple-click to select the “text wrap”
paragraph and cut the paragraph to your Clipboard. Create a 1.75”
(4.5cm) Heart-shaped text frame, using Shift while dragging to
maintain the heart’ s aspect ratio. Give the frame atop margin of .25
(0.63cm), then paste the text into your now readied frame.

U Set atop and bottom wrap with the distance from text set to .1
(0.25cm) and drop the heart-shaped frame into the top middle of the
right column.

weight

O Placeyour cursor at the end of this entry and start anew line. Type
“Grenoble Light <Enter> Grenoble Heavy”. Set both to 24pt, then set
each lineto its corresponding font. Set a 12pt Space Before the first
line you typed, and some Space After the second if “Grenoble
Heavy” isn't the last text on the page. Indent both lines by .5”
(1.25cm)
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Page Eleven — “white space” to “x-height”

white space

O If the page break inserted earlier is pushing this entry onto page 12,
click just before the term and press Delete to remove the break.

O Select the whole “white space” entry and cut it to the Clipboard.
Create asmall new single-column frame on the pasteboard,
approximately 1.5” (4cm) wide by .75” (2cm), and paste in the text
you just cut.

O Next, use the Rectangle QuickShape to drag out a box at the top of
the left column, starting at the top |eft corner. Make it as wide as the
column and about an inch high, with ablack line border and a Square
wrap.

U Usethe ChangeBar to accurately set the box’s Object Height to 1.3
inches (3.3cm). Adjust the size or margins on the “white space”
frame so lines wrap after the words “containing” and “vital.” Drag
the frame and position it in the center of the box, so the text appears
surrounded by white space.

width

O Start anew line below this entry. Type “Arial 80% <Enter> Arial
100% <Enter> Aria 150%" and set the block to 18pt. On the
ChangeBar, locate the Width control. With the Pointer tool, select
thefirst line of text and use the Width control to set it to 80%
(condensed). Set the third line to 150% (expanded). Leave the middle
line at 100% (normal). Set the Space Before line one to 6pt and the
Space After line three to 10pt.

word spacing

Thefinal exerciseisavisua comparison of two techniques for
“loosening” paragraph text.

U Open QReFMAST.PPP and locate the text frame starting with “The
letterspacing in this paragraph...” Copy it to the Clipboard, then
return to your QuickRef publication and paste the frame onto the
pasteboard. (Make sure no other frames are selected when pasting
copied text)
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W]

With the Pointer tool, triple-click to select the text of the first
paragraph, set the ChangeBar’s L etterspacing control to 0.6pt, and
press Enter. You'll seethe selected lines“expand.” Enlarge your
frame downwards if you need to so that you can still see al of your
text. Now select the second paragraph and choose Paragraph...
from the Format menu. Select the Spacing tab and alter the values
shown for “Word space” as follows: Minimum space: 40% Optimum
space: 50% Maximum space: 70%, Last Line Minimum 40%. Click
OK.

Take alook at the comparison. What’ s your opinion?

g

Before positioning the frame on your page, use the Attributestab’s
Line and Color panelsto giveit a 1pt-wide black line. (Thistime you
can use the Color panel’s Line button.) Then select the frame object
and drag the left and right frame margins, and top/bottom column
blinds, in slightly so the text has a some white space around it. Then
drag the frame into the left column.

Anatomy of a Page (reprise)

Every puzzle deserves a solution. For the benefit of anyone who might
still be uncertain as to the placement of labels on page 1's “ Anatomy of a
Page’ layout, here' sthe key.

a

Open QREFMAST.PPP and navigate to page 2. There, you'll find a
scaled-down replica of the Anatomy layout, complete with labels. If
you like, you can copy and paste the group to the right column of
your QuickRef’s last page. It's up to you.

Vo, Ya, Tu
Vo, Ya, Tu
Anatomy
ofa

Page...




Index

A

Actua Size, 106
anti-aliasing, 64
artistic text, 28, 38
artwork, 87
Autoflow, 108
auto-imposition, 83
AutoRun, 11

B

baseline shift, 116
Bezier curve, 113
bitmaps, 31

Bold, 106

button bar, 56

C

Cadendar Wizard, 9
calendars, 38

ChangeBar, 38, 60, 105, 116, 117, 120,

127,135
clipart, 129
Clipboard, 65, 106, 110
color, 78, 82, 87
CMYK, 97
color matching, 97
color palettes, 66
color proof, 90
color schemes, 18, 29
color separations, 94
mixing, 94
PANTONE, 95, 98
RGB, 97
Color Manager, 35
Color Mapper, 95
Colorize, 95
columns, 35
Commercia printing, 77
Convert to Picture, 39
Copy, 106, 107

copyright notice, 52
creating
certificates, 17
posters, 83
PostScript files, 91
Cromalin, 85, 90
Crop, 39
crop marks, 79, 90
cropping, 39
Curve toolbar, 30, 39

customizing a Page Wizard publication,

17

D

densitometer bar, 79
desktop printing, 80
dithering, 66

dot grid, 36, 105
double-page spreads, 33
draw-type graphics, 31
drop shadow, 120
dropped caps, 120
embedding images, 38

E-F

EPS format, 31

Facing Page mode, 33

fileinformation, 79

filter effects, 120

Find & Replace, 109

Fit Page, 105

Flip, 39

fonts
TrueType, 8, 92, 104

footers, 34, 105

frame tools, 36

frames, 27, 36, 105
graphic properties, 38
linking frames, 37, 110
setup, 108
Standard Frame tool, 108

FTP, 70



G

Gallery objects, 30, 127
GIF, 61, 62, 65, 68, 95
graphics, 62

guides, 36, 105

H

handles, 104

Headers & Footers, 34, 105
Help on Help, 16

HintLine, 105, 111

Home page, 54

hotspots, 57, 61

HTML, 45, 53
hypergraphics, 55, 57, 61
hyperlinks, 52, 57, 61
hypertext, 45, 47, 50, 57

images
anti-aliasing, 64
bitmaps, 31
color palettes, 66
Convert to Picture, 39
dithering, 66
draw graphics, 31
GIF format, 61, 62, 65, 68, 95
graphics, 30
hotspots, 57
hypergraphics, 57, 61
importing, 31, 38, 65
JPG format, 65
lines, 30
linking vs. embedding, 38
pictures, 31
rollover graphics, 57, 59
safe palette, 66
shapes, 30
suppress pictures, 90
text wrap around, 39
Web Picture Manager, 55, 64
import
from other Windows applications, 32
images, 65
pictures, 31, 38
text, 30, 37, 108, 122
Index Wizard, 9

Insert Symbol, 118
installation, 10
AutoRun, 11
first-timeinstal, 11
manual install, 11
requirements, 10
Italic, 106

J-L

JPEG, 65

kerning, 126

layering, 121

layout aids, displaying, 105
Layout Checker Wizard, 40
layout grid, 35

leading, 127

letterspacing, 127
Linetools, 107

lines, 30

linking images, 38
LogoPlus, 113

M-O

Mail Merge, 9
margins, 54

master pages, 34, 53
Multipage view, 21
navigation bar, 56
Normal view, 21
offset printing, 88
outline, 128

P

page make-up, 32
page marks, 79
page numbers, 106
Page Setup, 32
Page Wizard, 16
customizing, 38
using, 16
pages
adding, 37
copying, 37
deleting, 37
facing page view, 33
margin and row/column guides, 33,
35



master page, 53
page numbers, 106
Page Setup, 33, 90, 105
size, 53
Pan tool, 111
PANTONE, 95, 98
PaperDirect, 82
paragraph spacing, 128
Paste, 106, 107
Photo Optimizer Wizard, 9, 82
PhotoCD, 95
photocopying, 85
photographs, 87
pictures, 31
planning a publication, 25
point size, 106, 130
Pointer tool, 111
Portfalio, 7, 117, 118
PostScript, 31, 84, 88, 91
Prepresstab, 79
printer types, 80
printing, 41
auto-imposition, 83
color, 78, 82, 87, 94
color matching, 97
color proof, 90
color separations, 94
commercial printing, 77, 86
crop marks, 90
desktop printing, 80
folded publications, 83
high-resolution artwork, 88
offset, 88
posters, 83
PostScript, 84, 88, 91
print options, 41, 78
Print Preview, 40
print services, 84
printer setup, 41
printer types, 80
process color, 97
quality, 77
quantity, 77

quick printing and copying, 85

registration, 98
scaling output, 78, 79

screen angles and frequencies, 99

service bureau, 78, 84
spot color, 87, 96

thumbnails, 78, 79
tiling, 78, 79
trapping, 98
process color, 97
professional printing, 88

Q-R
QuickShapes, 31, 58
raised caps, 130
registration targets, 79
Registration Wizard, 9
rollover graphics, 57, 59
Rotate, 39
ruler guides, 36

S

saving, 104
scaling, 78
selecting, 104
service bureau, 78, 84
shapes, 30
small caps, 133
snapping, 36, 105, 108
solid color bar, 79
Spelling Checker, 83
spot color, 87, 96
starting from scratch, 105
starting PagePlus, 15
Startup Wizard, 15
strikethrough, 134
Studio
Attributes tab, 30, 38
customizing tabs, 20
Gallery tab, 30
overview, 19
Pages tab, 37
Schemes tab, 29, 35
styles, 28

T

Table of Contents Wizard, 9
tables, 28, 38
text, 30, 62
artistic text, 28, 38
Autoflow, 108



bold, 106
dropped caps, 120
from aword processor, 30
importing, 37, 108
Insert Date or Time, 52
italic, 106
kerning, 126
letterspacing, 127
outline, 128
paragraph spacing, 128
point size, 106, 130
raised caps, 130
ruled lines, 30
small caps, 133
strikethrough, 134
styles, 28
tables, 28, 38
text flow, 37
text frames, 27, 36
typing directly onto the page, 30
width, 135
word spacing, 135
thumbnails, printing, 78, 79
tiling, 78, 79
toolbars
customizing, 20
trapping, 98
TrueType, 8, 92, 104
tutorials, 11, 21, 103

U-v

Undo, 104

URL, 51

vector images, 31
view options, 21

wW

Web pages
alternate text, 55
color palettes, 66
designing pages, 50
graphics, 62
height, 53

hotspots, 57

layout, 52

page size, 53

rollover graphics, 57, 59

safe area, 51

safe palette, 66

text, 62

URL, 51

Web colors, 35

Web Picture Manager, 55, 64
Web sites

audience, 46

browse sequence, 58, 60

button bar, 56

designing, 46

FTP, 70

Home Page, 54

HTML, 45, 53

hyperlinks, 52

hypertext, 45

links, 57

navigation bar, 56

Publish Site to Disk Folder, 67

sections, 49

site structure, 48

suggested resources, 72

title, 52

using existing content, 47

Web Publishing mode, 7
width, 135
word spacing, 135
wrap

crop to wrap outline, 39

Wrap Settings, 111, 113
wrapping text, 39
WritePlus, 30, 109

starting, 30
WYSIWYG, 53

Z

Zoom, 111
Actual Size, 106
Fit Page, 105



PagePlus Keyboard Shortcuts

Menu shortcuts
Press...

Alt + underlined letter in menu name
Underlined letter in menu item

Function-key shortcuts

Press... To...

To...
Display menu
Send command

F1 Display the Help Contents screen.
F7 Run the Spell Checker

Shift+F7

View the Thesaurus

Esc (Escape)-key shortcuts

Pressthe Esc key when...

Sizing, moving, or creating an object

Shift-key shortcuts

Hold down Shift key when...

Moving an object

Creating and resizing
Drawing aline
Drawing a box
Drawing an oval
Resizing apicture

Selecting atext region
Using Select All

After drawing aline, box, or
shape

To...
Cancel the operation

To...

Constrain the movement to horizontal or
vertical. To switch directions, release and then
press Shift again

Constrain the operation (in general)

Constrain angle to multiple of 45 degrees
Draw a sguare

Draw acircle

Allow freeresizing. Keep Shift up to preserve
aspect ratio (proportion) of original picture
Highlight the text region

(If you have an object selected) Select only
objects of the same type as the selected object.
Retain the current graphic tool instead of
reverting to Pointer



Ctrl (Control)-key shortcuts

Hold down Ctrl key and...
Drag an object

PressE

PressF

PressG

Press K

PressT

PressTab

Press Ali+X
Press a number key

Character shortcuts

Press... For...
Ctrl+Alt+8 .
Ctrl+Alt+D T
Ctrl+Alt+G T
Ctrl+Alt+= —
Ctrl+Alt+C ©
Ctrl+Alt+R ®
Ctrl+Alt+T ™
Ctrl+Alt+Q ‘
Ctrl+Alt+W ’
Ctrl+Alt+2 “
Ctrl+Alt+3 "
Ctrl+Alt+A "

Ctrl+Alt+O(zero) "'

Ctrl+Alt+M '
Ctrl+Alt+N v
Ctrl+Alt+I "
Ctrl+Alt+F '

To...

Duplicate the object (press Ctrl first)

Edit selected story in WritePlus

Run Find & Replace

Display the Import Picture dialog

Insert hyperlink

Import text file into selected frame

Switch between open PagePlus windows; (if
insertion point in table) insert atab character
AutoFit text in selected frame

Switch to a particular Zoom view (e.g. 1 =
100%). For specifics, see the View menu.

Character Name...

Bullet

Dagger

Double dagger

Em-rule or dash

Copyright symbol

Registered symbol

Trademark symbol

Single open quote

Single close quote

Double open quote

Double close quote

Comma space (width equal to that of comma
in the typeface; for lining up columns of
numbers with commas as separators)

Digit space (width equal to that of ‘0" in the
typeface; for lining up columns of numbers)
Em space (equal to point size of typeface)
En space (equal to half of point size)

Inch mark

Foot mark



